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Audience

Preface

The Oracle Fusion Middleware Oracle Enterprise Single Sign-On Suite Plus Installation Guide
explains how to prepare your environment for installation of each suite application, install each of
the suite applications, and complete the necessary post-installation tasks.

Audience

This guide is intended for experienced administrators responsible for the planning, implementation
and deployment of applications. Administrators are expected to have solid knowledge of directory
environments, permission structures, domain administration, and databases.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support.

For information, visit http://www.oracle.com/support/contact.html or visit
http://www.oracle.com/accessibility/support.html if you are hearing impaired.

Related Documents

For more information, see the other documents in the Oracle Enterprise Single Sign-On Suite Plus
documentation set for this release.

Oracle Enterprise Single Sign-On Suite Plus
Release Notes

Installation Guide

Administrator's Guide

Secure Deployment Guide

User's Guide

Oracle Enterprise Single Sign-On Logon Manager
Deploying Logon Manager with Microsoft Active Directory

Deploying Logon Manager with Microsoft Active Directory Application Mode and Active Directory
Lightweight Directory Services

Deploying Logon Manager with a Lightweight Directory Access Protocol Directory
Template Configuration and Diagnostics for Windows Applications
Template Configuration and Diagnostics for Web Applications

Template Configuration and Diagnostics for Mainframe Applications

Oracle Enterprise Single Sign-On Provisioning Gateway
Administrator's Guide

Command Line Interface Guide

Oracle Identity Manager Connector Guide

Sun Java System Identity Manager Connector Guide

IBM Tivoli Identity Manager Connector Guide
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Oracle Enterprise Single Sign-On Universal Authentication Manager
Administrator's Guide

User's Guide

Conventions

The following text conventions are used in this document:

boldface Boldface type indicates graphical user interface elements associated with an action,
or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which you
supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code in examples,
text that appears on the screen, or text that you enter.
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Before You Install Oracle Enterprise Single Sign-On
Suite Plus

Before you install Oracle Enterprise Single Sign-On Suite Plus, read the information contained in
this section carefully and follow it closely. This section contains the following topics:

e Overview of the Oracle Enterprise Single Sign-On Suite Plus Installation Process
e Contents of the Oracle Enterprise Single Sign-On Suite Plus Master Archive
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Overview of the Oracle Enterprise Single Sign-On Suite
Plus Installation Process

Oracle Enterprise Single Sign-On Suite Plus handles all tasks related to granting users access to
applications, including automatic sign-on, application password change, Windows password reset,
kiosk session management, application credential provisioning, as well as strong authentication
inside and outside of the session.

Oracle Enterprise Single Sign-On Suite Plus consists of the following components:

Oracle Enterprise Single Sign-On Logon Manager - provides single sign-on functionality.
Provisioning Gateway - provides remote credential provisioning capability.

Password Reset - provides the self-service password reset ability. Consists of the following com-
ponents:

o Password Reset Client - installed as a selectable component during the Logon Manager
installation.

o Password Reset Server components.

Kiosk Manager - provides session and application management for kiosk environments.

Universal Authentication Manager - provides strong authentication inside and outside the Win-
dows session.

Anywhere - provides the ability to deploy custom-configured installation packages to end-user
workstations not connected to the enterprise network.

The following is a high-level overview of the suite installation process:

=¥ If this installation is an upgrade, please refer to the "Upgrading an
“2 Existing Installation..." section for the selected component(s).

Determine which components of the Oracle Enterprise Single Sign-On Suite Plus and their fea-
tures you will be installing, based on the business requirements of your organization.

Ensure that supporting software listed in Required Supporting Software has been installed on
the target machine(s). Refer to the Oracle Enterprise Single Sign-On Suite Plus 11.1.2.0.0
Release Notes for a per-application list of requirements.

Obtain and decompress the appropriate installer archive. See Contents of the Oracle Enterprise
Single Sign-On Suite Plus Master Archive for the description of its contents.

Complete the installation steps in this guide for each component you've chosen to install.

If any problems arise during the installation or post-installation tasks, see Troubleshooting
Oracle Enterprise Single Sign-On Suite Plus Installation Issues.
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Required Supporting Software

In order to install and function properly, the Oracle Enterprise Single Sign-On Suite Plus
applications require the following third-party supporting software to be installed on the target
machines if it has not already been installed:

e The Windows Installer InstallScript redistributable (isscriptl1150.msi). You must
install this package for the Agent and Console installers to run unless your machine already has
this package installed. It can be obtained from http://-
consumerdocs.installshield.com/selfservice/viewContent.do?externalld=Q108322.

e The Microsoft .NET 2.0 framework (dotnetfx20.exe). It can be obtained from http://ww-
w.microsoft.com/en-us/download/details.aspx?id=19.

e The Microsoft .NET 4.0 "Full Profile" framework (dotNetFx40_Full_x86_x64.exe).
You must install this package for the Console to run if your machine does not already have the
.NET Framework version 4.0 installed. It can be otained from http://www.microsoft.com/en-
us/download/details.aspx?id=17718.

o The Microsoft Visual C++ 2010 runtime library (vcredist_x86.exe). You must install
this package for the Agent and Console to run if your machine does not already have this redis-
tributable installed. It can be obtained from http://www.microsoft.com/en-us/down-
load/details.aspx?id=5555.
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Contents of the Oracle Enterprise Single Sign-On Suite
Plus Master Archive

The following section describes the purpose of the files contained in the Oracle Enterprise Single
Sign-On Suite Plus master archive. The archive contains the following folders:

ESSO Logon Manager 11.1.2.0.0

ESSO Password Reset 11.1.2.0.0

ESSO Provisioning Gateway 11.1.2.0.0

ESSO Universal Authentication Manager 11.1.2.0.0
ESSO Anywhere 11.1.2.0.0

Reporting

The archive root also contains a PDF file, "ESSRN.PDF," which contains the product release notes.

Contents of the Logon Manager Folder

The contents of this folder are as follows:

ESSO Administrative Console.msi - the Oracle Enterprise Single Sign-On Administrative
Console installer.

ESSO-LM.msi - the 32-bit Logon Manager installer.
ESSO-LMx64.msi - the 64-bit Logon Manager installer.

BIP Reports - report files for generating usage reports for Oracle Enterprise Single Sign-On
Suite Plus applications with Oracle Business Intelligence Publisher.

Language Transforms - MSI installer language transform files that allow you to launch the
Logon Manager installer in a specific supported language.

Utility - folder thatcontains supplementary software and unsupported Logon Manager trou-
bleshooting tools. These are:

o SSOHiddenWindowResponse.exe - the Hidden Window Response utility. Use this utility
to allow Logon Manager to detect hidden application windows by window title and class. For
more information, see the guide, Using the Hidden Window Response Utility, available in
the online documentation center.

o ssoSCDetect.exe - SmartCard detection tool. When troubleshooting logon issues with the
SmartCard authenticator, run this tool to determine whether Logon Manager can see an
inserted SmartCard.

o TraceController.exe - the Trace Controller utility. Use this utility to enable and manage
trace logging in Logon Manager and other Oracle Enterprise Single Sign-On Accelerator
Suite applications.

For more information, see the Oracle Enterprise Single Sign-On Suite Plus Administrator's
Guide.

o Logon Manager Event Viewer.msi - the Logon Manager Event Viewer installer. Installs
and registers the messaging libraries required to view Logon Manager events in the Win-
dows Event Viewer.

Contents of the Password Reset Folder

The contents of this folder are as follows:

ESSO-PR_Server.msi - 32/64-bit installer for the Password Reset server-side software.
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Contents of the Provisioning Gateway Folder

The contents of this folder are as follows:

¢ ESSO-PG_ClientCLI.msi - 32-bit installer for the Provisioning Gateway command-line inter-
face client-side software. Note that installation on 64-bit environments is not supported.

o ESSO-PG_Server.msi - 32/64-bit installer for the Provisioning Gateway server-side software.

Contents of the Universal Authentication Manager Folder

The contents of this folder are as follows:

¢ ESSO-UAM.msi - the Universal Authentication Manager 32-bit installer. Note that installation
on 64-bit systems is not supported.

¢ Language Transforms - MSI installer language transform files that allow you to launch the
Universal Authentication Manager installer in a specific supported language.

o SmartCard - contains .reg files that enable supported smart cards.

e Utility - contains the command-line and graphical configuration tools, DeployTool.exe and Con-
figEditor.exe and a document describing their use.

Contents of the Anywhere Folder

The contents of this folder are as follows:

e Console - contains the Anywhere Console installer MSI file.
e Utility - contains the VBS script file that adds the required MIME types to Microsoft IIS.

Contents of the Reporting Folder

The contents of this folder are as follows:

e MSSQL -Table setup scripts, stored procedure SQL scripts, and .NET stored procedures for the
Microsoft SQL Server database.

e ORACLE -Table setup scripts, stored procedure SQL scripts, and Java stored procedures for the
Oracle database.
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Installing Oracle Enterprise Single Sign-On Suite Plus

This section describes how to install each of the Oracle Enterprise Single Sign-On Suite Plus
components.

This section covers the following topics:

Installing the Oracle Enterprise Single Sign-On Administrative Console
Installing Oracle Enterprise Single Sign-On Logon Manager

Installing Oracle Enterprise Single Sign-On Password Reset

Installing Oracle Enterprise Single Sign-On Provisioning Gateway

Installing Oracle Enterprise Single Sign-On Universal Authentication Manager
Installing Oracle Enterprise Single Sign-On Anywhere
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Installing the Oracle Enterprise Single Sign-On
Administrative Console

To install and configure the Oracle Enterprise Single Sign-On Administrative Console:
1. Close all programs.

2. Execute the ESSO Administrative Console.msi installer file.

3. Wait while the installer loads.

4. On the Welcome Panel, click Next>.

j’fﬂ Oracle Enterprise Single Sign-on Logon Manager &drministrative Consale - Installs... @

Welcome to the InstallShield Wizard for
Oracle Enterprise Single Sigh-on Logon
Wanager Administrative Console

The Installshield(R) wizard will install Oradle Enterprise Single
Sigri-on Logon Manager Administrative Console on vour
computer, To continue, click Mext,

WARMIMG: This program is protected by copyright law and
international treaties,

< Back. [ Mext = ] | Cancel
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6. Select a setup type. The Complete option installs all program features. The Custom option
allows you to choose which program features to install and where they will be installed. If you
will be performing a custom installation, go to Step 7. If not, go to Step 8.

‘j’_# Oracle Enterprise Single Sign-on Logon Manager &dministrative Consale - Installs.., @

Setup Type
Choose the setup tvpe that best suits vour needs. -

Please select a setup type.,

o Lomplete
All program Features will be installed. (Requires the most disk
space,)

Choose which program Features wou want installed and where they
will be installed. Recommended for advanced users,

Installshield

| < Back. |[ Mextk = ] | Cancel |

7. Ifyou are performing a custom setup, choose from the following installation options. Click
Next when you are done.

ﬁ Oracle Enterprise Single Sign-on Logon Manager &drministrative Consale - InstallS... @

Custom Setup 44

L

Seleck the program Features vou want inskalled,

Click on an icon in the list below to change how a Feature is installed,

Feature Description

(= = | ESSO-LM Administrative Console
S Template Add-on templates that include
Empiates additional supported application

templates, configurations and
setkings that can be included in
the console

This feature requires S3KE on
wour hard drive,

Install to:
CiYProgram Files (x86)\Passlogixiv-G0 Administrative Consoleh change. ..
InstallShield

| Help | | Space | | < Back |[ Mext = ] | Cancel |
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Logon Manager Administrative Console

(requires 14MB of space): ESS0-LM Administrative Console
This option installs all necessary files and settings =3 ~ | Templates
that serve as the core foundation of the application.

Templates (requires 76KB of space):

Add-on templates that include additional supported
application templates, configurations, and settings
that can be included in the console.

Change .
Click this button to change the current installation

destination folder for the Console. Select a different
location, if desired, and click OK.

Help | Icon | Means the Feature:
] - Will be completely installed to the local hard
Click the Help button 9 to EI drive. P Y
display the Custom Setup tips.
Each icon indicates the state of | [=ii~ Will have selected subfeatures installed to
the available feature. the local hard drive.
» 'rI Will not be installed.

Space

) Volume | DiskSize | Available = Reguired
Click Space to display the Disk Space Requirements

. . = 93GE 1666 19MB
for installing the selected features on the local
. =IF: 139GE 177GB OKB
servers. Click OK.
2z OKE OKB OKB
< >
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8. The InstallShield Wizard is ready to begin the installation. Click Install.

‘_@ Oracle Enterprise Single Sign-on Logon Manager Administrative Console - Install5... \EI

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

InztallShield

[ < Back ][ Install ] [ Cancel ]

9. Wait for the installation to complete. When the Completed screen displays, click Finish.

ﬁ Oracle Enterprise Single Sign-on Logon Manager Administrative Console - Install=,., @

Installshield Wizard Completed

The InstallShield Wizard has successfully installed Oracle
Enterprise Single Sign-on Logon Manager Administrative
Console, Click Finish to exit the wizard,

< Back Cancel
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Installing Logon Manager

This section describes the steps necessary for installing Logon Manager.
It covers the following topics:

e Prerequisites for Installing Logon Manager

e Upgrading an Existing Logon Manager Installation
e Installing the Logon Manager Client-Side Software
e Completing the Installation of Logon Manager
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Prerequisites for Installing Logon Manager

Before you install Logon Manager, ensure the prerequisites listed in this section have been
satisfied.

F-¥ Please refer to the latest release notes to find out about last-minute requirements or
“4 changes that might affect your installation.

Prerequisites for Installing Logon Manager

If you are installing Logon Manager on a 64-bit (x64) system, you must use the 64-bit installer
files marked with the _x64 suffix. While the installers have been compiled for the 64-bit platform,
Logon Manager itself is a 32-bit application that runs via the Windows-on-Windows 64-bit
(WoW64) emulation engine and is installed into the "Program Files (x86)" parent directory. The
32-bit version of Logon Manager is fully compatible with the supported 64-bit operating systems
listed below.

Oracle supports the installation of Logon Manager on the following 64-bit platforms:

e Windows Server 2003

e Windows Server 2003 R2
e Windows Server 2008

e Windows Server 2008 R2
e Windows 7

If you plan to synchronize with a database, or have the Reporting Service store application events
in a database, you must install the appropriate database client in order to allow Logon Manager to
connect to the database instance. Additionally, if you are installing Logon Manager on a 64-bit
system and plan to connect to an Oracle database, you must install the 32-bit version of the Oracle
database client on the target end-user machine; otherwise, the Reporting Service will not be able
to connect to the Oracle database.

Prerequisites for Unattended (“Silent”) Installations

In order to successfully install Logon Manager in unattended ("silent") mode, the Windows
Management Instrumentation (WMI) service must be running before the installer is executed.

To check whether the WMI service is running, and start it if necessary, do the following on each
target machine:

1. Open the System Management Console.
2. Open the Services snap-in.

3. Navigate to the Windows Management Instrumentation service and check its status and
startup mode.

4. Depending on the status, do one of the following:

e Ifthe statusis Started, the WMI service is running; proceed to the next
section.
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e Ifthe statusis blank, check the service's startup type and start it as follows:
o Ifthe startup type is Disabled, do the following:
1. Double-click the service.

2. Inthedialog box that appears, change the startup type to Manual or Automatic,
as required by your environment.

Click Apply.
4. Click Start to start the service. The status changes to Started.
o Ifthe startup type is not Disabled, do the following:
1. Double-click the service.
2. Inthedialog box that appears, Click Start to start the service.
3. The status changes to Started.
4. Click OK.

5. Click OK to close the service properties dialog box.
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Upgrading an Existing Logon Manager Installation

This section provides information on upgrading an existing Logon Manager installation to the latest
version.

Upgrading to Logon Manager 11.1.2 is supported for the following versions of Logon Manager:

e 11.1.1.2.X
e 11.1.1.5.x

See the following Oracle Support document to determine your software version:
https://support.us.oracle.com/oip/faces/secure/km/DocumentDisplay.jspx?id=762647.1

Oracle fully supports installing version 11.1.2 of Logon Manager on top of existing installations of
Logon Manager as listed above. The installer will uninstall the previous version automatically, and
then proceed with installation of the new version. Refer to the sections in this guide for more
information on installing both the Logon Manager Administrative Console and the Logon Manager
Agent.

F-¥ If the original installer was customized using the Logon Manager Administrative
~d Console, you must customize the new installer in the same manner before performing
the upgrade, otherwise your current Logon Manager settings will be overwritten by the
defaults in the unmodified installer.

Oracle recommends that you do not change the primary logon method during an
upgrade, as such a change introduces unneeded complexity to the process. Changes to
the primary logon method should be undertaken as a separate project.

The following are the basic recommended steps to upgrade to Logon Manager 11.1.2.

1. Perform a backup of your existing credentials.

2. Run yourinstallation as outlined in the sections, Installing the Oracle Enterprise Single Sign-
On Administrative Console and Installing Logon Manager.

3. Ifdeploying on Microsoft Active Directory, set the Use secure location for storing user set-
tings option under Global Agent Settings > [TargetSettingsSet] > ADEXT to Yes and
publish this setting to the repository as an administrative override.

"™ Only deploy this override once all instances of Logon Manager have been upgraded to
-4 version 11.1.2.0.0; otherwise, once Logon Manager 11.1.2.0.0 synchronizes with the
repository, all previous versions will no longer be able to synchronize with the
repository for that user. For more information on this setting, see the Oracle Enterprise
Single Sign-0On Suite Plus Secure Deployment Guide.

4. Update all of your repository objects (policies, templates, and so on) to the latest data schema
used by the latest version of Logon Manager as follows:

a. Connect to your repository with the latest version of the Oracle Enterprise Single Sign-On
Administrative Console.

b. Retrieve all of your templates, policies, and any other data from the repository and into the
Console.

c. (Optional) Make any configuration changes in your templates and policies as desired.

d. Publish all of the retrieved objects back to your repository.
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F-¥® This procedure is mandatory and must be performed in a test environment before
“a deploying Logon Manager to end-users. This is because the latest version of Logon

Manager introduces a new data schema to its configuration objects, such as templates
and policies, which is incompatible with objects created with previous versions of Logon
Manager. Attempting to synchronize Logon Manager with a repository that has not been
updated will result in data corruption. Oracle highly recommends that you create a
separate OU in your repository to test your new configuration objects before deploying
them enterprise-wide.

Restore your backed up credentials to the new installation.

¥ The Passphrase Suppression setting is, as of the 11.1.5.1 release, configurable under
~4 Global Agent Settings > [TargetSettingsSet] > Authentication > Windows v2
> Recovery Method. The default is to display the passphrase. If you want to suppress
the passphrase, you must change this setting.

Note that if you have a custom passphrase suppression (a DLL that implements the
Secondary Authentication API), this DLL must return a unique GUID from its GetID
function. Also, you must set the:

HKLM\Software\Passlogix\MsAuth\ResetMethods:ResetMethodGUID
registry value to that GUID.

See the Oracle Enterprise Single Sign-On Suite Plus Administrator's Guide more details.

After the installer has finished and your credentials are restored, the upgrade is complete.

Refer to the Oracle Enterprise Single Sign-On Suite Plus Release Notes to learn about the new
product features.
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Installing Logon Manager Client-Side Software

F-¥ If you have a previous version of Kiosk Manager installed and are updating it during this
=4 jnstallation, you must first uninstall the previous Kiosk Manager using the Control
Panel Add/Remove Programs or the Uninstall option of the earlier software
installer.

For additional considerations with regard to Kiosk Manager, see the Oracle Enterprise
Single Sign-0On Suite Plus Administrator's Guide.

Toinstall and configure Logon Manager:

1. Close all programs.
2. Execute one of the following files to begin the installation:

o ESSO-LM.msi for 32-bit installations.
o ESSO-LMx64.msi for 64-bit installations.

w=* If you are installing in a language other than English and would like to launch the
k™ installer in the desired language, execute the following command:

msiexec /I <packagename>.msi TRANSFORMS=<language>.mst
where <packagename> is the name of the Logon Manager installer MSI package, and

<language>.mst is the name of the corresponding language transform file (included in
the installer archive).

3. On the Welcome Panel, click Next>.

j’g’ﬂracle Enterprise Single Sign-on Logon Manager - InstallShield Wizard EI =] @

Welcome to the InstallShield Wizard for
Oracle Enterprise Single Sign-on Logon
Manager

The Installshield(R) Wizard will install Orade Enterprise Single
Sign-on Logon Manager on your computer, To continue, dick
MNext.

WARMIMG: This program is protected by copyright law and
international treaties.

< Back Mext = ] | Cancel
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4. Select a setup type. Typical provides a path to select commonly used program features easily.
Advanced provides a detailed tree view of all the program features available for installation. If
you select a typical setup, follow Steps 5 and 6. For an advanced setup, go to Step 7. Click

Next>.

j@ﬂrﬁcle Enterprise Single Sign-on Logon Manager - InstallShield Wizard EI = @

Please select a setup type.

@ Typical
Easily select the program features desired for a typical Orade ESS0
Logon Manager installation.

) Advanced
Choose which program features you want installed and where they
will be installed. Recommended for advanced users.

InstallShield

T
[
Choose the setup type that best suits your needs.

< Back H Next = ] [

Cancel
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5. The Typical Setup screen appears. Select your authentication methods and indicate whether
you want to use multiple authenticators.

ﬁ![}racle Enterprise Single Sign-on Logen Manager - InstallShield Wizard EI (=] @

Typical Setup
Select the settings for your configuration. -

What authentication method(s) should be available for use?

| Windows Logon w2 Smart Card
LOAP Smart Card (Read-Only)
Proximity Card RSA SecurlD
Do you want the capability to use multiple authenticators? Yes @ Mo

Installshield

Authentication methods. In order to authenticate a user and grant access to stored
credentials, Logon Manager offers a number of authentication methods implemented as
authenticator plug-ins, with the most common method being a user name and password. In
Active Directory environments, Logon Manager supports this authentication method through
its Windows Logon (WinAuth) v2 plug-in.

If you are using a strong authentication method, refer to the Oracle Enterprise Single Sign-On
Suite Plus Administrator's Guide which describes specific settings that must be enabled within
an authenticator to work with Logon Manager. It also describes all the Logon

Manager Administrative Console settings and any steps that must be taken to integrate with
Kiosk Manager.

Multiple Authenticators. The Authentication Manager feature adds the capability to enable
multiple logon methods to authenticate the user. These logon methods can be the standard
Logon Manager supported logon methods such as LDAP and Windows Logon v2, or the strong
authenticators such as smart cards, proximity devices, and RSA SecurlD tokens.

Click Next>.

6. Select your repositories and indicate which audit logging capabilities should be installed. If you
install the Oracle Enterprise Single Sign-On Reporting Server, refer to the Oracle Enterprise Sin-
gle Sign-On Suite Plus Reporting documentation for configuration information. Click Next>
and continue to step 8.
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‘ﬁ Oracle Enterprise Single Sign-on Logon Manager - InstallShield Wizard EI = IEI

Typical Setup
Select the settings for your configuration. —

What repository type(s) are you using to store user data?

Microsoft Active Directory [TLoap

[| Microsoft ADAM [ Database

What audit logging capabilities, if any, should be available for use?

["|ES50 Reporting Server [T] %ML File
[ windows Event Manager [ Database
["]5yslog Server
InstallShield
< Back ]| Mext> [ Cancel ]
\, J
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7. Ifyou are performing an advanced setup, choose from the following installation options:

This option installs all necessary files and
settings that serve as the core of the
application, and allows you to select the
application types for Logon Manager to interact
with.

Application Support

S = 'I Application Support
p Qvl Web Integration

=3 ~ | Mozilla Firefox

¥ ~| OAM Support
Windows

Microsoft Internet Explorer
Host/Mainframe Emulators
. Console Windows
X | puTTY

Java

SAP
SoftlD

Web Integration

Helper objects that allow integration with Web
browsers and external Web services.

......... Mozilla Firefox

Helper object that adds Logon Manager support
for Mozilla-based browsers.

...0AM Support Helper object that adds Logon Manager support
for Oracle Access Manager-protected browser
applications.

Windows Support for Windows desktop applications.

Windows support files are installed by default.
These files cannot be deselected.

Microsoft Internet Explorer

Helper object that adds Logon Manager support
for Internet Explorer. Installed by default.

Host/Mainframe Emulators

Helper object that adds Logon Manager support
for HLLAPI-based emulators.

........ Console Windows

Support for Console windows (command prompt)
within the Logon Manager mainframe plug-in.

________ PuTTY Support for PuTTY windows within the Logon
Manager mainframe plug-in.

Java Helper object that adds native Logon Manager
support for Java applications.

SAP Helper object that adds SAP application support to
Logon Manager.

SoftID Helper object that adds Logon Manager support

for SoftID applications. See the Oracle Enterprise
Single Sign-On Suite Plus Administrator's Guide
for more information on using this feature.

To use this helper object, the Authentication
Manager Authenticator must be installed and
selected as your Primary Logon Method.
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Authenticators

The authenticators are plug-ins
that provide different methods for
logging on to Logon Manager. By
default, Windows Logon v2 is
installed.

The available authentication plug-
ins are:

------- =1 = | Authenticators
Windows Logon {deprecated)
=3 ~| Windows Logon v2
bl 3 = | GINA
LDAP
LDAP w2
Metwaork Provider
Proximity Card
Smart Card
Smart Card (Read-Only)
. RSA SecurID
(- 3 v| Local Authentication Toalkit (LAT)
Authentication Manager

Windows Logon (deprecated)

Deprecated plug-in that enables logging on to Logon Manager by
logon to Windows.

Note: Do not install this component unless explicitly instructed
todo so by Oracle support. It is being provided for legacy
purposes only.

Windows Logon v2

Plug-in that enables logging on to Logon Manager by logon to
Windows with secure passphrase support. This authenticator is
installed by default.

Module that works with the Windows Logon v2 method. The
GINA option is available only for Windows XP and Windows
Server 2003.

You must select between GINA and Network Provider. It is not
possible to install both methods.

LDAP

Plug-in that enables logging on to Logon Manager by logon to an
LDAP directory.

LDAP v2

Plug-in that enables logging on to Logon Manager by logon to an
LDAP directory. This plug-in also includes secure passphrase
support.

Network Provider

Eliminates double authentication by utilizing the Network
Provider mechanism to log on to Logon Manager. Supports all
current Microsoft Windows operating systems.

This feature has been moved to its own node, and is no longer a
sub-feature of Windows Logon v2, as of version 11.1.1.5.1.

— Page 28 of 174 —




Oracle Enterprise Single Sign-On Suite Plus Installation and Setup Guide

Proximity Card

Authenticators

Authenticator plug-in that supports authentication with
HID Proximity Cards.

Smart Card

Plug-in that enables logging on to Logon Manager using MS-
CAPI-capable smart cards.

Smart Card (Read-Only)

Plug-in that enables logging on to Logon Manager using a Read-
Only Smart Card.

RSA SecurlID

Plug-in that enables logging on to Logon Manager using one-time
passwords generated by RSA SecurID tokens.

....... Local Authentication
Toolkit

Components needed to perform RSA SecurlID authentication.

Authentication Manager

This feature adds the capability to allow multiple logon methods
to authenticate the user. If you want to use the Enroliment,
Grade, and Order functionality, you must install this feature.

Administrator's Guide.

",".e':‘ If you are installing Proximity Card, Read-Only Smart Card, RSA SecurID, Secure Data
~4 Storage, or Smart Cards, see the Oracle Enterprise Single Sign-On Suite Plus

This plug-in provides for the
management of synchronization
extensions to the application.

are:

The available synchronization plug-ins

Synchronizers

Microsoft Active Directory
Microsoft ADAM

LDAP

Database

Roaming Profile (deprecated)
File System

Microsoft Active Directory

Synchronization plug-in that supports storage and retrieval
of credentials and settings from an Active Directory server.

Microsoft ADAM

Synchronization plug-in that supports storage and retrieval
of credentials and settings from an ADAM/AD-LDS server.

LDAP Plug-in that supports storage and retrieval of credentials
and settings from an LDAP-compliant directory, such as
Oracle Identity Manager.

Database Synchronization plug-in that supports storage and retrieval

of credentials and settings from a database.

Roaming Profile (deprecated)

Synchronization plug-in that supports roaming profiles.

Note: Do not install this component unless explicitly
instructed to do so by Oracle support. It is being provided
for legacy purposes only.

File System

Synchronization plug-in that supports storage and retrieval
of credentials and settings from a file share.
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Kiosk Manager

Kiosk Manager

Y

Application Suppart
Authenticators
Synchronizers
Kiosk Manager
M Session Locking Suppork
Password Reset Client
Prowisioning Gateway Client
M Credential Delegation

+- ¥ | Audit Lagging Methads

X ~| Backup/Restare

To use Kiosk Manager, you must install the LDAP Authenticator

and a synchronizer. You must also ensure that Windows
Authenticator v2 is not installed.

Plug-in that is available to support
kiosk scenarios.

L]

i
X
1

>
1

v

"!5"‘ Kiosk Manager and its subcomponents are only
~d available when installing on the 32-bit versions

of Windows XP and Windows Server 2003.

Refer to the Oracle Enterprise Single Sign-On Suite Plus
Administrator's Guide for more information.

Session Locking Support Installs the Kiosk Manager session locking component to
support kiosk scenarios. This component is not installed by
default.

If you install this component, the Kiosk Manager Agent
(SMAgent) starts automatically.

If you do not install the Kiosk Manager GINA, the Kiosk
Manager Agent (SMAgent) does not start automatically, but
events can be triggered through the command line from other
applications. Using this scenario, you can install Kiosk
Manager on a workstation and have it run only when executed.

See the Oracle Enterprise Single Sign-On Suite Plus
Administrator's Guide for more information on using the
command-line options.

Password Reset

Password Reset Client Installs the client-side component of Password Reset which
provides knowledge-based authentication and password reset
functionality.

You must install the Password Reset server-side component
before you install the client-side component. Password reset is
not installed as part of the Typical installation option. For more
information on installing Password Reset, see Installing
Password Reset.
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Provisioning Gateway Client

Provisioning Options

Installs the Provisioning Gateway client-side software that
provides remote credential provisioning functionality as well as
credential delegation.

You must install the Provisioning Gateway server component
(as described in Installing the Provisioning Gateway Server-
Side Component) before you install the client-side software.

:_.Credential Delegation

Installs the Provisioning Gateway credential delegation
component, allowing a user to temporarily delegate one or more
credentials to another user.

Requires Provisioning Gateway to be installed and functional on
the target machine.

The available plug-ins are:

Audit Logging Methods

This plug-in provides for the management of — ------- ¥ | Audit Logging Methods
event logging extensions to the application.

ES50 Reporting Server
Windows Event Manager
Syslog Server

XML File

Database

ESSO Reporting Server

Event Management plug-in that supports logging of
events to the reporting service.

Windows Event Manager

Event Management plug-in that supports logging of
events to the Windows Event Manager.

Syslog Server

Event Management plug-in that supports logging of
events to a Syslog server.

XML File Event Management plug-in that supports logging of
events to a local XML file.
Database Event Management plug-in that supports logging of

events to a Database.

Backup/Restore

This plug-in provides a simple file-based backup
and restore mechanism via a wizard interface.

=] v| Backup/Restore
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g

The localized language support packages that - gvl Languages
allow the Agent to be displayed in the following | i = ~ | English
EOgUEREE | W ¥ - | Chinese (Simplified)
e English (mandatory, installed by default) [ e ¥ - | Chinese (Traditional)
e Chinese (Simplified) [ e ¥ - | Czech
e Chinese (Traditional) | = ¥_~ | Danish
e Czech b x - DLItCh
e Danish 0 g ¥~ | Finnish
e Dutch 0 ¢ ~ | French
e Finnish | i X - | German
e French i ¥ | Greek .
e German 0 ¥ - | Hungarian
""""" ¥ - | Italian
* Greek A N S ¥ - | Japanese
e Hungarian i % | Korean
e Italian ] ¥ - | Morwegian
e Japanese | % = | Polish
e Koreen | e ® - | Portuguese (Brazil)
¢ Norwegian | L ¥ - | Portuguese (Portugal)
e Polish | e ¥ - | Romarian
e Portuguese (Brazil) | b X | Russian
e Portuguese (Portugal) | e ¥ | Slovak
e Romanian | pwe * - | Spanish
e Russian e X _~ | Swedish
e Slovak b e ¥ - Thai
e Spanish e % = | Turkish
e Swedish
e Thai
e Turkish

Click this button to change the current installation destination folder for the Agent.

Browse to the desired location and click OK.

Means the feature

Will be completely installed to the
local hard drive.

Click the Help button 9 to display the Custom
Setup tips. Each icon indicates the state of the
available feature.

Will have some subfeatures installed
to the local hard drive.

Will not be installed,
Will be installed on first uss,

Will be installed to run from the
network.

FEkEEE
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CIick_Space to display dne dis.k space Volume Disk 5ize = Available  Required

requirements for the installation of the selected

features on local servers. Click OK. = o S3GE 15GE 23MB
=IF: 139GE 177GE OkE
i OKE OKE OKE
< >

8. The InstallShield Wizard is ready to begin the installation. Click Install.

ﬁﬂracle Enterprise Single Sign-on Logon Manager - InstallShield Wizard EI = @

Ready to Install the Program 4
[

The wizard is ready to begin installation.

Click Install to beqin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard,

InstallShield

< Back |[ Install ] | Cancel
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9. Wait for the installation to complete. When the Completed screen appears, click Finish.

j@ﬂracle Enterprise Single Sign-on Logon Manager - InstallShield Wizard EI = @

Installshield Wizard Completed

The InstallShield Wizard has successfully installed Orade
Enterprise Single Sign-on Logon Manager. Click Finish to exit
the wizard,

e &

10. The Logon Manager installation does not require restarting, except in the following scenarios:

e Ifyou installed the Windows Authentication v2 authenticator with the GINA or Network
Provider components (Windows XP and Windows Server 2003 only), you will be prompted
to restart your workstation after you click Finish. Continue with step 11 after restart.

e If you installed Kiosk Manager (32-bit Windows XP and Windows Server 2003 only), you
must configure Logon Manager to synchronize with one of the synchronizers that you
selected during installation. Refer to the Oracle Enterprise Single Sign-On Suite Plus Admin-
istrator's Guide for instructions. Do not install any other GINAs if you install the SM GINA.
Restart your workstation after setting up synchronization, then continue with step 11.

11. After your workstation or server restarts, log on to Windows. The Logon Manager Welcome
Screen/First Time Use (FTU) Wizard launches. Follow the instructions on the screen to

complete the FTU Wizard. After the FTU is complete, an icon E appears in the tool tray.

F_¥ Refer to the Oracle Enterprise Single Sign-On Suite Plus User's Guide and online help
“4 for information on completing the FTU Wizard and using Logon Manager.
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Completing the Installation of Logon Manager

Completing the Installation of the Mozilla Firefox Support Component

In order to complete the installation of the Mozilla Firefox Support component of Logon Manager,
you must do the following after installing Logon Manager:
e If Mozilla Firefox was running during the installation, close all of its instances and re-launch it,

e Ensure that the component is enabled in the "Extensions" list in the "Add-Ons" panel in Mozilla
Firefox,

e Restart Logon Manager.
In the online documentation center, you will find the complete set of product-specific guides for
the Oracle Enterprise Single Sign-On Suite Plus. The following table lists the high-level tasks you

will need to perform to complete your installation and deployment, and the documents associated
with each task.

Configuring Kiosk Manager | Oracle Enterprise Single Sign-On Suite Plus Administrator's Guide

Configuring a repository e Deploying Logon Manager with Microsoft Active Directory
e Deploying Logon Manager with Microsoft ADAM/AD-LDS
e Deploying Logon Manager with an LDAP Directory

Configuring the Agent | Configuring Logon Manager Agent

Configuring authenticators | Oracle Enterprise Single Sign-On Suite Plus Administrator's Guide

Creating templates e Template Configuration and Diagnostics for Windows
Applications

e Template Configuration and Diagnostics for Web Applications

e Template Configuration and Diagnostics for Mainframe
Applications
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Installing Password Reset

Installing Password Reset

This section describes the steps necessary for installing Password Reset.

It covers the following topics:

e Prerequisites for Installing Password Reset

e Upgrading an Existing Password Reset Installation

e Installing the Password Reset Server-Side Component
e Installing the Password Reset Client-Side Component
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Prerequisites for Installing Password Reset

Before you install Password Reset, ensure the prerequisites listed in this section have been
satisfied.

F-¥ Please refer to the latest release notes to find out about last-minute requirements or
“4 changes that might affect your installation.

Prerequisites for Installing the Password Reset Client

Because the Password Reset Client relies on the Password Reset Server to function, you must
install the Password Reset Server first before you will be able to install and successfully con-
figure the Password Reset Client component.

If you are installing Password Reset Client and Logon Manager on the same Windows XP work-
station, you cannot use the Logon Manager Network Provider logon method.

Installing the Password Reset Client on Windows XP disables the Fast User Switching feature,
which allows multiple users to be logged on to a computer at the same time and to switch
among logons by pressing Win+L. This feature is unavailable because Password Reset utilizes a
custom GINA (Graphical Identification and Authentication) component that replaces the Micro-
soft default GINA dynamic link library (Msgina.dll). To change logons on a Windows XP com-
puter, a user must log off to allow the next user to log on. To do this, open Task Manager
(CTRL+ALT+DELETE), and click Log off.

If you want to use Password Reset on a workstation where Kiosk Manager is installed, refer to
the Oracle Enterprise Single Sign-On Suite Plus Administrator's Guide for configuration infor-
mation.

The optional registry settings, AutomaticEnroll and ForceEnrollment, control whether a work-
station user is asked or required to enroll in the password reset service on next logon. These
values can be set by modifying the installer package; they are not added by the install wizard on
the client. See Oracle Enterprise Single Sign-On Suite Plus Configuration Reference for the loca-
tion and values of those settings.

When you install the Password Reset Server, take note of the URLs for the Password Reset Web
resources listed in the table below; you will enter those URLs during the installation of the
Password Reset Client. Those resources, served by the Password Reset Server, provide the
client with the enroliment and reset capability.

Enroll URL Enter the URL of the Enrollment service default page:
http://host/vgoselfservicereset/enrollmentclient/EnrollUser.aspx
Reset URL Enter the URL of the reset service default page:
http://host /vgoselfservicereset/resetclient/default.aspx
Check Enroll Enter the URL of the Enrollment check service (checks if user is enrolled):
URL http://host/vgoselfservicereset/resetclient/checkenroliment.aspx
Check Force Enter the URL of the force enrollment check service (checks if user is forced
Enroll URL to enroll):

http://host /vgoselfservicereset/resetclient/checkforceenrollment.aspx

Check Status | Enter the URL of the status check service (checks for Password Reset
URL service availability):
http://host /vgoselfservicereset/resetclient/checkstatus.aspx
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Prerequisites for Installing the Password Reset Server

e Review the hardware and software requirements in the Oracle Enterprise Single Sign-On Suite
Plus Release Notes thoroughly and verify that your environment meets all requirements.

e You must use matching versions of the Oracle Enterprise Single Sign-On Administrative Con-
sole and the Password Reset server component; otherwise, unpredictable behavior may result.

e You must not install the Password Reset server-side components on a domain controller. Use a
member server instead.

e Due to a Microsoft error, Digest Authentication fails if you are using Windows Server 2003 as
your Web server, and Windows Server 2008 R2 as your domain controller. Microsoft has issued
a hot fix to address this problem. See http://support.microsoft.com/kb/977073 on the Micro-
soft Web site to read a discussion of this issue and download the hot fix.

e Ensure that DNS is configured and working properly, including correct enumeration of forward
and reverse lookup zones.

e Verify that your servers and workstations have the latest service packs and Windows updates
installed on them.

e Ifyou areinstalling on Windows Server 2008, install the IIS 7.0 Web Server first as described in
Configuring IIS 7.0 for Password Reset on Windows Server 2008.

e By default, members of the "Domain Administrators" group in Active Directory are auto-
matically added to the local "Administrators" group on the member server. If you are not a
member of the "Domain Administrators" group, add yourself to the local "Administrators"
group on the member server. For simplicity, the instructions in this guide assume that an
“Administrator” account, which is a member of the "Schema Administrators" group is used to
install and set up Password Reset Server.

e Forthe creation of service accounts, consider using long, complex passwords and set the
accounts to lock out after a specific number of bad password attempts. These actions will pre-
vent a hacker from successfully launching a dictionary attack on service accounts.

F-¥ Generally speaking, Microsoft recommends that IIS servers be installed on member
-4 servers. For a full discussion of this matter, visit Microsoft.com.
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Prerequisites for Unattended (“Silent”) Installations

In order to successfully install Password Reset in unattended ("silent") mode, the Windows
Management Instrumentation (WMI) service must be running before the installer is executed.

To check whether the WMI service is running, and start it if necessary, do the following on each
target machine:

1. Open the System Management Console.
2. Open the Services snap-in.

3. Navigate to the Windows Management Instrumentation service and check its status and
startup mode.

4. Depending on the status, do one of the following:

e Ifthe statusis Started, the WMI service is running; proceed to the next
section.

e Ifthe statusis blank, check the service's startup type and start it as follows:
o Ifthe startup type is Disabled, do the following:
1. Double-click the service.

2. Inthedialog box that appears, change the startup type to Manual or Automatic,
as required by your environment.

Click Apply.
4. Click Start to start the service. The status changes to Started.
o Ifthe startup type is not Disabled, do the following:
1. Double-click the service.
2. Inthedialog box that appears, Click Start to start the service.
3. The status changes to Started.
4. Click OK.

5. Click OK to close the service properties dialog box.
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Upgrading an Existing Password Reset Installation

This section provides information on upgrading an existing Password Reset installation to the latest
version.

Upgrading to Password Reset 11.1.2 is supported from the following versions of Password Reset:

e 11.1.1.2.X
e 11.1.1.5.x

When upgrading a Password Reset Server installation, do the following:
1. Backupthe server settings with an export of the HKEY_LOCAL_MACHINE\Sof-
tware\Passlogix\SSPR registry key.

2. Follow theinstructions in Installing the Password Reset Server-Side Component. After com-
pleting the installation, you must restart Microsoft IIS and verify that the required service
accounts are active within the system and that Password Reset is still configured to use them.

3. (Optional) If you are upgrading an instance of Password Reset that uses an Oracle database as
its repository, you must add new indexes required by Password Reset 11.1.2 by running the
following queries:

e CREATE INDEX SSPR.UQ USERID ON SSPR.USERQUESTIONS (USERSID);

e CREATE INDEX SSPR.EI USERID ON SSPR.ENROLLMENTINFORMATION
(USERSID) ;

e CREATE INDEX SSPR.RI USERID ON SSPR.RESETINFORMATION (USERSID);
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Installing the Password Reset Server Component

= If you are installing Password Reset on Windows Server 2008, you must install Microsoft
=4 Internet Information Services 7.0 first. See the section on configuring IIS 7.0 before
beginning this installation.

Installation of Password Reset on Windows Server 2003 in a
64-bit environment can take up to 50 seconds to complete.

1. Close all programs.
2. Launch the ESSO-PR_Server.msi installer file.
3. Inthe"Welcome" panel, click Next.

i Oracle Enterprise Single Sign-on Password Reset Server - InstallShield ... E|

Welcome to the InstallShield Wizard for
Oracle Enterprise Single Sign-on Password
Reset Server

The InstallShield(R) Wizard will install Oracle Enterprise Single
Sign-on Password Reset Server on your computer. To
continue, click MNext.

WARMING: This program is protected by copyright law and
international treaties,

[ Mexts | [ Cancel ]

4. Select Complete or Custom setup type and click Next >.(Custom setup allows you to specify
an alternate installation directory.) Then click Next >.

i# Oracle Enterprise Single Sign-on Password Reset Server - InstallShield ... fg|

Setup Type
Choose the setup type that best suits vour needs.

Please select a setup type.

All program features will be installed. (Requires the most disk
space.)

Choose which program features you want installed and where they
will be installed. Recommended for advanced users.

< Back ” Mext = l [ Cancel
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5. Click Install.

i Oracle Enterprise Single Sign-on Password Reset Server - InstallShield ... B|

.

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to beagin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

[ < Back “ Install 1 [ Cancel

The bar indicates the progress of the installation.

i Oracle Enterprise Single Sign-on Password Reset Server - Instal...

Installing Oracle Enterprise Single Sign-on Password Reset Server
The program features you selected are being installed.

Please wait while the InstallShield Wizard installs Oracle Enterprise Single
Sign-on Password Reset Server. This may take several minutes.

Status:

(RENNNRRNNARNNARRNNRRNAERN

6. When the installation is complete, click Finish.
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i Oracle Enterprise Single Sign-on Password Reset Server - InstallShield ... E|

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed Oracle
Enterprise Single Sign-on Password Reset Server. Click Finish
to exit the wizard.
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Configuring IIS 7.0 on Windows Server 2008 for
Password Reset

Prior to installing the Password Reset Web server on Windows Server 2008, you must install
Microsoft Internet Information Services 7.0. Following is the procedure to configure IIS 7.0 on
Windows Server 2008.

1.

ua A W N

In the Windows Server 2008 Manager, select Roles>Add Roles.

In the Add Roles Wizard, select the Web Server (I1IS) role.

In the resulting popup window, confirm that you want to add the required features.
Click Next.

In the "Role Services" window, select the following roles, if they are not already selected:

e Application Development:
o ASP .NET andits required features
e Common HTTP Features:
o Static Content
o Default Content
o Directory Browsing
o HTTP Errors
e Health and Diagnostics:
o HTTP Logging
o Request Monitor
e Security:
o Windows Authentication
o Digest Authentication
o IPand Domain Restrictions
o Request Filtering
e Performance:
o Static Content Compression
e Under Management Tools:
o IIS Management Console
o IS Management Scripts and Tools
o Management Service
o IIS 6 Management Compatibility and all sub-roles

Click Next.

In the confirmation window, verify your installation selections. Click Back if you want to
change any of your selections. Click Install when you are ready to begin installation..

After installation completes, continue to the Password Reset installation wizard.
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Completing the Installation of the Password Reset
Server-Side Component

Perform the steps in this section to configure your host environment for Password Reset Server
and configure your Password Reset Server installation for operation. You must do the following in
order to start using Password Reset Server:

Configuring the Password Reset Authentication and Password
Reset Services

Configuring Password Reset Server to Store Data in Active Directory

Limiting the Inherited Permissions for the SSPRRESET Account to the Required Minimum
Configuring the Password Reset Web Service's IIS Site as a Trusted Site in Active Directory
Restricting Access to the Password Reset Web Console

Configuring Password Reset for SSL Connectivity with Windows Server 2003/2003 R2
Configuring Password Reset for SSL Connectivity with Windows Server 2008/2008 R2
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Configuring the Password Reset Authentication and
Password Reset Services

Creating the Required Service Accounts

Create the following two accounts on your domain controller. These accounts should be ordinary
users in the "Domain Users" group (default):

SSPRWEB. This account will be responsible for Password Reset IIS functions and will make
changes, additions, and so forth, to the organizational unit (OU) that you will create later. If the
IIS instance hosting the Password Reset Web service and the Active Directory or ADAM/AD-LDS
repository are running on separate machines, this account must be in the same domain as (or
in a trusted domain of) the Active Directory or ADAM/AD-LDS repository and must have read
and write permissions to the Password Reset Web service's I1S site directories and sub-
directories.

SSPRRESET. This account will run the actual reset service on the Password Reset member
server with IIS. It will be responsible for resetting user passwords on the domain level.

F=-¥ Make these accounts members of the local "Administrators" group on the IIS host to
-4 avoid problems.

These accounts will be the service accounts that Password Reset uses to manage the
container where user questions and enrollment information will be housed and to
handle the actual password reset process. Because these are service accounts, you
should use highly complex passwords and prudent practices in terms of user lockout
after a certain number of bad attempts. Although this might result in some help desk
calls from users who cannot reset their passwords, it will also alert you that someone
has been trying to attack these service accounts. For information as to best practices for
service accounts and security log monitoring, visit Microsoft’s knowledge base.

Assigning the Service Accounts to the Respective Password
Reset Services

Assigning the Required Service Account to the Password Reset
System Service

1.
2.

Run: Control Panel > Administrative Tools > Services.

From the list in the right-hand pane, right-click Self Service Password Reset, and select
Properties.

In the Self Service Password Reset Properties dialog box, select the Log On tab.

Select This account and enter the account name: Domain\SSPRRESET. Then enter and
confirm (re-enter) the password for the account.

A dialog box displays to advise you that changes will apply after the service is restarted.

Restart the service as indicated. The SSPRRESET account setup is complete.
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i
Q Action  ¥iew Window Help |

& | | = ‘ Fom oIl om Self Service Password Reset Properties { x|
E Computer Management (Local) Name / [ Description | 5t General LooOn | Recavery | Dependencies |

ﬁe System Tools @Resultant Set of Palicy Provider Enables a ...
Event Vigwer % Routing and Remate Access Enables mu..,

Shared Folders 8 Secandary Logon Erablesst., St ¢ Local System account
Local Users and Groups

Performance Logs and Alert:

Log on &s:

% Security Accounts Manager E The startu... 5t = Allow service o interact with desktop

k %Se\F-Service Password Reset Passlogix 5... St
Device Manager 89 Server SupportsFil.. St PASSLOGERASSPRRESET IBrowse... |
%Shall Hardware Detection Provides m.., St P g
| %Smart Card Manages a... IEFERE
| L %Spac\al Administration Consale Helper Allows adm... Confitm password:
E--& Services and Applications %System Event Notification Monitors 5., St
8 Telenhany %Task Scheduler Enables a... St
e 6 %TCP;’IP MetBICS Helper Providess... St ‘You cah enable or disable this service for the hardware profiles listed below
% WM Control %Te\ephony Provides T... Hardware Profile | Service |
B8 1ndexing Service 8 Telnet Enables ar... Profile 1 Enabled
3 prs %Termmal Services Allows user,.. St
1 Internet Information Service %Terminal Services Session Directory Enablesa...
Themes Provides u...
%Unmterruptlh\e Powser Supply Manages a...
4 | 3 p
‘ _I Extended )\ Standard Enable | Disable |

,TI Cancel I Apply |

F-¥ The SSPRRESET account runs the password reset service on the IIS server where the
“4 server-side components reside.

The SSPRWEB account runs the virtual Web site on the IIS server where the server-side
components reside.
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Configuring Access for the Password Reset Web Service's
IIS Web Site Contents

You must configure access to the Password Reset Web service's IIS Web site contents (under the
vgoSelfServiceReset virtual directory) as follows:

Configuration of Virtual Sub-Directories

Virtual Directory

| EnrollmentClient

Enable Anonymous Access | NO
Integrated Windows Authentication | NO
Digest Authentication | YES
Authentication and Access Control | SSPRWEB

Virtual Directory

| ManagementClient

Enable Anonymous Access | NO
Integrated Windows Authentication | YES
Digest Authentication | NO
Authentication and Access Control | SSPRWEB
Virtual Directory | ResetClient
Enable Anonymous Access | YES
Integrated Windows Authentication | YES
Digest Authentication | NO
Authentication and Access Control | SSPRWEB

Virtual Directory

| WebServices

Enable Anonymous Access | NO
Integrated Windows Authentication | YES
Digest Authentication | NO
Authentication and Access Control | SSPRWEB

1

o2
7

% A The only virtual directory that permits anonymous access is the ResetClient directory.
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Verifying the Password Reset Services Permissions

1. For IIS 6.0:

To access the Password Reset web-based console, open IIS Manager and navigate down to
Default Website, then to vgoSelfServiceReset > ManagementClient. In the right-hand pane,
scroll down to the webservice.aspx page, and browse it.

¥ Internet Information Services (I1S) Manager =10l x|
';g Fle action Mew ‘Window Help |;[i|i|
= | AE XFRHE 2281
-% Internet Infarmation Setvices | | Mame | Path il
E---i,l MEMESERYER (local computer) |=| storage.aspx
- Application Paols "| up_Arrow. GIF
(= Web Sites | users.ascy
- Default Weh Site b i e
E"\b vgoSelfServiceReset | warning.gif
LA omon: | Web.config
[+-4,5% EnralimentClient 3 ;
: ‘[’ ’ | webservice, ascx
=144t ManagementClient 3 -
T bservice, asp:
- bin e
: i [#-_J Branding ;l il Fermissions _I
|De|etes the current selection, Erowse |

¥ By default, Windows Server 2003 installation has all Web service extensions disabled.
“4 Be sure to activate the required web service extension.

For IIS 7.0:

To access the Password Reset web-based console, open IIS Manager and navigate down to
Default Web Site, then to vgoSelfServiceReset > ManagementClient. Select the Content view
tab on the right pane, scroll down to the webservice.aspx page, and browse it.

"—Elnternet Information Services (I18) Manager M= B
@._, [? » HYPERVATK b Skes » Defaul WebSite » vGOSeFServiceReset b ManagementClient b & < @ -

File  ‘Wew Help

_ g JfvGOSelfServiceReset/ManagementClient Content _

| L l B | "webservice.aspx' Tasks

; :;?E'SSSQTEK (SSPRYadministrator) Filker: - (G0 - Lk show Al | Group by: Na Grauping 2 AP

) ‘;} application Fools Heme = | Type | :I E Switch to Features iew

=] q; Sites || manageResets, aspx ASPH File Browse

EQ DE.FEUIt ‘Web Site || passwordprolicy, aspx ASPY File Edi Pt
| aspnet_client || Precompiledapp. config COMFIG File —
o | propertyEditor aspx A5 File I'aan:t Modified: 10/7/2009 4:11:00
|| questionClone, aspx ASPY File
| |questions. aspx ASPY File it 1
| |resets.aspx ASPY File 83 Refresh
|| service.aspx ASPY File iﬂl Help
|| settings. aspi ASPY, File - 4
3 \WebServices 4 | sspr.css Cascading Style Sheet Document Orline Help
= | |storage. aspx ASPY File
L Juiaspx ASPY File
8% up_Arrow, GIF GIF Image
| |users.aspx ASPY File
9 wearning, gif GIF Image
Fig COMFIG File
i o le:
E Swikch ko Features Yigw

E]Featuras Wil Browse

Ready Edit Permissions. .. -

— Page 49 of 174 —



Configuring the Password Reset Authentication and Password Reset Services

F-® On IIS 7.0, SSPR Server will be installed into the custom “"SSPR AppPool” application pool

K instead of DefaultAppPool (as is the case of IIS 6.0). The reason for this is that
DefaultAppPool in IIS 7.0 uses the Integrated managed pipeline mode, which is not
compatible with vGOSelfServiceReset application.

When you open your browser, add this page to your Favorites list for easy access.

2. Inthe Password Reset Management Console web page, locate the System > Web Service
Account section. Verify that the SSPRWEB account has been designated as the Current
Account.

ORACLE Enterprise Single Sign-on Password Reset

Settings  Questions  Users  Enroliments  Rassts

Wb Senvice ACcount
Storage

Reset Service
Conneclors

Current Account DOMAIRSEFRWER

User Name
Fasaword

Confirm Password

3. Inthe Password Reset Management Console Web page, locate the System > Reset Service sec-
tion. Verify that the SSPRRESET account is listed as the service account for the Reset Service.

"':g{ If the SSPRRESET account is not listed as the Reset Service account under the Reset
™4 Service section of the Password Reset Management Console Web page, verify that you
are logged in as a local administrator. If it still does not appear, you can manually assign
it by specifying the account with the following naming convention:
Domainname\SSPRRESET.

If you receive an error message indicating that the account does not have logon rights to a
service:

1. Navigate to the IIS member server where you installed the Password Reset server-side com-
ponents.
2. Check the local administrator’s group.

3. Verify that the SSPRRESET and the SSPRWEB accounts are both members of the local admin-
istrator’s group.

4. Click on Reset Service in the left pane and verify that the SSPRRESET account is listed as the
Reset Service account.
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ORACLE Enterprise Single Sign-on Password Reset

Seftings Questons  Ussr= Enrcliments  Resels

Web Serviee Aobunl

R el Sanide

Conrecinrg

Sabus
Account DO ESFRRESET

isar Mama
Fag gwiid

Confrm Pazaword

Listening Port 45000

Dwmain TaMaD

Notice that the SSPRRESET account has been designated as the service account for the Reset
Service.

Configuring the Password Reset Web Service's Access to the
Password Reset Registry Settings
In order for Password Reset to function properly, the SSPRWEB service account needs full

permissions to the following registry key on the member server containing the Password Reset
server side components:

e On 32-bit systems: HKLM\ SOFTWARE \Passlogix\SSPR
e On 64-bit systems: HKLM\ SOFTWARE \Wow6432Node \Passlogix\SSPR

=¥ After applying permissions to this key, drill down several levels to verify that
“4 permissions have been propagated throughout.

To avoid possible permissions problems during the configuration of the Password Reset server-side
components, Oracle recommends that you make both the SSPRWEB and SSPRRESET accounts
members of the local administrator’s group on the IIS Member Server where you are installing the
Password Reset server-side components.

After you have finished the installation and configuration of the Password Reset server-side
components, you can remove these accounts from the local administrator’s group on the member
server.

Adding SSPRWEB Account Credentials to the Password Reset Server
Configuration

In order for Password Reset Server to function properly, it must be provided with the
SSPRWEB account credentials. Complete the following steps to do so:
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1. Addthe credentials to the Web.config file:

a. Locate the following file on the Password Reset machine and open it in a text editor:

<PR_Install Directory>\WebServices\Web.config

b. Locate the following line:

<identity impersonate="true">

c. Modify the line to look as follows and replace the example values of the userName and pass-
word parameters with the SSPRWEB account credentials. (Retain the quotation marks
enclosing the values. The parameter names are case-sensitive.)

<identity impersonate="true" userName="domain\ssprweb"
password="ssprweb password" />

d. Save and close the file.

2. Encrypt the credentials:

a. On the Password Reset server machine, launch the command prompt with administrator
privileges.

b. Change into the following directory:

$windir$\Microsoft.NET\Framework\v4.0.30319

c. Run the following command:

aspnet regiis.exe -pe "system.web/identity" -app
"/vgoselfservicereset/webservices"
d. Do one of the following:

e Ifyou arerunning Windows Server 2003, run the following command:

aspnet regiis.exe -pa "NetFrameworkConfigurationKey" "NT
Authority\Network Service"

e Ifyourare running Windows Server 2008 or later, run the following command:

aspnet regiis.exe -pa "NetFrameworkConfigurationKey" "IIS
APPPOOL\SSPR AppPool"

The SSPRWEB account credentials will be encrypted and the Password Reset Web service will be
able to decrypt and use them to run under the SSPRWEB account.

To manually decrypt the credentials, run the following command:

aspnet regiis.exe -pd "system.web/identity" -app
"/vgoselfservicereset/webservices"
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Configuring Password Reset Server to Store Data in
Active Directory
Password Reset stores user questions, answers, configuration, and enrollment information within

an organizational unit in Active Directory. Select any name for the OU that will identify the unit
easily.

¥ Before you proceed, create this organizational unit at the root of your domain. If the OU
“4 does not exist when you try to enable storage, you might receive an error message
indicating that no such object exists on the server.

The Connect As account performs the schema extension. As such, this account must be a member
of the Schema Administrator’s group and have permissions to create objects within the Password
Reset OU.

ORACLE" Enterprise Single Sign-on Password Reset

Setlings Clussticns Lisars Erevllmants Rasets
Webr Service Actount
Etorage
Reset Serice
Conneciors
Starage Type A0 ke
Server Mame/P Address, Port
et
SEFEDC DOkASIN.COR |I|
Servers ¥
Delete
Servar Timeaut 1] Seconds
Slorage Location (D) DL =S5FF DT =Celibde b D= G0
Usa S5L A
Inializing srepanst the HIBDE (a6on for e by ESSOFR s invaiien
+ Echindng i oty Bt T
& Craalng e A
*  Grasting raed
= Craaling mqui 5
Intialize sterage for ESS0-PR =)
Cennect As [User Mame) DOk FECHEMASLUFER
Pazgwond IITTTYT YT Y
| Subemit |

To enable storage in Active Directory:
1. Inthe System > Storage screen, select the storage type as AD in the Storage Type drop-down
menu.

2. Enter the fully qualified domain name or the IP address of the domain controller that you want
to use.

3. Enter 389 for the port number. This is the LDAP port used by Active Directory.
Click the Add button.
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5. Populate the fields according to the information in the table below.
6. Click Submit.

After a slight delay, the confirmation message, Successfully Saved Changes, is displayed.

Storage Configuration
Screen Label Explanation

Storage Type The type of directory in which Password Reset is installed. This
example uses Microsoft Active Directory (AD).

Server Name/IP Address, | The fully-qualified domain name or the IP address of the domain

Port Number controller. The port number for AD is 389. The port number for SSL is
636.
Servers The list of domain controllers to use. This example uses one server:

SSPRDC.DOMAIN.COM. It is possible to have multiple servers.

Server Timeout The number of seconds in an attempt to establish a connection to the
repository before a timeout.

Storage Location (DN) The distinguished name (DN) of the Password Reset OU that you
create within Active Directory, for example:

OU=ESSOPR,DC=DOMAINNAME,DC=COM
Where:

ESSOPR is the name of the OU that you create.
DOMAINNAME is the NetBIOS or short name of the domain.
COM is the extension of the domain.

Use SSL Select to enable secure socket layer.
Initialize Storage for Make sure that this box is checked. If you do not select this option,
Password Reset you will not be able to enter information into either the Connect As or

Password fields. This tells Password Reset whether or not it should
extend the schema and create the initial objects. If this box is not
checked, Password Reset will only update the storage settings.

Connect As The name of the account that will actually extend the AD schema and
add the necessary objects to the Password Reset OU. This account
should be a member of the Schema Admins group and have
permissions to create objects in the Password Reset OU.

v
EJ:,J Enter the username in this syntax: Domain\Username

Password The password for the account specified above.

F=™. Toverify that the Password Reset OU is configured correctly, open a fresh instance of
“d Active Directory Users and Computers on your targeted domain controller, using the
Advanced view. You should see an OU named ESSOPR (or the name that you chose) and
two subordinate OUs named SystemQuestions and Users. The existence of these two
subordinate OUs indicates success.

You can now remove both the SSPRWEB and SSPRRESET accounts from the local administrator’s
group on the IIS member server where you installed the Password Reset server-side components.
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Limiting the Inherited Permissions for the SSPRRESET Account
to the Required Minimum

The goal of this procedure is to grant a limited set of rights to the password reset account
(SSPRRESET). You will be able to reset user passwords and unlock accounts with this account, but
nothing more.

Note that the SSPRRESET account is simply a member of your domain users group. As a fail-safe
built into AD, this account cannot be used to change the password of a user that has greater rights
(such as, an administrator account).

You can assign this right at the organizational unit level or group level. Assigning this right at the
user level should not be a general practice and is not recommended.

Planning Your Privilege Hierarchy

The assignment of password reset permissions mandates careful consideration and planning to
ensure that the desired accounts, and only the desired accounts, are granted this permission.
Some practices and caveats that might help you fine-tune your strategy as you set up these
accounts include:

e Consider granting the password reset account granular permissions based on organizational
units or specific groups. After applying permissions to either, test to make sure that you have
the desired results.

e Do not run the Delegation of Control Wizard at the root of your domain: if you do, you will give
the password reset account rights that extend beyond users to objects such as computers and
printers.

e Because the password reset account is a member of the domain users group, its password reset
permissions are applied to all the members of the domain users group, who are at the same
level.

So, if you store all of your users in the default users container in AD and run the Delegation of
Control Wizard at that level, it will not permit a domain user account to reset administrator
account passwords. Active Directory does not permit users to have admin rights over
administrators.

In this scenario, the password reset service account will not be granted permission to reset the
password of your administrators. Your administrators will be able to enroll in Password Reset and
go through the entire password reset dialog. However, when they attempt to reset their
passwords, they will receive an error message because the password reset service account is not
designed to have permissions to reset the password for users in a higher security group.

Carefully consider whether you want members of your domain administrators group to be able to
have their passwords reset by an ordinary user account. While you can grant this level of control to
the password reset account, you might decide it is wiser not to do so.
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Delegating Control at the OU Level

Consider an OU structure in Active Directory where users are divided in the following manner:
e OU = Usersl

e OU = Users2

e OU = Users (the default user container created in AD)

Assigning users to organizational units makes it possible to manage the SSPRRESET service

account permissions of many users in a simple and uniform manner.

In the following example, we will give the SSPRRESET account the authority over the Users2 OU to
reset its members’ passwords.

1. Goto Start>Administrative Tools> Active Directory Users and Computers.
2. Make sure Advanced Features is checked under the View menu.

4% Active Directory Users and Computers P ] 4
@ File Action | Wiew Window Help |_|_|- =] ll
& = | |E AddiRemave Columns... # Eﬁ 2 @ il
@_ Active Direckor Large Icans ocal] Internal_Users & obi
D Saved Que  Small Icans i 7 = =
=2 vOURCOM  List éme BE :
EI@ Accour e Detail Uszerst User
@ Exl — ﬁ Uzera? Usgr
@ ﬁ Users, Groups, and Computers as containers ﬁ Users3 User
Rt v ~dvanced Features € Uzerse User
-0 Compu Eilker Options. .. €7 Userss User
[]--@ Domnair i ﬁ UsersE User
[]"'[:l Farsiar Customize, .,
-(Z7] LostandFound
[+ NTDS Quotas
[-[Z7] Program Data
(5] sspr
- Syskem
-] Users
| | 2|
|Enables,|'disables advanced features and objects | |

3. Navigate to Active Directory Users and Computers > [YourDomain] > [YourOU]. This
example uses YOURCOMPANY.COM> Users2.

4. Right-click on the OU that you want to control (this example uses the Users2 OU) and select
Properties.
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@ Active Directory Users and Computers
-] Saved Queries
E..@ Y OLRCOMPANY COM
7. (5] Accounts
23 Buikin
L3 Computers
(&%) Domain Controllers
D ForeignSecurityPrincipals
[C7 LostandFound
[ NTDS Quotas
D Program Craka

Delegate Contral...

Mave...

Find. ..

[lew »
All Tasks 3
Wigt L2

Mew Window From Here

Cuk

Delete
Rename
Refresh
Export List...

5. Inthe Users2 Properties window, select the Security tab.

Users2 Properties ﬂll

I EDM+| Group F'olic:yl

Generall Managed Byl Object

Group or user names:

ﬁ Enterprize Adminz ;I
€7 ENTERPRISE DOMAIN CONTROLLERS
!ﬁ Pre-Windows 2000 Compatible Access
ﬁ Print Operators

€7 SvSTEM

-

Add... | Bemove |

Perrmizzions for Account Operators Al Deny

Full Contral O
Read O
ik O
Create all Child Objects O
O
O

-

OooOoono

Delete dll Child Objects b
Generate Resultant Set of Policy(Logging] O LI

For zpecial permizsions or for advanced settings, Advanced |
click &dvanced. =
QK I Cancel | Lpoply |

6. Click the Advanced button to access Advanced Security Settings.
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Advanced Security Settings for Users2 I i |

Permissions |.&uditing| Dwnerl Effective Permissionsl

T o wiews more information about special permizsions, select a pemizzion entry, and then click. Edit.

Permission entries:

Type | Name | Permizsion | Inherited From | Apply To |A
Allaw Account Operators [, Create/Delete .. <not inherited> This object anly

Al Account Operatars .. Create/Delete .. <not inherited> Thiz object anly

Allaw Account Operators [, Create/Delete ... <not inherited> This object anly

Al Frint Operators [YOUF  Create/Delete ... <not inherited> Thiz object only o
Allaw Account Operators [, Create/Delete ... <not inherited> This abject anly

Al Domain Adming [vOU  Full Contral <nat inherited: Thiz object anly

Allaw EMTERPRISE DOM... Special <nat inherited: This object anly

Al Authenticated Uzers Special <nat inherited: Thiz object anly ;I

Edit... Eemove

Allaw inheritable permizsions from the parent to propagate ko thiz object and all child objects. Include
these with entries explicitly defined here.

Taoreplace all permission entries with the default settings, click Default. Default |

Learm mare about access contral.

QK | Cancel | Lpply |

7. Click the Add button.

8. Inthe Enter the object name to select field, enter the name of your ssprreset account (or
browse to the account using the Advanced > Find buttons. (You can use the Check names
button to verify that you have entered the account name correctly.

Select User, Computer, or Group [

Select thiz object type:

ILlser, Group, or Built-in security principal Object Types...

Frorn thig location:
IYOURCOMPANY.IDI:&I Locations. .

Enter the object name to select [examples]:

[Eheck Hames

A

Advanced... | ] I Cancel

9. Click OK.

10. From the Object tab of the Permission Entry screen, select User objects from the "Apply
onto:" dropdown menu.

11. Inthe Permissions window, check the Reset Password box in the Allow column.
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Permission Entry for Internal_Users 2l x|

Object | Properties |

Apply onte: ILIser ohijgcts j

Permizzions: Allaws Deny

Delete Subtree

Read Permizsions
Maodify Permizzions
Modify Dwner

Al alidated Wiites

Al Extended Rights
Create All Child Objects
Delete All Child Objects
Allowed to Authenticate
Change Paszword
Receive As

Fezet Paszword i

| A R LI
r Apply these permizziohz to objectz and/or Clear All |

containers within thiz container only

OF. I Cancel |

1800000000000
1000000000000

12. In the Permission Entry screen, select the Properties tab.
13. From the "Apply onto:" dropdown menu, select User objects.

14. In the Permissions window, check the Write lockoutTime and Write pwdLastSet boxes in
the Allow column.

Permission Entry for Internal_Users i3 | || Permission Entry for Internal_Users 2=l

Object Properties | Object Properties I

Marne: |ssprreset [ssprreset@alanfeldman local) Change... | MHame: ISSD”BSBt [ssprreset@alanfeldman local) Change... |
Apply ontor [User objects =] Apply anta: | User cbiects =l
Permissions: Al Dieny Pemissians: Allawy Deny

Read IP Phone Murber (Others) O O ] Read phata O O [

wite |P Phone Mumber [Others) O O ‘wirite phota O O

Read Jab Title a O Read Post Office Box O O

wirite Job Title O O wirite Post Office Box O O

Read jpegPhoto O O @y Read postaltddress O O

wirite jpegPhoto O O wribe postaldddress O O

Read labeledUR] O O Read prefermedLanguage O O

Wwirite lsbeledUR O O ‘write preferredLanguage O O

Fiead lastLogonTimestamp O O Read profilePath O O

Wirite lagtLogonTimestamp O O Write profileFath O o -

Read lockoutTime O O Read pwdLastSet O O

Write lockoutTime O ‘write: prudLastS et O

[T I Y o] [ B T TP T m m LI
r Apply these permizzsions to objects and/or Clear all | r Apply these permizzions o objects and/or Clear &l |

cohtainers within this container only containers within this container anly

Cancel | Cancel |

— Page 59 of 174 —



Configuring Password Reset Server to Store Data in Active Directory

15. Click OK.
16. Click OK two more times to close the windows. Your changes take effect immediately.

To verify that permissions were correctly assigned:

1. Right-click on the OU to which you just assigned the new permissions.
2. Select Properties.
3. Select the Security tab.

The SSPRRESET account should be listed as having Special Permissions. The Advanced tab will
indicate that this account has password reset permissions on the OU.
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Configuring the Password Reset Web Service's IIS Site
as a Trusted Site in Active Directory

There are two virtual directories within Password Reset that do not permit anonymous access, but
that are configured to use integrated Windows authentication (that is, if you are logged onto the
domain with your Windows password, you should be able to get to that page).

Due to security policies for IIS running on Windows Server 2003/2008, the first time a user
attempts to enroll, he might encounter a popup screen requesting username and password, as is
customary with any Web site with such settings. You can avoid this behavior (which can lead to
undesired help desk calls) by putting the fully qualified domain name of your Password Reset IIS
server in your list of trusted sites for any user in your domain.

To designate your Password Reset server as a trusted intranet site:

e For an individual computer, add the Password Reset IIS server’s default Web site to your list of
trusted intranet sites.

e Within AD, add this site to your list of trusted intranet sites through a group policy.
To accomplish this, you need:
e Domain administrator rights

e The ability to create or modify group policies at the OU or domain level.

In the following example, the Password Reset server site is designated as a trusted intranet site for
the entire domain. As such, it is a trusted site to all domain users.

F=* You might choose to create this policy for each OU that contains potential Password
~4 Reset users for more granular access control. Regardless of your approach, the end
resultis the inclusion of the Password Reset IIS server default Web site as a trusted

site.

To add the Password Reset IIS server to the list of trusted sites in your organization, you must first
create a policy for Windows clients that do not have the Internet Explorer Enhanced Security
Configuration installed (by default, Windows XP does not have this feature installed):

1. Remove the Internet Explorer Enhanced Security Configuration settings (Control Panel >
Add/Remove Programs > Add/Remove Windows Components).

2. De-select (remove) the Internet Explorer Enhanced Security Configuration.

F-™ You can install this enhanced security feature on your domain controller after having
“4 created this policy. Read the dialog box that pops up when you attempt to import the
current zone within Group Policy Object Editor.

To create this policy, open Active Directory Users and Computers, right-click on the
organizational units that contain users who will be enrolling in Password Reset (in this
example, at the root level of the domain) and click the Group Policy tab.

3. Create a policy named SSPR TRUSTED INTRANET SERVER.
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Generall tanaged B_I,II EII:-ieu:tI Security  Group Policy I

To improve Group Policy management, upgrade to the Group Paolicy
i anagement Conzole [GRPRLC).

Current Group Palicy O bject Links for dom ain

Group Policy Object Links | Mo Owerride | Dizabled |
Drefault Dromain Policy

TRUSTED IMT

)
15,

MET SER"

Group Policy Objects higher in the list have the highest priority.
This list cbitained from: TRUSTED domain com

New | agd. | Edi Up |
Options... | Delete... | Propertiez [ |

[ Block Policy inkeritance

4. Click Edit.

|4 Active Directory Users and Ci =12l
) Ele Adion Mimw Windem e ‘T Group Palicy Object Ed -0
e domail P ;
o
m General | Managed By | Object | eﬁruup Pali | o o ‘ | @
- (3 Saved Que o improve Group Policy management, upgrade tathe. [ S5 55PR TRUSTED INTRANET SERVER. | Name [ Description
H agement Console (GPMC). {8 Camputer Configuration Security Zones and Conkent R... Settings For content ratings and
= [ Software Settings i i
= Cusrent Group Policy Dbject Livc For dom E] ) b B lauthenticods Settings Settings For authenticode
| Window's Settings Security Zones and Content Ratings 2|
([ Adrniniistr akive = -

Tel 5
£ 4ffF User Configuration % Securty and Privacy Settings |
(L] Software Settings

Policy Object Links

Grouy

Mol

58 Default Domain Policy
2§ 55PR TRUSTED INTRANET SERVER

Va

Group Palicy Objects higher in the list hawe the highest
This list obtained From TRUSTED.domain.com

[0 Users
Hew Add.. Edit
Options. Delete... Properties
I~ Black Palicy inheritance
Cloze: (Car
T (|

6.

and Content Ratings.
7. Click Modify Settings.
8.

= [ Windows Settings

i Remote Installation £
=] Scripts {LogonfLogof
Security Settings
(23 Public key Policie
(1 Software Restric
[#1-(_] Folder Redirection
[=1-4f] Internet Explorer Ma
Browser Liser Ink

Connection
URLs

ool Security
Programs

[ Administrative Templates

R -y

“fou can customize the settings of each secunity zone as well as customizing the privacy settings. These settings
must be made through the Modify Settings button below. For more detailed help, refer ta the help documents

i~ Secuity Zones and Privacy
Do rot customize security zones and privacy

& Import the current secuiity zones and privacy sellings

Conlent ratings allow you to prevent users flom viewing sites with risky content. Ratings are set on a per-site basis

and are rated by the author for dearees of risky language, rudity, and violsnce:

- Content Aating:
& Dy not customize Content Ratings

€ Impott the currsnt Content Riatings settings

Moy Seitings |

oK Concel | ok | Hep

N |

Read the displayed message and proceed.

Expand the user configuration portion of the policy in the Group Policy Object Editor.
Navigate to Windows Settings > Internet Explorer Maintenance > Security > Security Zones

[
f—é This is the same Internet Properties dialog box that is found in Internet Explorer 6.0.
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pul =181X%]
BIEacon R mc B i ‘it Group Policy Object Editor: 2l x| =1t
= ﬁ com Propertie file  Action Wiew Help B | Bl
etive Drocty; | oneral| Managed By| Object | Secuity GrousFPoil oy | [ @
23 saved Que : = Select a'Web content zone to specily its security settings. —
= To improve Group Pdlicy management, upgrade to the | = SSPR TRUSTED INTRARNET SERVER. | ame —
) Management Cansole (GPMC), B d anek? 2| x g .1
{1 Builtin —_ = A= “'u‘
i[_aﬂ Compr r\ES Current Group Policy Object Links far dom & h‘ tuhse Lthe IS(Iatttlngs ktnelow to defing which Web sites areindudedin - Jocalintaret Tusled sites  Restricled b x|
Domé g . N e Local Intranet zone, sites
fLocal intranet . 2P
[ Localinanet L
(3 Loste ¥ Include all local (intranet) sites not isted in other zones ranet
& < ;| Vou can add and remove Web sites From this zone. All Web sites contains all Web sites that
NTDZ Sit
é ouA ":) in this zone will use the zone's security settings. IV Include all stes that bypass the proxy server r oiganization's intianet ek i
@l ¢ ¥ Include all petwork paths (UNCs)
i r this zone
& @ Add this Web site ta the zone:
&«
EI Progi Il é {tels) Adwanced.. o3 Cancel L
1
= :SPF Web sites: Ider Redirection LA S To ghasfgé'lﬁi settings, click Custom Level
L A
- Syete - - ey ternet Explarer Ma - To use the recommended seftings, click Default Level
Sue [http:fissprms.passlogix.com e | [EESRETE
Connection Content ratings allow you d
L and are rated by the authe
s
Sy Content Ratings Custom Level... I Diefault Level |
Programs &0 ¢ {oisal
I™ Require server verification (hitps:) for all sites in this zone istrative Templates A=
£ Import the current [
K | Cancel | Ll I
Close:
ok || cancal | sl | hep |

||

button.

10.

11.

cated.
12. Click Close.
13.

_I‘—I T

In the Internet Properties dialog box, click the Local intranet zone icon, then click the Sites

In the Local Intranet dialog box, click Advanced.
Enter the fully qualified domain name of your Password Reset IIS default website where indi-

Click OK and Apply as needed to close out of the Group Policy Object Editor.

Depending on the replication speed within your network, it could take some time to replicate this
policy throughout your Active Directory structure.

To confirm that this policy was applied at your desired level in AD:

1.

sufficient time).

Sites > Advanced.

In Internet Explorer, open Tools > Internet Options > Security > Local Intranet >

Internet Explorer should list the site you added in its Trusted Sites window.
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[

Restricting Access to the Password Reset Web Console

In order to avoid unauthorized users from accessing the Web-based Password Reset management
console, perform the following steps:

1. Open Windows Explorer and navigate to:
e On 32-bit systems: C:\Program Files\Passlogix\v-GO SSPR
e On 64-bit systems: C:\Program Files (x86)\Passlogix\v-GO SSPR

Right-click the Management Client and select Properties from the shortcut menu.
In the Properties dialog box, click the Security tab.

Click Advanced.

Click Inheritable rights for Users to clear the selection.

In the dialog box that opens, click Copy.

Click OK.

In the Security tab, remove unauthorized users.

Click Add.

Choose an Advanced search and select IIS_WPG (for Windows 2003).

Click OK.

O WV XN A WN

[
f—é All permissions except Full should be checked under the Allow column.
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Configuring Password Reset for SSL Connectivity with
Windows Server 2003/2003 R2

Before configuring Password Reset for SSL connectivity on Windows Server 2003/2003 R2, you
must obtain an X.509 Certificate from a trusted certificate authority (CA). This trusted CA must be
installed in the list of trusted Root CAs. The certificate must be valid for the current date and its
subject must exactly match the network name (either its host name or fully qualified

URL containing a host name and domain suffix) that Password Reset client instances will use when
connecting to the Password Reset server instance. The instructions in this section assume that a
valid certificate has been obtained and is ready to be installed.

F=-¥ The following articles from the Microsoft Web site can be referred to for information on
“4 installing certificates and setting up SSL:

e "How to: Obtain an X.509 Certificate” http://msdn2.microsoft.com/en-
us/library/ms819929.aspx

e "“How to: Set Up SSL on a Web Server” http://msdn2.microsoft.com/en-
us/library/aa302411.aspx

If you use Microsoft Certificate Services to obtain the X.509 certificate, choose a Server
Authentication Certificate. Also, enable the Mark keys as exportable and Use local
machine store options under the Key Options section.

The steps required to enforce SSL-only connections to Password Reset server are as follows:
1. Installing the X.509 Certificate in Microsoft IIS

Modifying the Password Reset Server Configuration Files

Granting Password Reset Server Access to the WebServices Directory

Restricting Password Reset Connectivity to SSL Only

ua A W N

Testing the New Connectivity Configuration

Step 1: Installing the X.509 Certificate in Microsoft IIS

Launch Microsoft IIS Manager.

In the left-hand pane, expand the root node, then expand Web Sites.
Right-click Default Web Site and select Properties from the context menu.
In the dialog that appears, select the Directory Security tab.

In the Secure Communications field, click Server Certificate.

A b~ WN =

In the wizard that appears, click Next.
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7. Inthe"Pending Certificate Request" dialog, select Process the pending request and
install the certificate, then click Next.

I1S Certificate Wizard

Pending Certificate Hequest

A pending certificate request iz a request to which the certification
authority hag not vet responded,

& certificate request iz pending. *Wwhat would you like to do’?
¥ Process the pending request and install the certificate

i Delete the pending request

Cancel |

8. Enterthe absolute path or navigate to the certificate file, then click Next.

IIS Certificate Wizard x|

Procesz a Pending Bequest

Process a pending certificate request b retrieving the file that contains
the certification autharity's responze.

Enter the path and file name of the file containing the certification autharity's rezponze.

Browsze. .. I

Path and file name:

< Back I MHest » I Cancel

9. Specify the desired SSL port and click Next. The default value is 44 3.
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IIS Certificate Wizard

SSL Port
Specify the 550 part far this web zite,

551 part thiz web zite should use:
443

¢ Back

Cancel |

10. Review the information displayed in the summary dialog. If there are any errors, go back and
correct them; otherwise, click Next.

IIS Certificate Yizard

Certificate Summary
Y'ou have chozen to install a certificate from a responze file,

To inztall the fallowing certificate, click Hest.
File name: C:hDocumentz and SettingzhAdminiztrator, SS0L. . oertnew, cer

Certificate detailz:

lzzued To zzolabrmem

lzzued By gzocert

E=piration D ate 1043042009
Intended Purpoze Server Authentication
Friendly Hame Default web Site
Country/R egion 115

State / Province kY

City Mew York
Organization zzolab

Organizational Unit zzolab

< Back

Cancel |

11. In the dialog that appears, take note of the Issued To value ("ssolabmem" in our example).
You will use this value to modify the Password Reset server configuration files in the next
section.

12. Click Finish to exit the wizard. The certificate is now installed.
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Step 2: Modifying the Password Reset Server Configuration Files

You must update the following configuration files to use the HTTP-over-SSL (HTTPS) protocol when
calling the Password Reset Web pages:

$PROGRAMFILES%\Passlogix\v-GO SSPR\EnrollmentClient\web.config

$PROGRAMFILES%\Passlogix\v-GO SSPR\ManagementClient\web.config

$PROGRAMFILES%\Passlogix\v-GO SSPR\ResetClient\web.config

Do the following:

1.

Modify the \EnrollmentClient\web.config file as follows:

a. Locatethe <appSettings> section.

b. Modify the Enrollsvc.enrollment key value as follows:

Changehttp tohttps.

Replace 1ocalhost with the Issued To value from your X.509 certificate.
(You recorded this value in the previous part of this procedure.)

(Optional) If you are using a custom port to connect to this service, append the port
number at the end of the host name, separated by a semicolon. For example:
https://sssolabmem.ssolab.com:1880.

c. Save and close the file.

[P Web.config - Notepad =[Ol x|

File Edit Format Yiew Help

application.
pageoutput="true", the

can wiew the

tracemode="SortEyTime" Tocalonly="true"/ >
particular session.

identifier to the URL.

sglConnectionstring="data source=127.0.0.1;user id=sa;password=" cookieless="false
timeout="20"/>

"Passpart” and "None” |
-
<authentication mode="windows" /=
<jdentity impersonate="true"/ >
<!-— APPLICATION-LEVEL TRACE LOGGING
AppTlication-Tewvel tracing enables trace log output for every page within an

set trace enabled="true" to enable application trace logging. IF
trace information will be displayed at the bottom of each page. otherwise, you
application trace Tog by browsing the "trace.axd" page from your web application
. root.
<trace enabled="false" reguastLimit="10" pageoutput="false"

<!-— SESSION STATE SETTINGS
By default asP .MET uses cookies to identify which requests belong to a

If cookies are not awvailable, a session can be tracked by adding a session
To disable cookies, set sessionstate cookieless="true"

-
<sessionstate mode="InProc” stateConnectionstring="tcpip=127.0.0.1:42424"

<l—= GLOBALIZATION
This section sets the globalization settings of the application.

<g1Eba1izatiDn regquestEncoding="utf-8" responseEncoding="utf-8",/>

o

~
\-

va1ue=“https://5501abmem/vguseWFSEfvicereset/webservices/enrDWWment.asmx”/>

<apﬁ5ettin 5>
<add key="Enrollsvc.enrollment”

</fappsettings></configuration>

Ell

2. Modify the \ManagementClient\web.config file as follows:
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a. Locate the <appSettings> section.
b. Maodify the AdminSvc.administration key value as follows:
i. Changehttp tohttps.

ii. Replace localhost with the Issued To value from your X.509 certificate.
(You recorded this value in the previous part of this procedure.)

iii. (Optional) If you are using a custom port to connect to this service, append the port
number at the end of the host name, separated by a semicolon. For example:
https://sssolabmem.ssolab.com:1880.

c. Save and close thefile.

[P web.config - Notepad =ol x|

File Edit Format Wiew Help

"Passport” and "nNone”
-z
<authentication mode="windows" />
<identity impersonate="true"/>
<l-— APPLICATION-LEVEL TRACE LOGGING
application-Tevel tracing enables trace Tog output for ewvery page within an
application.
set trace enabled="true" to enable application trace Togging. If
pageoutput="true", the
trace information will be displayed at the bottom of each page. otherwise, you
can view the
application trace log by browsing the "trace.axd" page from your web application
root.
-->
<trace enabled="false" reguestLimit="10" pageoutput="false"
traceMode="sortEyTime" Tocalonly="true"/ >
<l-— SESSION STATE SETTINGS
By default ASP .MET uses cookies to identify which reqguests belong to a
particular session.
If cookies are not available, a session can be tracked by adding a session
jdentifier to the URL.
To disabTle cookies, set sessionstate cookieless="true".
-
<sessionstate mode="InProc” stateConnectionstring="tcpip=127.0.0.1:42424"
sglconnectionstring="data source=127.0.0.1;user id=sa;password=" cookieless="false"
b

timeout="20"/

<l—— GLOBALIZATION
This section sets the globalization settings of the application.
-
<globalization reguestencoding="utf-8" responseencoding="utf-8"/>
i L
Y <apﬁsettin 5>

<add key="adminsvc. administration”
va1ue=”https:fﬁssg1abmem/vgo§e1fsetviceResetfwebServices/AdministratiDn.asmx”f>
N < fappsettingss< S configurations

3. Modify the \ResetClient\web.config file as follows:
a. Locate the <appSettings> section.
b. Maodify the ResetSvc.PasswordReset key value as follows:
i. Changehttp tohttps.

ii. Replace localhost with the Issued To value from your X.509 certificate.
(You recorded this value in the previous part of this procedure.)

iii. (Optional) If you are using a custom port to connect to this service, append the port
number at the end of the host name, separated by a semicolon. For example:
https://sssolabmem.ssolab.com:1880.

c. Save and close thefile.
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[P Web.config - Notepad =10] x|

File Edit Format Wiew Help
" ]
<authentication mode="windows"/ >
<!-— APPLICATICON-LEVEL TRACE LOGGIMG
application-Tevel tracing enables trace Tog output for ewvery page within an
application.
set trace enabled="true" to enable application trace Togging. I
pageoutput="true", the
trace information will be displayed at the bottom of each page. otherwise, you
can view the
application trace log by browsing the "trace.axd” page from your web application
root.

-
<trace enabled="false" requestLimit="10" pageoutput="false"
traceMode="SortByTime" localonly="true"/>
<!-— SESSION STATE SETTINGS
By default ASP .NET uses cookies to fdentify which reguests belong to a
particular session.
If cookies are not available, a session can be tracked by adding a session
identifier to the URL.
To disabTle cookies, set sessionsState cookieless="true".
-->
<sessionstate mode="InProc” stateConnectionstring="tcpip=127.0.0.1:42424"
sqlconnectionstring="data source=127.0.0.1;user d=sa;password=" cookieless="false"
timeout="1",>
<l-— GLOBALIZATION
This section sets the globalization settings of the application.

<globalization requestencoding="utf-8" responseencoding="utf-8"/>
<fsystem. web>
<appsettingss
<add key="adminsvc,administration”
'Ibm i 1 LIwE| I3 -+ L LIwE| .;Lm-?n%-v—w-v—-%n ey

1. Ul e e
i f o
<add key="Resersvc.Passwordreset” .
'vaWue:”https://5501abmem/vgoseWFServ1ceReset/webServ1ces/PasswordReset.asmx”/>
- <fappsettings></configuration>

Step 3: Granting Password Reset Server Access to the
WebServices Directory

1. Launch Microsoft IIS Manager.
2. Inthetreein the left-hand pane, navigate to and expand the vGOSelfServiceReset node.
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3. Right-click the Web Services node located under the vGOSelfServiceReset node, and
select Properties from the context menu.

t Internet Information Services {IIS) Manager 1ol =]
¥3 File Action Wiew Window Help ‘;lilil
¢= AEXFRAER 2E/E])r 50
-Eg Inkernet Information Services Marne | Path -
= .8 S50LABDC (local computer) _Bin

[#-_J Application Pools "l Connectors

£l web Sites | Templates

3
-

= Default web Site
[+ gl tsweb

1

E"""j wE0SelFServiceReset
: ~Ty EnrollmentClient
~T', ManagementClient

| adamschema.|dF
|=] Administr ation, asm
|=] Branding.di
[ | Enrollment. asmzx
[ | enrollment. css, kemplate

s ResetClient :
y | OracleTables. tbxt
ud Explore L
] Help E et asm:
| Images Open pp.canfig
1 license Permissions plate
- Administration ~ Browse
_| Web serwce Extens New » ‘I-S'le
__| FTP 3ites £ Tasks v I
el
Wigw FCZ el
Mew Window From Here DE.xrnl
ES.xml
Refresh I ><||'n
Expotk List... N -
=Rl
Tl
Help

|ODEI’IS the properties dialog box rer e TarTErT EETTTT |

4. Inthe dialog that appears, select the Directory Security tab.
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5. IntheIP address and domain name restrictions section, click Edit.

webServices Properties d

HTTP Headers I Cuskam Errors | ASP.NMET |
Yirtual Direckory I Cocuments Directary Security

— Authentication and access control

Enable anonyvmous access and edit the
w authentication methods For this resource. Edit...

22

—IP address and domain name restrickions

Grant or deny access ba this resource using
IP addresses or Internet domain names.

[ Secure communications

Reguire secure comrmunicakions and
enable client certificates when this
resource is accessed,

Server Cerkficate. .. |

Yiew Cerhificate, ., |

Edit... |

(] 4 Zancel Apply | Help |

6. Grant the IP address of the Password Reset server machine access to the webServices
directory:

In the dialog that appears, select Denied Access. The dialog displays a list of IP addresses

explicitly excluded from the global deny rule.

b. Click Add.

IP Address and Domain Name Restrickions x|

—IP address access restrickions
By defaulk, all computers will be: @f " Granted access

@ % Denjed access

a.

Except the Following:

Aocess | IF address [Subnet mazk]
@ Granted 9 177.0.0.1

Eemove

| s
Edit.. |

I, Cancel Help |

c. Inthe dialogthat appears, select Single Computer, enter the target IP address and click
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OK.

Tvpe:

{* Single compuker

i Group of computers

i~ Domain name

IP address:

m .o .o

124

DS Lookup. .. |

Zancel |

Help |

Step 4: Restricting Password Reset Connectivity to SSL Only

1.

2.

In the tree in the left-hand pane of Microsoft IIS Manager, right-click the vGO-
SelfServiceReset node and select Properties from the context menu.

t Internet Information Services (IIS) Manager - |EI|5|
¥3 File action Wew Window Help ‘ =1l

€ BmEEFRR @B 2]y =0

-Eg Internet Information Services
= .8 S50LABDC (local computer)
[#+_ Application Pools

Marne

| path

Mew window From Here

Refresh
Export Lisk...

Properties

Help

"b EnrollrmentClient
"b ManagementClient

B0 web Sites WMiResetclient
Eg Default Web Site '..}.'JWehServi-:es
{ ltsweh J Help
""",J
: Es
g Adrminisk Eizloe A
[-_J Web Service Qpen. _ e i
- FTP Sites Permissions angeFasswordve, exe
Browse
Hew ]
All Tasks 3
Wiew b

<]

Ci\Program Files\Passlogixiy-GO SSPRAER
Ci\Program FilesiPasslogixiy-G0 S5PRME
C:\Program FilesiPasslogixiy-G0 SSPRIRE
Ci\Program FilesiPasslogixiy-G0 SSPRY M

|Opens the properties dialog box for the current selection,

In the dialog that appears, select the Directory Security tab.
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3. Inthe Secure Communications section, click Edit.

WehServices Properties el

HTTP Headers I Cuskom Errors | A3P . MNET |
Yirtual Direckory I Ciocuments Directary Security

—futhentication and access cantral

Enable anonymous access and edit the
w authentication methads Far this resaurce, Edit...

n 2

—IP address and domain name restrickions

Garant ar deny access ko this resource using
IP addresses or Internet domain names,

Edi... |

—Secure communicakions

Require secure communications and
enable client certificates when this

resource is accessed, _ b
Wiew Cerkificate, ..

Serwver Certificate, ., |

Ik Zancel Grply Help

4. Inthe dialog that appears, do the following:
a. Select the Require secure channel (SSL) check box.

b. (Optional) If your environment requires 128-bit encryption, select the Require 128-bit
encryption check box.
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c. Click OK.

Secure Communications il

¥ Require secure chanmel {S5L)

v Require 1Z5-bit encryption

— Client cettificates
% Ignore client certificates

" Accepk dient certificates
" Require client certificates

[ Enable client certificate mapping

Client certificates can be mapped to Windows user

accounts, This allows access contraol ko resources using Edi
client certificates, dit:..

Cancel Help

5. Click OKin the parent dialog to dismiss it.
6. Restart Microsoft IIS for the changes to take effect.

Step 5: Testing the New Connectivity Configuration

Using a Web browser, access each of the Password Reset interface services using the new SSL-

enabled URLs (i.e., using the https protocol header in place of http).

The URLs are as follows:

e EnrollmentClient: https://<new host name>:<new port>/vGOSelfServiceReset/
WebServices/Enrollment.asmx

¢ ManagementClient: https://<new host name>:<new port>/vGOSelfServiceReset/

WebServices/Administration.asmx

o ResetClient: https://<new host name>:<new port>/vGOSelfServiceReset/
WebServices/PasswordReset.asmx

If any of the URLs fails to load, or a certificate error is displayed, check your configuration, such as
virtual directory permissions and certificate options, and correct it if necessary, then try again.
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Configuring Password Reset for SSL Connectivity with
Windows Server 2008/2008 R2

Before configuring Password Reset for SSL connectivity on Windows Server 2008/2008 R2, you
must obtain an X.509 Certificate from a trusted certificate authority (CA). This trusted CA must be
installed in the list of trusted Root CAs. The certificate must be valid for the current date and its
subject must exactly match the network name (either its host name or fully qualified

URL containing a host name and domain suffix) that Password Reset client instances will use when
connecting to the Password Reset server instance. The instructions in this section assume that a
valid certificate has been obtained and is ready to be installed.

F=-¥ The following articles from the Microsoft Web site can be referred to for information on
“4 installing certificates and setting up SSL:

e "How to: Obtain an X.509 Certificate” http://msdn2.microsoft.com/en-
us/library/ms819929.aspx

e "“How to: Set Up SSL on a Web Server” http://msdn2.microsoft.com/en-
us/library/aa302411.aspx

If you use Microsoft Certificate Services to obtain the X.509 certificate, choose a Server
Authentication Certificate. Also, enable the Mark keys as exportable and Use local
machine store options under the Key Options section.

The steps required to enforce SSL-only connections to Password Reset server are as follows:

1. Installing the X.509 Certificate in Microsoft IIS

Modifying the Password Reset Server Configuration Files

Granting Password Reset Server Access to the WebServices Directory
Restricting Password Reset Connectivity to SSL Only

Testing the New Connectivity Configuration

ua A W N

Step 1: Installing the X.509 Certificate in Microsoft IIS

Launch Microsoft IIS Manager.

In the Connections pane on the left, select the target server instance.

In the Home pane in the center, double-click the Server Certificates icon.
In the Actions pane on the right, click Complete Certificate Request....
In the Complete Certificate Request dialog that appears, do the following:

u A W N =

a. IntheFile name containing the certificate authority's response field, browse to or
provide the full path and file name of the target X.509 certificate.

b. Inthe Friendly name field, enter a descriptive name for the certificate.
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K E3

Complete Certificate Request

| l Specify Certificate Authority Response
a8
Complete a previously created certificate request by retrieving the File thak conkains the certificate
autharity's response,

File name containing the certification autharity's response:

IC:'l,temp'l,cert_resp.cer |

Friendly name:

|ESSO—F'R Web Server

Cancel |

c. Click OK.

The certificate appears in the target machine's Server Certificates list.
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Ug‘ Server Certificates

Use this Feature to request and manage certificates that the Web server can use with Web sites configured For 55L,

Mame = | Issued To | Issued B | Expiration Date | Certificate Hash |
WMSve-IDMMERL M S - I0M) 21
racle.lab  idmroot-I0T

Bind the installed certificate to the https protocol for the selected site. In the Connections
pane on the left, expand the target machine node and drill down to and select the Default
Web Site node.

In the Edit Site section in the Actions pane on the right, click Bindings.
In the Site Bindings dialog that appears, click Add.

Site Bindings K E3
Tvpe | Hiost Mame: | Park | IP Address | Binding Infarmation | &dd...
http &0 *
net.kcp aog* LI
A *
net.pipe REmaye |
nek. msmg localhost
rasrg. Farmatnarne localhost Browse |

Close

In the Add Site Binding dialog that appears, do the following:
a. From the Type drop-down list, select https.

b. From the Certificate drop-down list, select the certificate you installed earlier in this pro-
cedure.

c. Leavetheremaining settings at their defaults.
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Add Site Binding |

Tvpe: IP address: Paort;
Ihttps ~| IF'.II Unassigned j |443
Hosk name:

531 certificate:
JESSC-PR Web Server R B |

Cancel |

d. Click OK to save your changes and dismiss the Add Site Binding dialog.

10. Click Close to dismiss the Site Bindings dialog.

Step 2: Modifying the Password Reset Server Configuration Files

You must update the following configuration files to use the HTTP-over-SSL (HTTPS) protocol when
calling the Password Reset Web pages:

® S$PROGRAMFILES%\Passlogix\v-GO SSPR\EnrollmentClient\web.config
® SPROGRAMFILES%\Passlogix\v-GO SSPR\ManagementClient\web.config
® S$PROGRAMFILES%\Passlogix\v-GO SSPR\ResetClient\web.config
Do the following:
1. Modify the \EnrollmentClient\web.config file as follows:

a. Locate the <appsettings> section.

b. Maodify the Enrol1Svc.enrollment key value as follows:

i. Changehttp tohttps.

ii. Replace localhost with the Issued To value from your X.509 certificate.
(You recorded this value in the previous part of this procedure.)

iii. (Optional) If you are using a custom port to connect to this service, append the port
number at the end of the host name, separated by a semicolon. For example:
https://sssolabmem.ssolab.com:1880.

c. Save and close thefile.
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File Edit Format Yiew Help

[P Web.config - Notepad =[Ol x|

"Passport” and "nNone”
-
<authentication mode="windows" /=
<jdentity impersonate="true"/ >
<!-— APPLICATION-LEVEL TRACE LOGGING
AppTlication-Tewvel tracing enables trace log output for every page within an
application.
set trace enabled="true" to enable application trace logging. IF
pageoutput="true", the
trace information will be displayed at the bottom of each page. otherwise, you
can view the
application trace Tog by browsing the "trace.axd" page from your web application
root.
-
<trace enabled="false" reguestLimit="10" pageoutput="false"
tracemode="SortEyTime" Tocalonly="true"/ >
<l-- SESSION STATE SETTINGS
By default asP .MET uses cookies to identify which requests belong to a
particular session.
If cookies are not awvailable, a session can be tracked by adding a session
identifier to the URL.
To disable cookies, set sessionstate cookieless="true"
-
<sessionstate mode="InProc” stateConnectionstring="tcpip=127.0.0.1:42424"
sglConnectionstring="data source=127.0.0.1;user id=sa;password=" cookieless="false"
timeout="20"/>

<l-— GLOBALIZATION
This section sets the globalization settings of the application.
-
<globalization requestEncoding="utf-8" responseEncoding="utf-8",>
+ o =8
( <apﬁ5ettin 5>
<add key="Enrollsvc.enrollment” .
value="https:/ ssolabmem/vgoselfservicereset /webservices /enrolIment. asmx" /=
k </fappsettings></configuration>

Ell

Modify the \ManagementClient\web.config file as follows:

a. Locatethe <appSettings> section.

b. Modify the AdminSvc.administration key value as follows:
i. Changenttp tohttps.

ii. Replace localhost with the Issued To value from your X.509 certificate.
(You recorded this value in the previous part of this procedure.)

iii. (Optional) If you are using a custom port to connect to this service, append the port
number at the end of the host name, separated by a semicolon. For example:
https://sssolabmem.ssolab.com:1880.

c. Save and close the file.
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[P Web.config - Notepad =10] x|

File Edit Format Wiew Help

"Passport” and "Mone"
-
<authentication mode="windows"/ >
<jdentity dmpersonate="true" />
<!-— APPLICATICON-LEVEL TRACE LOGGIMG
application-Tevel tracing enables trace Tog output for ewvery page within an
application.
set trace enabled="true" to enable application trace Togging. I
pageoutput="true", the
trace information will be displayed at the bottom of each page. otherwise, you
can view the
application trace log by browsing the "trace.axd” page from your web application
root.
-
<trace enabled="false" requestLimit="10" pageoutput="false"
traceMode="SortByTime" localonly="true" />
<!-— SESSION STATE SETTINGS
By default ASP .NET uses cookies to fdentify which reguests belong to a
particular session.
If cookies are not available, a session can be tracked by adding a session
identifier to the URL.
To disabTle cookies, set sessionsState cookieless="true".
-->
<sessionstate mode="InProc” stateConnectionstring="tcpip=127.0.0.1:42424"
sglconnectionstring="data source=127.0.0.1;user id=sa;password=" cookieless="false"
timeout="20"/>

. <l'-- GLOBALIZATION . . . .
This section sets the globalization settings of the application.
——x
<globalization requestencoding="utf-8" responseencoding="utf-8"/>
E-T L,
4 <apﬁ5ettin S

<add key="adminsvec.administration” L. .
wvalue="https:/ ss0labmemvgoselfservicereset Awebservices fadministration. asmx" />
N <fappsettings></configuration>

Modify the \ResetClient\web.config file as follows:

a. Locatethe <appSettings> section.

b. Modify the ResetSvc.PasswordReset key value as follows:
i. Changenttp tohttps.

ii. Replace localhost with the Issued To value from your X.509 certificate.
(You recorded this value in the previous part of this procedure.)

iii. (Optional) If you are using a custom port to connect to this service, append the port
number at the end of the host name, separated by a semicolon. For example:
https://sssolabmem.ssolab.com:1880.

c. Save and close the file.
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[P Web.config - Notepad =10] x|

File Edit Format Wiew Help
" ]
<authentication mode="windows"/ >
<!-— APPLICATICON-LEVEL TRACE LOGGIMG
application-Tevel tracing enables trace Tog output for ewvery page within an
application.
set trace enabled="true" to enable application trace Togging. I
pageoutput="true", the
trace information will be displayed at the bottom of each page. otherwise, you
can view the
application trace log by browsing the "trace.axd” page from your web application
root.

-
<trace enabled="false" requestLimit="10" pageoutput="false"
traceMode="SortByTime" localonly="true"/>
<!-— SESSION STATE SETTINGS
By default ASP .NET uses cookies to fdentify which reguests belong to a
particular session.
If cookies are not available, a session can be tracked by adding a session
identifier to the URL.
To disabTle cookies, set sessionsState cookieless="true".
-->
<sessionstate mode="InProc” stateConnectionstring="tcpip=127.0.0.1:42424"
sqlconnectionstring="data source=127.0.0.1;user d=sa;password=" cookieless="false"
timeout="1",>
<l-— GLOBALIZATION
This section sets the globalization settings of the application.

<globalization requestencoding="utf-8" responseencoding="utf-8"/>
<fsystem. web>
<appsettingss
<add key="adminsvc,administration”
'Ibm i 1 LIwE| I3 -+ L LIwE| .;Lm-?n%-v—w-v—-%n ey

1. Ul e e
; ' <add key="ﬁ'esetsvc.PasswurdReset" )

'vaWue:”https://5501abmem/vgoseWFServiceReset/webServices/PasswordReset.asmx”/>
- <fappsettings></configuration>

Step 3: Granting Password Reset Server Access to the
WebServices Directory

1. Launch Microsoft IIS Manager if it is not already open.

2. Inthe Connections pane on the left, expand the target machine node and drill down to and
select the Sites > Default Web Site > WebServices node.

3. Inthe Default Web Site Home pane in the center, double-click the IP Address and
Domain Restrictions icon.

In the Actions pane on the right, click Add Allow Entry... .
5. Inthe Add Allow Restriction Rule dialog that appears, do the following:

a. Select the Specific IP Address radio button.
b. Enterthe IPv4 or IPv6 address of the target machine.
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Add Allow Restriction Rule 2 x|

Allow access for the following IP address or domain name:

¥ Spedific IP address:

IfEBEI: 1897dee00E87c 1 2819010

" 1P address range:

QK I Cancel

c. Click OKto save your changes and dismiss the dialog.

Step 4: Restricting Password Reset Connectivity to SSL Only

Launch Microsoft IIS Manager if it's not already open.

In the Connections pane on the left, select the target machine node.

Under the target machine node, drill down to and select the Sites > Default Web Site node.
In the Default Web Site Home pane in the center, double-click the SSL Settings icon.

In the SSL Settings screen in the center pane, select the Require SSL check box and leave
the Client certificates option at its default value.

u A W N

g SSL Settings

This page leks wou modify the S5L settings for the content of a \Web site or application,
v Fequire 5L

Client certificates:
' Ignare
. Accepk
™ Require

6. Inthe Actions pane on the right, click Apply to save your changes.

Step 5: Testing the New Connectivity Configuration

Using a Web browser, access each of the Password Reset interface services using the new SSL-
enabled URLs (i.e., using the https protocol header in place of http).
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The URLs are as follows:

e EnrollmentClient: https://<new host name>:<new port>/vGOSelfServiceReset/
WebServices/Enrollment.asmx

¢ ManagementClient: https://<new host name>:<new port>/vGOSelfServiceReset/
WebServices/Administration.asmx

o ResetClient: https://<new host name>:<new port>/vGOSelfServiceReset/
WebServices/PasswordReset.asmx

If any of the URLs fails to load, or a certificate error is displayed, check your configuration, such as
virtual directory permissions and certificate options, and correct it if necessary, then try again.
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Installing Password Reset Client-Side Software

Ez‘ The Password Reset Client Installer provides the following functions:
o

e Supplies the components needed to run Password Reset through the
Windows interface

e Sets the registry values that point the Password Reset client to the
enrollment and reset service

o Offers or obliges workstation users to enroll in the password reset service if so
configured

To install and configure the Password Reset client-side software, make sure you have created a
functioning installation of Password Reset server as described in Installing the Password Reset
Server-Side Component.

F-¥, To perform an unattended ("silent") installation of the Password Reset client, see
“d Installing the Password Reset Client-Side Software from the Command Line.

Then, follow the instructions in Installing the Logon Manager Client-Side Software and do the
following when prompted by the installer:

1. When prompted to select between a Typical and Advanced installation, select Advanced.

2. Inthe Advanced Setup screen, click Password Reset Client and select This feature, and
all subfeatures, will be installed on local hard drive. Make any other installation
choices as desired, then click Next.

3. Inthe Setup Configuration Information screen, enter the Password Reset Server URLs:

I

Setup Configuration Information

Please enter the appropriate configuration information below

Check Enroll URL

Check Force Enroll URL

Enroll URL

Reset LIRL

Check Status URL

InstallShield

When you have finished, click Next.
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4. Continue the installation process as prompted by the installer and described in Installing the
Logon Manager Client-Side Software.

Installing Password Reset Language Packs

In order to install additional language packs after initial installation:

1. Inthe Windows control panel, launch Add/Remove Programs.
Highlight Logon Manager and click the Change button.
Navigate through the install wizard and click the Modify button.
Select the additional language packs that you want to install.

Reboot as instructed and re-launch Add/Remove Programs to complete the additional lan-
guage installation.

ua A W N

Reverting to the Original Language Pack After Installing Another

To revert to the original language pack after you've installed another one:

1. Launch Add/Remove Programs and modify the Logon Manager
installation to set the appropriate language pack.

2. Reboot as instructed after the installation finishes.

3. Repair the installation.

F-¥ You must repair the installation after modifying it. Failure to do so will cause improper
b functionality of the GINA button.

Installing Language Packs at the Command Line

In order to install the various language packs, you must install Password Reset using command
line switches as illustrated below; otherwise the GINA stub will not appear on localized operating
systems. You install the desired language pack by adding the language name to the string that
follows the ADDLOCAL switch.

Following is the minimum command line for the ADDLOCAL switch:

msiexec /i "Location of .msi" ADDLOCAL=Gina,VersionTracker,English,
CheckEnrollment.x86 only,Release Only

And following is an example of a command line to install silently (/q) with the German language
pack added:

msiexec /i "Location of .msi" /g ADDLOCAL=Gina,vgo sspr client,English,German,
CheckEnrollment.x86 only,Release Only

/i = Install
/g = Quiet installation
ADDLOCAL = Follow with options to install (listed below)
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ADDLOCAL Options
Gina

e Required for all operating systems prior to Windows 7 (Windows Vista is not supported)
e Do notinclude for Windows 7

Required Items

e VersionTracker
e One of the following:

o CheckEnrollment.x86_only (32-bit operating systems)

o CheckEnrollment.x64_only (64-bit operating systems)
e One of the following:

o Release_Only (32-bit operating systems)

o Release_Only.x64 (64-bit operating systems)

For Installation with Windows Windows 7

e Vista_Only (32-bit)
e Vista_Only.x64 (64-bit)

Installable Language Packs (always install English)
e Brazilian Portuguese

e Czech

e Danish

e Dutch

e English

e Finnish

e French

e German
e Greek

e Hungarian
e Italian

e Japanese
e Korean

e Norwegian
e Polish

e Portuguese
e Romanian
e Russian

e Simplified Chinese
e Slovak

e Spanish
e Swedish
e Thai
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e Traditional Chinese
e Turkish
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Installing the Password Reset Client-Side Software
from the Command Line

F-* If you are upgrading the Client from an earlier version on the Microsoft Windows 7
=4 32-bit operating system, you must uninstall the older version before performing the
following procedure.

The Password Reset client can be installed via an msiexec command, using the following syntax:
msiexec /i [/g] c:\ESSO-LM installer.msi programURLs [REBOOT=ReallySuppress]

/g = Quiet Mode: Suppress all installer user-interface messages. Refer to the
description of other Windows Installer command line options for msiexec at

http://msdn.microsoft.com.

REBOOT=ReallySuppress = Tellsthe Installer not to reboot under any circumstances.

Example

Using the following command line, you can perform a silent installation without a reboot of the
workstation. This command assumes that the user’s Windows directory is Windows and the Logon
Manager installer file is named ESSO-LM_ installer.msi:

c:\windows\system32\msiexec /i /g c:\ESSO-LM installer.msi
REG_CHECKENROLLURL="http://host/vgoselfservicereset/resetclient/

checkenrollment.aspx"
REG_CHECKFORCEENROLLURL="http://host/vgoselfservicereset/resetclient/

checkforceenrollment.aspx"
REG_ENROLLURL=" http://host/vgoselfservicereset/enrollmentclient/enrolluser.aspx"

REG RESETURL="http://host/vgoselfservicereset/resetclient/default.aspx"
REG_CHECKSTATUSURL="http://host/vgoselfservicereset/resetclient/

checkstatus.aspx" REBOOT=ReallySuppress

¥ You must type out the full path to the installer .msi, as in the example above. A single
~4 space must separate each REG_*="*.aspx”—not a line return.

ProgramURLs (required)

REG_CHECKENROLLURL=" http://host/vgoselfservicereset/resetclient/checkenrollment.aspx"

REG_CHECKFORCEENROLLURL="

http://host/vgoselfservicereset/resetclient/checkforceenrollment .aspx"

REG_ENROLLURL="http://host/vgoselfservicereset/enrollmentclient/enrolluser.aspx"

REG_RESETURL=" http://host /vgoselfservicereset/resetclient/default.aspx"

REG_CHECKSTATUSURL="http://host /vgoselfservicereset/resetclient/checkstatus.aspx"

Where: host is the server name (or IP address) of the server that is running the Password Reset
service.

Installing Password Reset without Logon Manager

To install Password Reset only on an end-user workstation without installing Logon Manager, use
the following command:

msiexec /i ""<lm installer>.msi" TRANSFORMS="pr client only.mst"
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Be sure to specify the full path and name to the installer file and the full path to the transform file.
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Completing the Installation of the Password Reset
Client

Perform the steps in this section to complete the installation of Password Reset Client component.

(Optional) Running the Reset Client Under a Specified User
Account

The Password Reset client provides the ability to run the Reset client under a specified user
account instead of the Local System account. This eliminates the possibility that the Reset client
will have rights to access resources it should not.

To enable this feature, follow these steps:

1. Open acommand prompt and run aspnet_setreg -k:sof-
tware\passlogix\sspr\windowsinterface -u:domain\username -p:password,
Replace domain\username and password with real values.

2. Ensurethat the key HKLM\Software\Passlogix\SSPR\WindowsInterface\ASPNET SETREG
exists. There should be two values in the key: password and userName.

3. Renamethe ASPNET SETREG key to RestrictedUser.

The Reset Client should launch under the configured user. The Enrollment Client will run
under the logged on user.

To test this feature:

1. Open the Registry and browse to HKLM\Software\Passlogix\SSPR\WindowsInterface.
2. Copy the value of Enrol11URL and set ResetURL to that value.
3. Launch the Reset client. The Enrollment screen opens.

The Enrollment screen should identify you as the specified user successfully.

Disabling the “"Redirection” Popup

You can disable the popup that indicates that Password Reset is redirecting the user to an external
reset page.

To disable this popup, the Password Reset client will create the following setting before launching
windowsinterface.exe, and then restore it after redirection: HKEY_CURRENT_
USER\Software\Microsoft\ Windows\CurrentVersion\Internet Settings Value:
WarnonZoneCrossing.

Specifying a Custom Window Title

You can configure Password Reset so that the Password Reset GINA button displays as a banner at
the top of any window you choose.

ORACLE Forgotyour password? Click here o resetit

To specify the windows that display this banner, add them to thelist in:
HKLM\Software\Passlogix\SSPR\WindowsInterface\xx\GinaWindows

where xx is the two-letter language code of the currently installed Password Reset language pack.
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Within this key, add a REG_sz value for each window title that you want to have display the
banner. The value name will be WindowTitleX, where X is a sequence number starting from 1, and
the value data is the window title. For example:

e WindowTitlel=Log On to Windows
e WindowTitle2=Unlock Computer

-
f;é The window title must match exactly, including any leading or trailing white space.

Using Password Reset Client With a Custom Reset Web
Application

You can configure the Password Reset client in the absence of a Password Reset server installation.
Follow the instructions to install Password Reset on the client machine.

1. Setthe ResetURL value to point to the custom reset Web application.

2. Set the StatusURL to a resource that will return the success response. This forces Password
Reset to bypass the status check and display the ResetURL contents. See below for details.

The StatusURL setting should point to a resource (such as an HTML file) that contains the
following content:

<HTML>

<HEAD>
<TITLE>CHECKSTATUS</TITLE>
</HEAD>

<BODY>

GOOD SSPR STATUS

</BODY>

</HTML>
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Installing Provisioning Gateway

This section describes the steps necessary for installing Provisioning Gateway.
It covers the following topics:

e Prerequisites for Installing Provisioning Gateway

e Upgrading an Existing Provisioning Gateway Installation

e Installing the Provisioning Gateway Server-Side Component
e Completing the Installation of Provisioning Gateway
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Prerequisites for Installing Provisioning Gateway

Before you install Provisioning Gateway, ensure the prerequisites listed in this section have been
satisfied.

F-¥ Please refer to the latest release notes to find out about last-minute requirements or
“4 changes that might affect your installation.

Prerequisites for Installing the Provisioning Gateway Client-Side
Component

e The Provisioning Gateway client-side component at the very minimum requires the following
software to function:

o Internet Explorer 8.0 and above with 128-bit encryption or Mozilla Firefox 5.0 and above
o Microsoft® .NET Framework 2.0 (installed as part of the Provisioning Gateway setup)

o Microsoft Web Services Enhancements 3.0 (WSE 3.0) (installed as part of the Provisioning
Gateway setup)

o In order for the Provisioning Gateway support for the Logon Manager Agent to function prop-
erly, Logon Manager must be installed.

o Ifyou areinstalling the optional command-line interface, you must install a Java runtime
environment version 1.6 or later on the target machine.

Prerequisites for Installing the Provisioning Gateway Server-
Side Component

e In order toinstall the Provisioning Gateway server-side component, you must run the installer
as a user with administrative privileges; otherwise, the installer will fail.

e Provisioning Gateway Server at the very minimum requires the following software to function:

o Microsoft Windows Server 2003/2003 R2, or Windows Server 2008/2008 R2.

o Microsoft Internet Information Server version 5.0 or later (6.x is recommended
and is necessary if you are using Windows Server 2008) Provisioning Gateway
uses the IIS Web server to provide a browser-based interface for user enroliment,
general setup, and administrative tasks.

¥ If you are installing Provisioning Gateway Server with IIS 7.0 running on Windows
“4 Server 2008, you must configure IIS 7.0 to run the Provisioning Gateway Web
application as described in Installing Provisioning Gateway Server on Windows Server
2008 as well as complete the post-installation steps described in Completing the
Installation of Provisioning Gateway.

o Microsoft Active Directory®, Microsoft ADAM/AD-LDS, Oracle Directory Server
Enterprise Edition, Oracle Unified Directory, Oracle Virtual Directory, IBM LDAP
Directory, Oracle Internet Directory, Novell eDirectory Server.

F=* If Active Directory or ADAM/AD-LDS is used, the anonymous account used in IIS must
“4d have administrative privileges and the server must be joined to the domain.

o Microsoft SQL Server 2000, Microsoft SQL Server 2000 Desktop Engine (MSDE
2000), Microsoft SQL Server 2005 Express Edition, or Microsoft SQL Server 2005
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(only required if you are using event logging) , or
o Oracle database

e During the installation of Provisioning Gateway, you must provide the following information to
set up a connection to your Provisioning Gateway repository:

host | Name of the server hosting the directory server instance.
port | Port number of directory server instance.
namel[name2, name3] | Distinguished name of the directory server domain root.

e An X.509 Certificate for SSL must be obtained from a certificate authority (CA). A trusted root
CA certificate should also be downloaded from your certificate authority into the list of trusted
root CA certificates on the local computer. For more information, see Completing the
Installation of Provisioning Gateway.

A certificate setup guide is provided with the documentation suite. If you do not have a
certificate authority in place and want to use Microsoft Certificate Services to obtain certificates,
refer to the Oracle Enterprise Single Sign-On Suite Plus Administrator's Guide, which explains
how to obtain the necessary certificates using Microsoft Certificate Services.

Installing Provisioning Gateway Server on Windows Server 2008

Because Windows Server 2008 uses a hewer version of IIS (Internet Information Services), you
must turn on IIS compatibility mode for the previous version of IIS if you are installing the
Provisioning Gateway Server on a Windows 2008 Server machine.

To add the IIS 6 Management Compatibility role service to IIS:

1. Start your Windows 2008 Server.
2. From the Initial Configuration Tasks screen, under Customize This Server, click Add Roles.
3. IntheRoles window, select Web Server (IIS); click Next.
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Add Roles Wizard

Server Roles

Web Server (II5)
Role Services

Confirmation

Progress

Results

Select one or more roles to install on this server,

Roles:

|:| Active Directory Certificate Services

|:| Active Directory Domain Services

|:| Active Directory Federation Services

[ Active Directory Lightweight Directory Services
D Active Directory Rights Management Services
[] application Server

|:| DHCP Server

|:| DMS Server

|:| Fax Server

[ File Services

] Metwork Policy and Access Services

D Print Services

[] Terminal Services

[] uDDI Services

Web Server (IIS)
] windows Deployment Services
] windows Server Update Services

More about server roles

Description:

Web Server (I1S) provides a reliable,
manageable, and scalable Web
application infrastructure.

< Previous | Next > I Imstall | Cancel |

4. Inthe Role services window, select the Windows Authentication service under Web Server

> Security.

5. Inthe Role services window, scroll down and select IIS 6 Management Compatibility.

Role services:

[ ] Digest Authentication

[ ] client Certificate Mapping Authentication

=]

[] 115 Client Certificate Mapping Authentication

[] URL Authaorization
Request Filtering
[] 1P and Domain Restrictions
E= [E Performance
Static Content Compression
|:| Dynamic Content Compression
= [E Management Tools
115 Management Console
[] 115 Management Scripts and Tools
|:| Management Service

=R 115 5 Management Compatibility
k IS 6 Metabase Compatibility

115 & WMI Compatibility
II5 & Scripting Tools
IIS & Management Console
= [] FTP Publishing Service
[] FTP server
|:| FTP Management Console
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6. Click Next.
7. From the Confirmation screen of the Add Roles wizard, click Install.

8. After configuring IIS 6 Management Compatibility, install the Provisioning Gateway Server as
described in Installing the Provisioning Gateway Server-Side Component.

(Windows 2008 Server Only) Creating a Classic .NET Application
Pool for Provisioning Gateway Server

Before installing, Provisioning Gateway, you must create a classic .NET application pool. You will
move the Provisioning Gateway Web application into this pool after installation.

1. Launch Microsoft IIS Manager.

2. From the tree, select server_name > Application Pools.

3. Right-click Application Pools and select Add Application Pool... from the drop-down menu.
4

For the name of the new app pool, enter Classic .Net App Pool. From the Managed Pipeline
Mode field drop-down menu, select Classic.

Q§l Application Pools

This pace lets vou view and manaae the list of aoolication pools
kil Add Application Pool 7] x|
proce

isnlat Name:

Filte ICIassic MET AppPool

k

Mam  .MET Framework version: ged P
E¥c [ .neT Framework v2.0.50727 =l lrated
B rated

Managed pipeline mode:

¥ start application pool immediately

0K I Cancel

< | i

F=¥ For all Web Services using .NET and IIS, where .NET is installed before IIS is
“4 configured, you must run the following command after creating the classic
application pool:

aspnet regiis -i

The location of the aspnet_regiis tool is as follows:

e 32-bit systems: %WINDIR%\Microsoft.NET\Framework\v2.0.50727
e 64-bit systems: %WINDIR%\Microsoft.NET\Framework64\v2.0.50727
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Prerequisites for Unattended (“Silent”) Installations

In order to successfully install Provisioning Gateway in unattended ("silent") mode, the Windows
Management Instrumentation (WMI) service must be running before the installer is executed.

To check whether the WMI service is running, and start it if necessary, do the following on each
target machine:

1.
2.
3.

5.

Open the System Management Console.
Open the Services snap-in.

Navigate to the Windows Management Instrumentation service and check its status and
startup mode.

Depending on the status, do one of the following:

e Ifthe statusis Started, the WMI service is running; proceed to the next
section.

e Ifthe statusis blank, check the service's startup type and start it as follows:
o Ifthe startup type is Disabled, do the following:
1. Double-click the service.

2. Inthedialog box that appears, change the startup type to Manual or Automatic,
as required by your environment.

Click Apply.
4. Click Start to start the service. The status changes to Started.
o Ifthe startup type is not Disabled, do the following:
1. Double-click the service.
2. Inthedialog box that appears, Click Start to start the service.
3. The status changes to Started.
4. Click OK.

Click OK to close the service properties dialog box.
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Upgrading an Existing Provisioning Gateway
Installation

If you are upgrading from an earlier version of Provisioning Gateway, perform the following
procedures:

e Provisioning Gateway Server. Follow the instructions in Installing Provisioning Gatewayto
install Provisioning Gateway Server. After running the installer, reset Microsoft IIS and verify
that the anonymous service accounts are still assigned.

o Provisioning Gateway Agent. The Agent has been integrated into Logon Manager and is
installed with it automatically. To upgrade, uninstall all previous versions of Provisioning Gate-
way Agent, shut down the Logon Manager, then follow the instructions in Installing the Logon
Manager Client-Side Software. After running the installer. Restart Logon Manager when done.

— Page 99 of 174 —



Installing the Provisioning Gateway Server-Side Component

Installing the Provisioning Gateway Server-Side
Component

To install and configure the Provisioning Gateway Server:

1.

2.
3.
4

Close all programs.
Launch the ESSO-PG_Server.msi installer file.
On the Welcome Panel, click Next.

On the Customer Agreement screen, enter your user name, organization name, and select
who to Install this application for: All Users or Only for you. Click Next.

On the Setup Type screen, select Complete or Custom. Complete installs all program files.
Custom allows you to choose which program files are installed and where they are installed.
Custom installations are only recommended for advanced users. Click Next.

Provisioning Gateway is ready to be installed. Click Install. Wait for the installation to com-
plete. When it is done, click Finish.
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(Optional) Installing the Client-Side Provisioning
Gateway Command-Line Interface (CLI)

F-* This installation procedure is optional. The Provisioning Gateway Client CLI SDK is
=4 supplied as an integration component for Provisioning Solutions.

This software requires that a Java runtime environment version 1.6 or later is installed
on the target machine.

The Provisioning Gateway Server provides a Web service that allows integration with other third-
party provisioning systems. The Provisioning Gateway CLI is used to communicate with this Web
service. You can use it as a traditional scripting tool or, if you prefer, you can use the SDK library to
develop more complex integration solutions and connectors for the Provisioning Gateway Server.

Complete the following procedure to install and configure the Provisioning Gateway CLI. For more
information on the CLI syntax and usage, refer to the Provisioning Gateway CLI Guide.

1. Close all programs.

2. Launch the ESSO-PG_ClientCLI.msi installer file.

3. Onthe Welcome Panel, click Next.
4

On the Customer Agreement panel, enter your user name, organization name, and select who
to Install this application for: All Users or Only for you. Click Next.

5. The Setup Type panel appears. Select Complete or Custom. Complete installs all program
files; Custom allows you to choose what program files are installed and the location. Custom
installations are only recommended for advanced users. To install the Java CLI, you must
choose the custom panel. Installation choices for the Java CLI are JDK 1.4 or 1.5.

r‘.:? Oracle Enterprise Single Sign-on Provisioning Gateway CLI - InstallShield Wizard E]

Custom Setup
Selact the program Features you want instalied, b "
Chek on an kcon in the lisk below to change how a festure i installied.
Feabure Desoription
= E- (ich: LI
=] METCLI The E550-PG Clent Command
' Lirwe Initerface

¥ = | Java CLI for JOK 1.5
¥ = | Java CLI For JOK 1.4

This Feature requires 1KEB on
your hard drive, It has 1 of 3
subfestures selected, The
subfestures require 188 KE on
your hard drive.

Install bo:
Ci\Program Files\Passlogix) Changs...

[ Help J [ spece |[ <Back [ met> ][ canced |

6. Select the proper setup options and click Next.
7. Provisioning Gateway is ready to be installed. Click Install.
8. When the installation is complete, click Finish.
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Completing the Installation of Provisioning Gateway

This section describes the tasks necessary to create a fully functional Provisioning Gateway
deployment. It covers the following topics:

(Windows Server 2008 Only) Creating an Application Pool for Provisioning Gateway
Setting the CycleInterval Registry Key

Granting Provisioning Rights to Domain Users

Configuring Syslog

Creating or Identifying a User Account for Anonymous Logon

Granting the IIS Anonymous Account Access to ADAM/AD-LDS

Configuring Provisioning Gateway for SSL Connectivity

(Windows Server 2008 Only) Creating an Application Pool for
Provisioning Gateway

After installing Provisioning Gateway on Windows Server 2008 and above, you must move the
Provisioning Gateway Console and Provisioning Gateway Service Web applications into the classic
.NET application pool you created before the installation.

1.
2.

Launch Microsoft IIS Manager.

In the tree, navigate to server_name >Sites>Default Web Site and right-click v-GO PM
Console.

Select Manage Application >Advanced Settings. In the Advanced Settings window, select
Application Pool. In the Select Application Pool window, select Classic .NET AppPool.
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4,

2 x

B (General)
Application Pool
Physical Path

rtual Path

El Behavior
Enabled Protocols

Fhysical Path Credentials
Physical Path Credentials Logon Type

DefaultAppPool
C:\Program Files\Passlogbd\v-G0 PM\Console

ClearText

1201 PM Conen
Ju-G0 PM Console

http

Application pool:

DefaultAppPool

DefaultAppPool

Met Framework Version: 2.0
Fipeline mode: Integrated

Application Pool

[@pplicationPool] Configures this application to run in the spedfied application poal.

QK Cancel |

4

Click OK.

5. Repeat this procedure to move the Provisioning Gateway Service into the Classic .NET App

Pool.

Configuring a 64-bit OS to Run Provisioning Gateway Server

On a 64-bit Windows 2003 Server, you need to enable IIS 6.0 to run 32-bit applications. To do so:

1.

Open a command prompt and navigate to the %systemdrive%\Inetpub\AdminScripts direc-

tory.

Type the following command:

cscript.exe adsutil.vbs set W3SVC/AppPools/Enable32BitAppOnWin64d “true”

Press ENTER.
Restart IIS.

[t
fgj These steps should be done after installing the Provisioning Gateway Server.
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On a 64-bit Windows 2008 Server, you must enable running 32-bit applications for the Classic

.NET Application Pool:

1. Open Internet Information Services (IIS) Manager.
2. Click Application Pools.
3. Right-click Classic .NET AppPool and select Advanced Settings...
4. Change "Enable 32-bit Applications" settings to True and click OK.
E (General) =
MET Framewark Version w20
Enable 32-Bit Applications ;I
Managed Pipeline Mode Classic
lame Classic .MET AppPoo
Queue Length 1000
Start Automatically True
E CPu
Lirit 0
Limit Action MoAction
Limit Interval (minutes) 5
Processor Affinity Enabled False —
Processor Affinity Mask 4294967295
E Process Model
Identity ApplicationPoolldentity
Idle Time-out (minutes) 20
Load User Profile False
Maximum Worker Processes 1
Ping Enabled True
Ping Maximum Response Time (seconc 90
Ping Period (seconds) 30
Shutdown Time Limit (seconds) a0
Startun Time Limit {eecnnds) LTl l
Enable 32-Bit Applications
[enable32BitAppOnWing4] If set to true for an application pool on a 64-bit operating
system, the worker process(es) serving the application pool will be in WOWa4
(Windows on Windowsa4) mode, Processes in WOWE4 mode are 32-bit processes...
oK Cancel |
A
5. Restart IIS.

Granting the Required Permissions to the PMSERVICE Account

You must grant the permissions required by Provisioning Gateway to each repository container
holding user data to the PMSERVICE account as follows:

1. Inthe repository, navigate to the Logon Manager configuration data container (usually named
SSO0Config) and open its permission dialog, then do the following:
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a. Select This object and all child objects from the Apply onto: drop-down list.

b. Grant the PMSERVICE account read-only access to the SSOConfig container.

2. Navigate to the Users container and open its permissions dialog and do the following:

a. Select User Objects from the Apply Onto: drop-down list.
b. Grant the PMSERVICE account the following ALLOW privileges:
e Create vGOConfig Objects
e Delete vGOConfig Objects
e Create vGOUserData Objects
e Delete vGOUserData Objects

e List Contents

e Read All Properties

o Read Permissions

3. Grant the PMSERVICE account the Full Control privilege over vGOConfig objects:

2 active Dueciory Users ond Computers =
) He pmen Vew Wndw b ali) ]
- - | T e pT—r—— 1l
m— - Pearnission [nbry for Users x
Aetive Directort Guangasl| Dbt Socurty | Pesmiviora | sudting | G | Eflecs 2
F- ) Seved o : Dby IM |
= oecacor  fioun of ube names T i moes indemation sboul 1pecie
s ) Bt a!ﬂmmmlﬁﬂfﬁ'\idﬂwaml
51 ) Compud Pominion Home: [ EEENIEI OGP Change.
: EII d €1 ENTERPRISE DOMAM CONTROLLERS - - —I
o ) Favign | 1 PMADMIN [PMADMBIEORCA COM) p =] | [a0tong abrects =
3 Letarn 1] Foetofirnioons 2000 Compaibie Access [DACAPrewindwa 2 | jpe  FaiaDMI PMADML F PRS-
CHR )= -1 ﬂp‘wﬂwaﬂs [OECAN e O pesesicas] Ales  PMADMIH [PMEDM . [ -
@ ) frogar | dalor. - Alowi PMEDM. F Full Corecd =] o
. Al PMADMIN PMADM. F Lih Coribarit
S Agd Bome | s PMADMIN PMEDM F a g
il iy Al PMADMIHPMeDW p | [YRedAdPropertis =] =
=1 Users Presmms pont b FMADIMIN Bl ey Abow Pt Dgeraton JORC . € wiibe 41 Propesties =) ||
I WERE o Cort ] ] - ¢ Dielete 5] a
Flesd a a g | [ Fiead Perat tior A [m|
taletn o o . Wbty Prerarziors a o
ki able g |
Crnste A D Dbjects o B || e vl it ety | | | 1205 O a o
Diedete A0 (i Clbsects o o T 5] [m]
ol Perms o =] m]
Fion wppecial e sons or bt sdhvanced reftings . Sdpsre Voreplacn ol permiiion enities vith ¥
cheh, Advarced S
. abnd 3083 Cool
Appky these pasvsions b dhiects andior 1]
o Cencel I Cortarers vttt i, |

4. Grant the PMSERVICE account the Full Control privilege over vGOLocatorClass objects:
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6. Grant the PMSERVICE account the Full Control privilege over vGOSecret objects:
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Setting the CyclelInterval Registry Key

In order for Provisioning Gateway to function properly, the Provisioning Gateway Agent must
synchronize to retrieve the provisioning instructions from the directory.

When you deploy Provisioning Gateway, you must decide on the synchronization interval. The
CycleInterval registry key is used to force synchronization to occur on a regular interval. If this is
not set to a non-zero value, synchronization only occurs upon some user action. This is not the
desired behavior with Provisioning Gateway. Oracle recommends that this key be set to a value, for
example, 15 minutes. This setting would guarantee that the provisioning instructions are pulled
down from the directory within 15 minutes (or whatever interval is set) of when they are put
there by the Provisioning Gateway Server.

The cycleInterval registry key can be set through the Oracle Enterprise Single Sign-On
Administrative Console:

1. Open the Oracle Enterprise Single Sign-On Administrative Console by clicking Start>Pro-
grams > Oracle > Oracle Enterprise Single Sign-On Administrative Console.

2. Expand Logon Manager > Global Agent Settings, expand Live, and click Syn-
chronization.

3. Set the Interval for automatic re-sync setting to the desired value.
Click Tools > Write Global Agent Settings to HKLM.
5. The Apply Settings dialog opens. Click Yes.
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{7 Applications Oplions
-L[F| Kiosk Manager Synchronizer order [l
Pravisioning Gateway
E]---ﬁ Universal Authentication Manager Use configuration objects [ | Ne
{=* Shared Accounts ] ]

----- & Password Generation Policies Allow disconnected operation [0 | Yes
----- () Passphrase Questions X
(- I Credential Sharing Groups Delete local cache )
~{&) Exclusions Deleted credential cleanup [ |3

=k ﬁﬁ bealﬁgentSeﬂmgs
Sy Live Location of entlist.ini file [F

- E] User Experence

E[| Authertication Behavior

@ [2] Synchronization

% Security ‘ait for synchronization at startup [ | Yes

DI Custom Actions {nterval for automatic | -

-] Audit Logging resynchronization 15 -

E[I Kiosk Manager Optimize synchronization [ | Yes

-EE Repository

Use aggressive synchronization [ |MNe
Resynchronize when network or A [n
connection status changes L4

"':J‘ This procedure applies only to running Logon Manager agents. If a user does not have
“ |ogon Manager running, the provisioning instructions are not processed until the user
starts Logon Manager.

Processing the provisioning instructions requires that the user be authenticated to
Provisioning Gateway. If the user is not authenticated to Provisioning Gateway (for
example, the timeout expired) then an authentication Ul is presented and the
synchronization process is blocked until the user authenticates.

Granting Provisioning Rights to Domain Users

If you want an ordinary domain user to have the ability provision Logon Manager credentials via
Provisioning Gateway, do the following:

e Create a user group and add the desired domain user accounts to it.

e Grant the permissions described in Granting the Required Permissions to the
PMSERVICE Account to the group.

e Addthe PMSERVICE account to the group.
e Add the desired domain user accounts to the group.

Configuring Syslog

After Provisioning Gateway installation is complete, you must configure Syslog:

1. Click on the Settings option, then click on the Event Log.
2. From the Database Type drop-down list, select Syslog Daemon.
3. Click Save Changes.

Complete the following Registry changes:
1. Open regedit and navigate to the following location:

HKEY LOCAL MACHINE\SOFTWARE\Passlogix\Extensions\EventManager\Syslog
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2. Enterthe IP address of your Syslog server in the RemoteAddress key.

F=¥ If you are using a non-standard Syslog port, enter the correct port number of your
“4 Syslog server in the RemotePort key.

Creating or Identifying a User Account for Anonymous Logon

You must create or identify a dedicated Anonymous User account through which Provisioning
Gateway users and administrators access Provisioning Gateway Web Services. This Anonymous
User account should be a member of the Administrators group.

¥, Because the default Anonymous User account in IIS, IUSR_MACHINE_NAME, is not a
“d member of the Administrator group, you must create or choose a domain user account
that is an Administrator; this will allow the account to perform the following tasks:

e Change which Web service account to use from the management console
e Read from and write to the directory service (if Active Directory or ADAM/AD-LDS)
e Write to the local-machine registry IHKLM).

To create a new user account or assign Administrator rights to an existing account, use
the Active Directory Users and Computers console (for an Active Directory domain) or
the Computer Management console (for non-Active Directory domains)

The user account you create or choose is specified as the Anonymous User dialog of the Services
tool during this step.

If you are using Windows Server 2008

1.
2.

A bW

N

Launch the Microsoft IIS Manager.

In the left-hand tree, drill down to <Server> > Sites > Default Web Site and select the Pro-
visioning Gateway Console site node.

In the IIS section of the center pane, double-click Authentication.
In the Authentication pane, right-click Anonymous Authentication and select Edit.
In the dialog box that appears, select Specific User and click Set.

In the dialog box that appears, enter the name of the anonymous access user account in the
<DOMAIN>\<user> form, and the appropriate password, then click OK.

Click OK in the Edit Anonymous Access... dialog to dismiss it.
Repeat steps 2-7 for the Provisioning Gateway Service site.
When you have finished, restart Microsoft IIS to apply your changes.

If you are using Windows Server 2003

Launch the Microsoft IIS Manager.

Locate the Provisioning Gateway Console node in the tree, right-click on it, and click Prop-
erties.

Click the Directory Security tab and click the Edit button next to Anonymous Access

Mark the Anonymous Access checkbox and enter the username and password of the anony-
mous user. The anonymous user must have local administrative access.

=¥ By default, the Provisioning Gateway Management Console is not restricted. Any user
=4 with a credential in the backend storage can log in. If you want to restrict access to a
particular group, please see the Additional Security Settings in the Provisioning Gateway
Administrator Guide.
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Granting the IIS Anonymous Account Access to ADAM/AD-LDS

[t
fgj This step only applies to ADAM/AD-LDS users. Use the account chosen in Step 4 above.

1. Launch the ADAM/AD-LDS command line interface.
2. Enter:
dsacls [\\SERVER:PORT\DISTINGUISHED NAME] /g [USER]:ga /i:t"
For example:
dsacls \\localhost:50000\ou=pm,dc=passlogix,dc=com /g PLX\PMWeb:ga /i:t

3. To verify that the account was given access, type:

dsacls \\SERVER:PORT\DISTINGUISHED NAME

The output shows the security information for the directory object. The Anonymous Account
should appear in the list with full access.

Configuring Provisioning Gateway for SSL Connectivity

Before configuring Provisioning Gateway for SSL connectivity, you must obtain an X.509
Certificate from a trusted certificate authority. This trusted CA must be installed in the list of
trusted Root CAs.

The certificate must be valid for the current date and must contain the name of the Web site
(machine name).

The following instructions assume that these certificates are available at known locations.

F-¥ The following articles from the Microsoft Web site can be referred to for information on
=4 installing certificates and setting up SSL:

"How to: Obtain an X.509 Certificate” http://msdn2.microsoft.com/en-
us/library/ms819929.aspx

“How to: Set Up SSL on a Web Server” http://msdn2.microsoft.com/en-
us/library/aa302411.aspx

If you use Microsoft Certificate Services to obtain the X.509 certificate, choose a Server
Authentication Certificate. Also, enable the Mark keys as exportable and Use local
machine store options under the Key Options section.

1. Goto Control Panel > Internet Information Services. Right-click Default Web Site.
Select Properties.
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-T'E Internet Information Services - Inlﬂ
Fl=  Action Yiew Help
=A@ EFRE 22> =

) Internet Information Services Name [ path | Status
=8 EX‘#IW\"L {local computer) w=E0 PM Console Ci\Program Files\Passlogix|v-&0 FM...
e ;ﬂb Skes w-GO PM Service C\Program Files\Passloginly-GO FM. .
T & IO _

| L]

|Opens property sheet For the current selection. | |

2. Click the Directory Security tab and under Secure Communications, click Server Cer-
tificate.

Default Web Site Properties

1P address and domain name restricons

Grank or deny access bo bhis resounce using
1P sddresses of Inbemmet domain names,
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3. The Web Server Certificate Wizard opens. This is where you generate a request for a certificate.

Click Next.

4. Select Assign an existing certificate and click Next.

Server Cerfidwale

115 Certificate Wizard E

Theese 200 the mestheods bt acsigning a cedihcale bo a'Web ahe

Sislect the meshod you vk bo ues for e web sile:

" Creabe 5 new cerificale.

7 Imppil & oaitificabs Bom & Ky Manager backip fs

T Ippodt & ceiticats hom & ph e

= Copy of Move a cestihcabe fom a 1emole $orae site (o ther site

<gock [ Hei> |  conca |

5. Highlight the certificate to assign and click Next.
6. The default SSL port is 44 3. Accept the default and click Next.

LS5L Port
Spmcaly the 551 poset Fror Bhis wedy gile,

115 Certificate Wizard E

551, proet thiz web sbe sheoubd use:

m

<gock [ Mei> |  conca |

7. Review the summary of your request. Click Next.

8. Click Finish.

9. The Directory Security tab will still be open. Under Secure Communications, click Edit.

10. Inthe Secure Communications dialog box, check Require secure channel (SSL) and
Require 128-bit encryption. Click OK to close the dialog.
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11.

12.

Secure Communications

—Iv Require secure channel (5513

v Require 123-bit encrypion

—Client certificates

¢~ Ignore client certificates
" Accept client certificates

{* Require client certficates

client certificates.

[ Enable client certificate mapping

Client certificakes can be mapped ko \Windows user
accounts, This allows access conkral ko resources using

Edit... |

[ Enable certificate trust lisk

Current CTL: I

[dEw .

| Edit. .. |

]

(]4 I Zancel | Help

On the Internet Information Services Tree (see screen following step 1), select Provisioning
Gateway Console. Right-click and select Properties. To enable SSL for the Console, repeat
steps 2 through 10. The next two steps ensure that the Console can communicate with the

Web service.

Select the ASP.NET tab (on the Provisioning Gateway Console Properties dialog box). Verify
that the ASP.NET version is set to 2.0.x. (If it is not set to 2.0, change the setting, then click

Apply). Click Edit Configuration.

¥-G0 PM Console Properties ﬂil
Virtual Directory | Documents | Directoy Security |
HTTP Headess | Custom Enors ASPNET
ASP
net
ASPET vrson: AT A |
Virtual path: [+GO PM Console
File location: IE;\Dmmenls and Setfings\Administiator\Desk!
File creation date: |1J4f20061|::3&35m
File last modiied: [12/21/2005 1:47:54 PM

Edit Configuration. ..

0k | cancel bopy | Hel
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13. Under Application Settings, select localhost.UP and click Edit.

—F RSP NET Configuration Settings : 2 x

General ItmhmEm;w] Aulhorization | Authertication | Appbcation | Stabe Management | Locations |

| Mo | Connection Paismelers
LocaiRpSaver dits sours= | SOLENFRESS intppated Secum =SSRl ArachOfSbnans=Dataly

Agd. | EdL. | Remas | et ]

[Path win2000/Defaull Web Ste/vGO PMConscle | OK | Cocel | 2o | Hee |

14. Inthe Value field, change the prefix of the URL to https. The console will how communicate
over SSL with the Web service.
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Installing Universal Authentication Manager

This section describes the steps necessary for installing Universal Authentication Manager.
It covers the following topics:

e Prerequisites for Installing Universal Authentication Manager

e Upgrading an Existing Universal Authentication Manager Installation

e Installing the Universal Authentication Manager Client-Side Software

¢ Completing the Installation of Universal Authentication Manager
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Prerequisites for Installing Universal Authentication
Manager

Before you install Universal Authentication Manager, ensure the prerequisites listed in this section
have been satisfied.

Prepare the Universal Authentication Manager Repository

Before installing Universal Authentication Manager in enterprise mode, you must prepare your
Microsoft Active Directory repository for use with Universal Authentication Manager as described in
Preparing the Universal Authentication Manager Repository. Microsoft ADAM/AD-LDS is not
supported.

Prerequisites for Universal Authentication Manager Logon Methods

Universal Authentication Manager requires and supports various third-party software, hardware,
and middleware for the logon methods. The general prerequisites are listed below. For a detailed
list of supported products and versions for this release, refer to the Oracle Enterprise Single Sign-
On Suite Plus Release Notes.

Prerequisites for Using Smart Cards

The following third-party software and hardware components are required to use smart cards with
Universal Authentication Manager:

e Supported smart card middleware software (PKCS#11, MiniDriver/Base CSP, .NET)

e Supported smart card readers and drivers

e Supported smart cards

e Each card must have an embedded serial number.

e Ifusing Smart Card PIN mode, each card must have a valid digital certificate and a key pair,
which can be generated either by third-party tools or Universal Authentication Manager. Oracle
recommends using the method that conforms more closely to your organization's security pol-
icies. Cards without a valid certificate and key pair can only be used with a Universal Authen-
tication Manager-generated PIN.

F=-¥ To have Universal Authentication Manager generate a key pair, you must configure it to
“4 do so via Universal Authentication Manager registry settings, as described in the Oracle
Enterprise Single Sign-On Universal Authentication Manager Administrator's Guide.
Universal Authentication Manager does not generate digital certificates and one is not
required in such scenario.

e Your card's middleware must conform to the Microsoft Base CSP standard or be both fully
PKCS#11-compliant and provide a CSP module.

e If using Windows XP and Microsoft Base CSP-compliant middleware, the Microsoft Base CSP
framework must be installed.

e Sagem smart cards are not supported in this release of Universal Authentication Manager.
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After the smart card middleware is installed, you must merge the appropriate registry file with it.
The registry files are available in the Universal Authentication Manager installation folder in the
/SmartCard subfolder. Double-click the registry file to merge it. The following table displays the
registry file for each supported smart card:

_ Family/Type |Middleware Registry File
RSA smart card 5200 PKCS11 RSA Authentication Client smart_providers_
2.0 pkcs1l_ rsa.reg
NetMaker Net iD - CardOS 1 PKCS11 NetMaker Net iD 4.6 smart_providers_
pkcs11l_ netid.reg
ORGA JCOP21 v2.2 PKCS11 SafeSign/RaakSign smart_providers_
Standard 3.0.23 pkcsil_
safesign.reg
Oberthur ID-ONE Cosmo PKCS11 SafeSign/RaakSign smart_providers_
Standard 3.0.23 pkcs11_
safesign.reg
Athena IDProtect PKCS11 SafeSign/RaakSign smart_providers_
Standard 3.0.23 pkcs11_
safesign.reg
Athena ASECard Crypto PKCS11 Athena ASECard Crypto smart_providers_
4.33 pkcs11_
athena.reg
HID Crescendo 700 PKCS11 HID RaakSign Standard 2.3 | smart_providers_
pkcs11_
raaksign.reg
Gemalto Cyberflex 64K (v2c) PKCS11 Gemalto Access Client 5.5 smart_providers_
SPE Required / SPE Optional Xiring CCID Driver version pl;(;?allltlc)_re
1.00.0002 or later / XISIGN | 9 reg
reader
Gemalto PC-PinPad version
4.0.7.5 or later / PC PinPad
reader
IBM JCOP21id PKCS11 SafeSign Identity Client smart_providers_
2.2.0 pkcs11_
safesign.reg
DigiSign JCOP with MyEID PKCS11 Fujitsu mPollux DigiSign smart_providers_
Applet Client 1.3.2-34 (1671) pkcs11_
fujitsu.reg
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_ Family/Type |Middleware Registry File
Oberthur ID-One Cosmo 64 PKCS11 ActivIdentity ActivClient 6.1 | smart_providers_
v5.2D Fast ATR with PIV pkcs11_
application SDK actividentity.reg
Cyberflex 64K PKCS11 Gemalto Access Client 5.5 smart_providers_
pkcs1l_
gemalto.reg
HID Crescendo 200 MS Base HID Global MiniDriver for smart_providers_
CSP/MiniDriver | MS Base smart card CSP basecsp.reg
Gemalto .NET v2+ MS Base Gemalto MiniDriver for smart_providers_
CSP/MiniDriver | Microsoft Windows XP basecsp.reg
Oberthur ID-ONE Cosmo MS Base Oberthur ID-ONE MiniDriver | smart_providers_
CSP/MiniDriver | for MS Base smart card CSP | basecsp.reg
Athena ASECard Crypto ILM MS Base Athena ASECard Crypto ILM | smart_providers_
CSP/MiniDriver | MiniDriver for MS Base basecsp.reg
smart card

Prerequisites for Using Proximity Cards

The following third-party hardware components are required to use Proximity Cards with Universal
Authentication Manager.

e Supported Proximity Card readers and drivers
e Supported Proximity or Contactless Cards and tokens

Prerequisites for Using Fingerprint Readers

The following third-party hardware components are required to use a fingerprint reader with
Universal Authentication Manager.

e Supported fingerprint readers and drivers
e Forthe Fingerprint logon method, BIO-key BSP version 1.10 must be installed.
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Prerequisites for Unattended (“Silent”) Installations

In order to successfully install Universal Authentication Manager in unattended ("silent") mode,
the Windows Management Instrumentation (WMI) service must be running before the installer is
executed.

To check whether the WMI service is running, and start it if necessary, do the following on each
target machine:

1. Open the System Management Console.
2. Open the Services snap-in.

3. Navigate to the Windows Management Instrumentation service and check its status and
startup mode.

4. Depending on the status, do one of the following:

e Ifthe statusis Started, the WMI service is running; proceed to the next
section.

e Ifthe statusis blank, check the service's startup type and start it as follows:
o Ifthe startup type is Disabled, do the following:
1. Double-click the service.

2. Inthedialog box that appears, change the startup type to Manual or Automatic,
as required by your environment.

Click Apply.

4. Click Start to start the service. The status changes to Started.

o Ifthe startup type is not Disabled, do the following:
1. Double-click the service.
2. Inthedialog box that appears, Click Start to start the service.
3. The status changes to Started.
4. Click OK.

5. Click OK to close the service properties dialog box.

Configuring Universal Authentication Manager for
Synchronization with a Repository

"',2; Before completing the procedures in this section, note that:

-

= e Oracle recommends that you install Universal Authentication Manager in local mode and switch
it to enterprise (synchronization) mode (as described in the Oracle Enterprise Single Sign-On
Universal Authentication Manager Administrator's Guide) only after you have prepared the
repository and configured synchronization settings. Otherwise, Universal Authentication
Manager data structures may not be correctly created or permissions correctly set within the
repository.

e When deploying Universal Authentication Manager in enterprise mode, users must not enroll in

any logon methods until synchronization with the repository has been properly configured and
tested. Otherwise, enrollment data will be lost.

e Only Microsoft Active Directory is supported as a repository.
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In order to allow Universal Authentication Manager to centrally store and manage policies and
enrollment data, you must prepare an Active Directory-based repository and configure Universal
Authentication Manager for synchronization with that repository by performing the following
tasks:

e Create a Universal Authentication Manager Service Account

e Extendthe Schema

e Enable Data Storage Under User Objects

e Initialize Universal Authentication Manager Storage

e Configure the Universal Authentication Manager Synchronizer

When assigning user groups, keep the following in mind:

e User groups used should be in the same domain,
e Use security groups, not distribution groups,
e Universal Authentication Manager will only support a single Active Directory domain.

Preparing the Repository when Logon Manager is Already Deployed

If Logon Manager is already installed and synchronizing with your Active Directory-based
repository, Universal Authentication Manager will be sharing Logon Manager's repository container
to store its own policies and settings. In such cases, you do not need to extend the schema or
enable data storage under user objects. Instead, complete the following steps:

e Complete the steps in Initializing Universal Authentication Manager Storage.

e Complete the steps in Configuring the Universal Authentication Manager Synchronizer.
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Creating a Universal Authentication Manager Service Account

In order for Universal Authentication Manager to read and write data in the repository, you must
give it the privileges to do so. This is accomplished by creating a service account that Universal
Authentication Manager uses to interact with its repository. This account should be a standard
domain account (member of Domain Users); no other permissions are necessary.

1. On the workstation that will serve as your domain controller, launch Active Directory Users
and Computers.

2. Right-click in the Users container and select New > User. The User account is a regular
member of the Domain Users group.

£ Active Directory Users and Computers =10 ]

| =18l]

= Fie  pction  View Window  Heb

-« OmE 8 FER Pn| gk van

S et o e [

¥ ] Saved Queries

= ¥ damanol.bocad %_ums — Tipe Bm@ﬁm - I
-2 Buikin Amiristrator Lser Bult-n acoount For admwni,,,
B1-[C Compubers Cerk Publishers Securky Group .. Merbers of this group are. .
Bl (3] Domain Contrallers Drafdming Securicy Group ... DNS Administrators Group
1 (L FoesipnSacuityPrincipals Drslpdstefroy  Security Group ... DS clents who are permi...

L Usars Diomain Adrmirs Securky Group ... Designated administrators. ..
Diomain Computers  Securiy Group ... &1 warkststions and serve, .
DiBima = Caabsallane  Casiskes e

Nome Defegate Contral,.,

P ... &l demain cortralers in th...
Ep.. &1 demain quests

Doms p ... Aldemainusers
mErter Computer rakiars. ..
lGreu Contact p can..
G Group quast ...
€0iHelpe InetOrgPessan 2nd Su
hrns S0 Queue Aliss can.
CRebE  yew v Prinker
Hactar———————————— ators
2o e —
fhspp  Un2up lcons 1 15 @ VOrAoT s A0count .,
€Tene  Froperties ip ... Members of tis grou ha. .

ﬂ userl Help

I — I

Create & new ohiact. . [

3. Enter aname for the user or group account (for this example, the name is uamservice) and
click Next>.
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Hew Object - User |
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Extending the Schema

F-¥ If you are not sure whether you have already extended the schema, simply complete
“4 the steps below; performing the schema extension multiple times will not harm your
repository or the data it contains.

1. Launch the Oracle Enterprise Single Sign-On Administrative Console.
2. From the Repository menu, select Extend Schema.

2 Oracle Enterprise Single Sign-on Logon Manager Administrative Console

File Edit Insert | Repository | Tools  Help
O=E #Hl Extend Schema
sl Applications Initialize UAM Skorage

Kiozk b anad

Provizioning Use Short Names Type
+ Uriversal &u Show User Credential Containers Window s
F= Clarmd fmm e —— [ s

3. Inthe Connect to Repository dialog box, enter a Server Name (for this example, the name
is DC01), select Microsoft Active Directory Server from the drop-down menu, select the
Use secure channel (SSL) check box if your environment is configured for
SSL connectivity, enter the Port number (this example uses port 389), and the
Username/ID and Password of an administrative account with Domain and Schema
Administrator permissions. Click OK when finished.

Connecl to Rapository E]

Server Mame: oco |
Repositep Type: Microscét Active Diractory Server |
Port: 388

[] Use secuee channel [S51)

Uzamams/ID: Adrarsiratar

Passward

Cancel |[ Halp ]

Enabling Data Storage Under User Objects

After extending the schema, you must allow Universal Authentication Manager to store
enrollment data under each respective user's user object within the repository. To do so, complete
the following steps:

"':g{ If Logon Manager is already installed and synchronizing with your repository, you do not
b need to enable this option, as it is already enabled; proceed to the next section.

1. Inthe left-hand tree, right-click the Repository node and select Connect To... from the con-
text menu.

2. Inthe Connect to Repository dialog box, enter a Server Name (for this example, the name
is DC0O1), select Microsoft Active Directory Server from the drop-down menu, select the
Use secure channel (SSL) check box if your environment is configured for
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SSL connectivity, enter the Port number (this example uses port 389), and the
Username/ID and Password of an administrative account with Domain and Schema
Administrator permissions. Click OK when finished.

3.

Connecl to Rapository

Server Mame: oco w
Aepositon Typs: Microscét Actve Diractory Seaver w0
Peet: e '
[] Use secuee channel [S5L)
Uzamamad0: Sdrnrislrstan
e waaaians .
[ ok || Cancel || Heb |

X]

4. From the Repository menu, select Enable Storing Credentials Under User Object.
5. Inthe prompt that appears, click OK.
6. Inthe confirmation dialog that appears, click OK to dismiss it.

Initializing Universal Authentication Manager Storage

1. After successfully extending the schema, return to the Repository menu and select Initialize

UAM Storage.

2 Oracle Enterprise Single Sign-on Logon Manager Administrative Console

File Edit Insert | Repository | Tools  Help

D +l

Applications
Kinzk b anag

Provisioning

4
;

[ gl PPN R

Extend Schema

Iritialize UAM Storage

IJse Short Mames

Show User Credential Containers

hager

2. From the drop-down menu, select the server that you just created. The other fields are filled in

automatically.

3. Click OK.

Connecl to Rapository E
Sesver Mame: oco w
Aepositon Typs: Microscét Actve Diractory Seaver w0
Po: 339 '

[] Use secuee channel [S51)
UgamamadID; Ldranliaka
e e
Ok || Cancel |[ Heb |
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4. 1Inthe Select User or Group window, start typing the name of your service account, then click
Check Names. The service account name is filled in automatically.

Select User or Group @El

Select this objact lyps:

Ulses | [ Objact Types.

From thiz loc atiar

Emnbinz Direclory . Lo atiars... il

Eriled the shijscl names to selecl [2xamples]
i i1, ol Chack Mamez

s o )]

5. Click OK and wait for the success message.

UAM Storage Inthialization Status

Checking dreclory cchema ertiies for DAk updates... A
Checking object clas "waollzeiDala" .

Object class has bean updated.

Chacking object clazz "wgaConfig™..

DObject class has bean wpdated.

Schema refiesh complebe,

Adding ‘cn=Paszzlgy’ container.,

Adding ‘crn=LIAM' contanes...

Adding ‘cn=Palcies’ container,,

Adding ‘en=Dioman Usess’ contanes,

Audding ‘ern=D1ala’ eantaine, .

Audding ‘er=llzers’ container...

Audding "cr=Appl D PLAFRAMEWDRE' cortaner. .

L&KM Storzge Inilidization SUCCESSFUL!

Clase

The data structures have now been created and the required permissions set. For more
information on what's done in the repository during this step, see the next section.

F-¥ Once the Universal Authentication Manager service account has been created, it can also be
“4 configured manually or automatically on multiple end-user machines using the command-
line tool DeployTool.exe. For more information, see the Oracle Enterprise Single Sign-On
Universal Authentication Manager Administrator's Guide.

About The Universal Authentication Manager Repository Data Structures
and Permissions

When you invoke the Initialize UAM Storage command described earlier, Universal
Authentication Manager does the following within your repository:

1. Modifies the schema to ensure that vgoUser and vgoConfig classes may be placed inside Con-
tainer objects.

2. Builds the default container structure "Program Data/Passlogix/UAM" with subcontainers "Pol-
icies" and "Index" as shown below:
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= 9 uarmwin200332. uamora.com
+-[] CH=Configuration. DC=uamaora,DC=com
+-[] CM=5chema,CH=Configuration,DC=uamora,D C=com
+-[] DC=DomainDnsZones,DC=uamaora,D C=com
+-[] DC=ForestDnsZones,DC=uamora,DC=com
=[] DC=uamora,DC=com
1]
1]
=R
+
+ I:l I:N [ndex
+-] CH=Policies

[
f}é Never manually modify the contents of the index and policies containers.

The containers can be named differently if your environment requires so; however, you will
need to manually configure all Universal Authentication Manager client instances to point to
the custom-named containers. Oracle highly recommends you leave the container names at
their defaults.

3. Grants the Universal Authentication Manager service account generic read, write, modify, and
delete permissions to the index container (as well as all other permissions inherited from its
parent) so that the Universal Authentication Manager service can read, create, modify, and
delete objects in the index container.

4. Grantsthe Universal Authentication Manager service account generic read permissions (as
well as any permissions inherited from its parent) so that the Universal Authentication Man-
ager service can read objects within the policies container.

5. Updates the domain root DSE object to grant the Universal Authentication Manager service
account permissions to create and delete vgoConfig and vGoUser objects under User objects
across the entire domain. (If the user objects have been relocated to a custom location, the
permissions can be set directly at the target container instead of at the root.)

6. Updates the domain root DSE object to grant the Universal Authentication Manager service
account generic read permissions to all vgoConfig objects across the domain so that the Uni-
versal Authentication Manager service can read all vgoConfig objects regardless of their loca-
tion in the repository.

Configuring the Universal Authentication Manager Synchronizer

You are now ready to configure the Universal Authentication Manager to allow Universal
Authentication Manager to synchronize with the repository. Complete the following steps:
1. Launch the Oracle Enterprise Single Sign-On Administrative Console.

2. Intheleft-hand tree navigate to Global Agent Settings
> [TargetSettingsSet>] > Synchronization.

3. IfLogon Manager is not installed and synchronizing with the repository, add a configuration
node for the Active Directory synchronizer to your settings set as follows (otherwise skip to the
next step):
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a. Right-click the Synchronization node and select Manage synchronizers from the context
menu.

b. Inthe window that appears, click Add.

c. Inthelist of available synchronizers, select Active Directory, enter ADEXT as the name,
and click OK.

d. Click OK to dismiss the dialog. The ADEXT node appears under the Synchronization
node.

4. Doone of the following:

e If Logon Manager is installed and synchronizing with the repository, do not modify the
value of the Base location(s) for configuration objects field; instead, skip to the next
step.

e If Logon Manager is not installed and synchronizing with the repository, do the following in
the Base location(s) for configuration objects field:
i. Select the check box.
ii. Click the ... button.

iii. Inthe window that appears, enter the fully qualified DN of the Universal Authentication
Managerpolicies container.

iv. Click OK.

5. Inthe Base location(s) for UAM storage index field, select the check box, click the ... but-
ton, and enter the fully qualified DN of the Universal Authentication Manager index container,
then click OK.

6. Ifitis not already set, select the check box next to the Location to store user credentials
option and select Under respective directory user objects from the drop-down list.

7. Configure other synchronization settings as desired; for more information on each setting, see
the Console help.

8. Export your settings to a .REG file for distribution to end-user workstations:
a. From the File menu, select Export.
b. Inthedialogthat appears, click HKLM Registry Format.

c. Inthe"Save" dialog that appears, navigate to the desired location and pro-
vide a name for the .REG file, then click Save.

9. Distribute the .REG file to your Universal Authentication Manager workstations and merge it
into their Windows registries.

Configuring Universal Authentication Manager Synchronization for
Administrative Users

The rights necessary to store credentials under user objects are granted at the tree root and
inherited down to user objects. If you are deploying Universal Authentication Manager in
enterprise mode in an environment where members of protected user groups, such as
Administrators, will be using it, you must grant the Universal Authentication Manager service
account through the AdminSDHolder object the permissions necesary to create and delete
vGOUserData and vGOSecret objects.
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F=¥ If Logon Manager is already installed and synchronizing with the same repository that
~4 Universal Authentication Manager is utilizing, you will also need to grant these
permissions to the AdminSDHolder object itself, which was most likely done during
Logon Manager deployment. This granting will appear as "SELF" in the affected
administrative user's permissions list, as well as in the AdminSDHolder object's
permissions list.

Without this explicit permission application, administrative users will be blocked from storing their
Universal Authentication Manager data in the repository due to automatic inheritance of
restrictive rights from the AdminSDHolder object. This is because the object’s ACL, which governs
the ACLs of all protected groups, prohibits rights inheritance by default. More information about
this issue is available in the following MS Knowledge Base article:
http://support.microsoft.com/kb/817433.

The following protected user groups are known to be affected by this problem:

e Enterprise Admins
e Schema Admins
e Domain Admins
e Administrators

e Account Operators
e Server Operators
e Print Operators

e Backup Operators
e Cert Publishers

To verify that you are experiencing this particular issue, do the following:

1. Login tothe primary domain controller as a domain administrator.

Open the "Active Directory Users and Computers" MMC snap-in.

From the View menu, select Advanced Features.

Navigate to the affected user object, right-click it, and select Properties.
In the dialog that appears, select the Security tab.

ua A W N
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6. Click Advanced. The “"Advanced Security Settings” dialog appears:

Advanced Security Settings for Administrator 7] x|

Permissions | Auditing I I:Iwnerl Effective F'ermissiu:-nsl

To view more information about special permissions, select a permizsion entry, and then click Edit.

Permizzion entries:

Type | M arne | Perrmizzian | |nherited Fram |i|
Al Cert Publizhers (S50...  Readfwiite Property <hiot inkerited:
Allow Evenone Change Pazsword <hot inkernted:
Al Prewindaws 2000 ... Special <niot inhernted:
|l CELE Changelassuand ki e ——
Allon JaMSermvice Create/Delete wG0UzerD ata Objects <ot inkherited: |
Allow 1Ak Service Create/Delete wGOConfig Objects <hiot inkerited: —
T T T e LI P e T Ty P TrreTie v
4| | >
Add... Edit... Bemowve

Allov inheritable permiszions from the parent bo propagate to this object and all child objects. Include
thesze with entriez explicitlhy defined here.

Toreplace all permizzion entriez with the default zettings, click Default. Diefault |

Learn more about access contral,

] I Cancel | Apply |

7. Inthedialog, check whether:
e The Allow inheritable permissions... check box is not selected.
e The permissions highlighted in the figure in step 6 are not present in the list.

If the above conditions are true, the user object is not inheriting the necessary permissions
from the directory root.

To rectify this issue, you must manually modify the ACL of the AdminSDHolder object to grant the

right to create objects of type vGOConfig and vGOUserData. The steps are as follows:

1. Login tothe primary domain controller as a domain administrator.

2. In the Microsoft Management Console, open the "Active Directory Users and Computers"
shap-in.

3. From the View menu, select Advanced Features.

4. Navigate to the AdminSDHolder container located in
cn=AdminSDHolder,cn=System,dc=<domainName>,dc=<domainSuffix>

5. Right-click the AdminSDHolder container and select Properties.
In the “Properties” dialog, select the Security tab and click Advanced.
7. Inthe™“Advanced Security Settings” dialog, click Add... .
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8. In the"“Select User, Computer, or Group” dialog, enter the name of the Universal Authen-
tication Managerservice account and click OK.

9. Inthe“Permission Entry” dialog, do the following:

a. From the Apply onto: drop-down list, select This object and all child objects.

¥ If the create and delete permissions for vGOUserData objects do not appear in the
=4 permissions list, select User objects from the Apply onto: drop-down list instead.
This variation occurs between different versions and patches of Active Directory and the
underlying operating system.

b. Inthelist of permissions, select the Allow check box for the permissions shown below:

Permission Entry for AdminSDHolder el

Object | Froperties I

I amne: ISELF Change... |

Apply ontar: IThis object and all child objects j
Permizzionz: Al Deny
B LU i L1 = Lt g LR ;I

All Extended Rightz
Create All Child Objects

./Dﬁﬂzﬂmhwct
Create vGOCaonfig Objects

Delete vGOCaonfig Objects
Create vGOUzerD ata Objects
\Eelete wGOUserD ata Objects
allowed to Authenhicate

Change Pazsword
Receive As

Reset Pazsword
Send Az -

r Apply theze permizsions o objects and/or Clear Al |

cohtainers within this container anly

0k I Cancel |

OO0O0O0O0KREEEOO0OO0C
OO0O0O0O00O00003J00C

c. Click OK.

10. Trigger the SD propagator (SDPROP) process to immediately propagate the changes
throughout the network. Instructions for launching the SD propagator process are provided in
the following Microsoft Knowledge Base article: http://support.microsoft.com/kb/251343.

F* If you encounter a version of this procedure that calls to apply the above permissions
-4 onto “This object only,” disregard it. It is deprecated and has been superseded by the
steps above.

If you are running Windows Server 2008 R2, you can trigger the SD propagator process
by kicking off the RunProtectAdminGroupsTask task.
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Upgrading an Existing Universal Authentication
Manager Installation

Upgrading from earlier versions of Universal Authentication Manager is not supported. You must
fully uninstall any old versions of Universal Authentication Manager before installing the current
version. The new version will ignore all repository data stored by any earlier versions, thus deletion
of the old data is not required.

Migrating from Logon Manager with Strong Authenticators to
Universal Authentication Manager

Each client workstation with Logon Manager may only be configured to use one primary logon
method. Logon Manager supports several native primary logon methods, including strong
authenticators such as smart cards or proximity cards. If a strong authenticator is deployed and
configured as the Logon Manager primary logon method, each end user must convert to using
Universal Authentication Manager as the primary logon method.

End users must manually change the Logon Manager Primary Logon Method from the strong
authenticator to the Universal Authentication Manager Authenticator using the Logon Manager
Agent Settings tab to Change Primary Logon Method.
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Installing the Universal Authentication Manager Client-
Side Software

=¥ Oracle recommends that you install any hardware devices, middleware, and drivers
=4 prior to installing Universal Authentication Manager.

Installing Universal Authentication Manager requires you to have local administrator
permissions.

Oracle recommends against installing Universal Authentication Manager on the same
workstation as the Oracle Enterprise Single Sign-On Administrative Console to avoid
lockout. You should have at least one workstation running the Oracle Enterprise Single
Sign-On Administrative Console without Universal Authentication Manager.

If you want to perform an unattended ("silent") installation, see Performing an
Unattended (Silent) Installation of Universal Authentication Manager.

During the installation, you will be prompted to select a client mode (local or enterprise).
For more information on the Universal Authentication Manager client modes, see the
Universal Authentication Manager Administrator's Guide.)

If you are installing Universal Authentication Manager on

Windows 7, the Microsoft Windows Password and PKI smart card credential providers
will be disabled and the Universal Authentication Manager credential provider will be
enabled in their place.

To install and configure Universal Authentication Manager:

1. Close all programs.
2. Launch the ESSO-UAM.msi installer file.

#* If you areinstalling in a language other than English and would like to launch the
-2 installer in the desired language, execute the following command:

msiexec /I <packagename>.msi TRANSFORMS=<language>.mst
where <packagename> is the name of the Universal Authentication Manager installer

MSI package, and <language>.mst is the name of the corresponding language
transform file (included in the installer archive).

3. On the Welcome Panel, click Next>.

i Oracle Enterprise Single Sign-on Universal Authentication Manager - |... gl

wWelcome to the InstallShield Wizard for
Oracle Enterprise Single Sign—on Universal
Authentication Manager

The InstalShield(R) Wizard will install Oracle Enterprise Single
Sign-on Universal Authentication Manager on your computer,
To continue, click Mext,

WARMING: This program is prokected by copyright law and
international treaties,

Mexk = l [ Zancel
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4. The Program Features dialog box prompts you to select the features to install. Select the fea-
tures you want by clicking the red [x] next to the feature and clicking This feature will be

installed on local hard drive. You must select at least one Logon Method to proceed with
the installation.

i Oracle Enterprise Single Sign-on Universal Authentication Manager - |... @

Select the

Click. on an icon in the lisk below to change how a feature is installed.

Feature Description

55%| Logon Methods all necessary files and settings

) that serve as the core
<=3 - | Challenge Questions foundation of the application
- ¥~ | Smart Card

- ¥ | Proximity Card

- ¥~ | Fingerprint This Feature requires 4584KE on
i ¥+ | ES5C-UAM Authenticator for ESS0M your hard drive,
==~ | Languages

- =3 - | Engiish

e [ I T SR S

Install ba:

C:\Program Files\Passlogixiv-G0 LAM),

[ Help ] [ Space ] [ < Back " Mext = ] [ Cancel ]

Application

(requires ~4580KB of space) application
This option installs all necessary files and settings Lagan Methads
that serve as the core foundation of the
application.

Logon Methods

(requires ~215KB of space, ~1253KB including — ------- =i v| Logon Methods
Subfeatures) e = = | Challenge Questions
The logon methods are plug-ins supported by i H % - | Smart Card
Universal Authentication Manager. Select the 7% v | Proximity Card
logon methods that you intend to use. P % ~| Fingerprint

The available plug-ins are:

e Challenge Questions
e Smart Card

e Proximity Card

e Fingerprint

=¥ Toavoid performance issues and

“4d potential conflicts, the
recommended best practice is to
install only the logon methods you
intend to use.
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Universal Authentication Manager Authenticator for Logon Manager

(requires ~105KB of space) = v| ESS0-UAM Authenticator For ESS0-LM
The Universal Authentication Manager Authenticator
plug-in integrates Universal Authentication Manager
with Logon Manager. If Logon Manager is installed after
Universal Authentication Manager, you can Modify the
Universal Authentication Manager installation to install
the Universal Authentication Manager Authenticator.

-:_;,: The Universal Authentication Manager
A Authenticator option is only available if
you already have the Logon Manager

Agent installed on the workstation.

The localized language support packages that - gvl Languages
allow the Agent to be displayed in the following | i = ~ | English
EOgUEREE | W ¥ - | Chinese (Simplified)
e English (mandatory, installed by default) [ e ¥ - | Chinese (Traditional)
e Chinese (Simplified) [ e ¥ - | Czech
e Chinese (Traditional) | *_~ | Danish
e Czech ¥ _~ | Dutch
e Danish | X _~ | Finnish
e Dutch 0 ¢ ~ | French
e Finpish i X | German
......... W Greek
e French )
e German 0 ¥ - | Hungarian
""""" ¥ - | Italian
* Greek I I S ¥ ~| Japanese
e Hungarign i % | Korean
e Italign X _~ | Morwegian
e Japanese | % = | Polish
e Koreen | il - | Portuguese (Brazil)
e Norwegian ¥ - | Portuguese (Portugal)
e Polish e ¥ _~ | Romanian
e Portugese (Brazil) | e X | Russian
e Portugese (Portugal) | e ¥ | Slovak
e Romanian | pwe * - | Spanish
e Russian e X _~ | Swedish
e Slovak b e ¥ - Thai
e Spanish e % = | Turkish
e Swedish
e Thai
e Turkish

Click this button to change the current installation destination folder for the Client.

Browse to the location and click OK.
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Click the Help button to display Custom Setup tips. | @,

Click Space to display the Disk Space Requirements for the installation of the |

selected features on local workstations. Click OK.

6. Select the desired client mode. (For more information on the client modes, see the Universal
Authentication Manager Administrator's Guide.)

e Local Client Mode. Universal Authentication Manager runs locally and does not syn-
chronize with the repository.

o Enterprise Client Mode. Universal Authentication Manager runs in an Enterprise
environment and synchronizes with the repository.

i& Oracle Enterprise 5ingle Sign-on Universal Authentication Manager - I... E

Client Mode

Choose ESSO-UAM client mode

(%) Local Client Mode

ESSO-UAM stores and manages credentials and palicy settings
locally on this computer,

) Enterprise Client Mode

ESSO-UAM can connect bo an enterprise repository ba store and
rekrieve credentials and policy settings,

[ < Back H ek = ] [ Cancel ]

7. Iftheinstaller detects a third-party GINA, it prompts you to choose between keeping the
current GINA and registering the Universal Authentication Manager GINA. Oracle recommends
that, if you choose to chain the GINAs, you verify in a test environment that the configuration
is stable. See Selecting the Desired GINA Library for more information.
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ii# Oracle Enterprise Single Sign-on Universal Authentication Manager - [... E|

Third Party GINA Detected

Select an opkion,

The installer detects that a third party product has modified the Windows native GINA, ESSO-UAM
supparts chaining with third party GIMNAs but it is recormmended ta manually configure and kest GINA
chaining, Refer to the ESS0-UAM product documentation For information on how to manually
configure E3SO0-IUAM to chain with other products that modify the Windows native GINA,

WARMING: IF vou select option to Register E33O0-UAM GINA, the computer may encounter errors
that presvent ability to log on.

@ Keep Current GINA
@ Do not modify current GIMNG configuration,

() Register ESSO-UAM GINA

@ Register ES50-UAM GIMA and attempt ko chain to current GING,

[ < Back ” Mexk = ] [ Cancel ]

8. Ifyou selected to install the Universal Authentication Manager Authenticator for Logon
Manager in step 4, the installer proceeds with the next step, depending on whether or not
Logon Manager is detected with any strong authenticators installed. The Universal
Authentication Manager Authenticator for Logon Manager allows for integration with Logon
Manager.

Logon Manager installed with Strong Authenticators

When the installer detects that Logon Manager is installed along with at least one strong
authenticator and the Universal Authentication Manager Authenticator custom setup option
has been enabled for installation, the installer will not ask if you want to configure Universal
Authentication Manager as the Logon Manager primary logon method.

Logon Manager installed without Strong Authenticators

When the installer detects that Logon Manager is installed without any strong authenticators
and the Universal Authentication Manager Authenticator custom setup option has been
enabled for installation, the installer will ask if you want to configure Universal Authentication
Manager as the Logon Manager primary logon method. If you select to configure Universal
Authentication Manager as the Logon Manager primary logon method, Universal
Authentication Manager will be the only available option in the Primary Logon dropdown of
Logon Manager First-Time Use (FTU) Wizard. For more information on the FTU Wizard, see the
Oracle Enterprise Single Sign-On Suite Plus User Guide.

Make your selection and click Next.
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i Oracle Enterprise Single Sign-on Universal Authentication Manager - I... E]

ESS0-LM Detected

ES30-LMis installed on this workskation, Select an option and click Mext ko
proceed,

") Configure ESS0O-UAM as Primary Logon Method

Configure ESS0-LM ko only allow ESSO-UAM as the primary logon
method

(*! Do not configure ESSO-LM Primary Logon Method

@ Do nok modify ESS0-LM

[ < Back ” Mexk = l [ Cancel

9. The InstallShield Wizard is ready to begin the installation. Click Install.

& Oracle Enterprise Single Sign-on Universal Authentication Manager - I... g|

Ready to Install the Program

The wizard is ready o begin installation,

Click. Install to beqgin the installation,

If wou wank ko review or change any of wour inskallation settings, dick Back, Click Cancel ta
exik the wizard,

l < Back. ” Install l [ Cancel ]

10. Wait for the installation to complete. When the Completed screen appears, click Finish.
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i& Oracle Enterprise Single Sign-on Universal Authentication Manager, - I... |X|

InstallShield Wizard Completed

- The InskallShield wWizard has successfully installed Qracle
Enterprise Single Sign-on Universal Authentication Manager.
Click. Finish ko exit the wizard,

< Back. Cancel

11. After installation is complete, you may be prompted to restart the machine.
e Ifyou installed the Client in Local Mode, click Yes now.

e Ifyou installed the Client in Enterprise Mode, click No and proceed to Completing the Instal-
lation of Universal Authentication Manager to configure the required service accounts.
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Performing an Unattended (Silent) Installation

In order to install Oracle Enterprise Single Sign-On products successfully in unattended ("silent")
mode, the Windows Management Instrumentation (WMI) service must be running before you
execute the installer. To check whether it is running and start if it is not, see Prerequisites for
Unattended ("Silent") Installations.

Command Line Syntax

Universal Authentication Manager supports standard MSIEXEC.exe command line parameters.
The command line to perform an unattended installation uses the following sequence:

MSIEXEC.exe [Install Flag] [MSI Installer Filename] [Custom Properties]
[User Interface Level Flag]

Where:

Install Flag. /i = install, /x = uninstall, /a = admin install

Filename. Name of the MSI package to install

Custom Universal Authentication Manager Installer Properties
The custom installer includes the ability to configure the following options:

e Option to select local (default) or enterprise mode

e Option to configure Logon Manager to use Universal Authentication Manager as its Primary
Logon Method

o Ability to select which GINA to use
e Ability to configure custom features to install
e Ability to install in the desired language
Use the following custom parameters to configure these installer options:
¢ CLIENTMODE
o 0 = Local Client Mode (default)
o 1 = Enterprise Client Mode
¢ SSO_LOGONMETHOD

o Yes = Configure Universal Authentication Manager as the Logon Manager Primary Logon
Method

o No = Do not configure Universal Authentication Manager as the only available Logon Man-
ager Primary Logon Method (default)

¢ GINACHOICE (Windows XP only)

o 0 = Keep the current GINA (default)

o 1 = Register Universal Authentication Manager GINA
e ADDLOCAL

o "Application" (Required)

o "SmartCard"

o "ProximityCard"

o "Fingerprint"

o "ChallengeQuestions"

— Page 139 of 174 —



Installing the Universal Authentication Manager Client-Side Software

o "UAMAuth"

To configure which features are installed, use the standard "ADDLOCAL" command line
option.

[
f}é Do NOT use the ADDLOCAL property with ORCA, which is command-line only.

Installable Language Packs (English is always installed)

English

Brazilian Portuguese
French

German

Italian

Japanese

Korean

Simplified Chinese
Spanish

Czech

Finnish

Dutch

Polish

Portuguese
Tranditional Chinese
Danish

Greek

Hungarian
Norwegian
Romanian
Russian

Slovak

Swedish

Turkish

Thai

Examples

msiexec /i "ESSO-UAM.msi” ADDLOCAL
="Application, SmartCard, ProximityCard, German, Norwegian, Turkish”
CLIENTMODE=1 GINACHOICE=1

Installs Universal Authentication Manager with Smart Card and Proximity Card, in enterprise

mode, using the Universal Authentication Manager GINA, with the German, Norwegian, and
Turkish language packs.
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e msiexec /gn /i "ESSO-UAM.msi” ADDLOCAL ="Application,SmartCard”
CLIENTMODE=0 GINACHOICE=0

Installs Universal Authentication Manager with Smart Card only, in Local Client mode, and
using the default GINA.

e msiexec /gn /i "ESSO-UAM.msi” ADDLOCAL ="Application,Fingerprint”
CLIENTMODE=0
Installs Universal Authentication Manager with Fingerprint only, in Local Client mode.

e msiexec /i "ESSO-UAM.msi"
ADDLOCAL="Application,ChallengeQuestions, ProximityCard, SmartCard, Fingerprint"
CLIENTMODE=1 GINACHOICE=0

Installs Universal Authentication Manager with Challenge Questions, Proximity Card, Smart
Card, and Fingerprint, in Enterprise Client mode, using the default GINA.
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Completing the Installation of Universal Authentication Manager
You must complete the tasks listed below in order to successfully configure Universal
Authentication Manager.

e Configuring the Universal Authentication Manager Service Account

e First-Time Logon for Enterprise Mode Users

e Selecting the Desired GINA Library

Configuring the Universal Authentication Manager Service Account

When running the Client in Enterprise mode, you must follow the instructions in this section to
configure each Universal Authentication Manager client so that they will be able to synchronize
with an Enterprise repository.

F=-¥ Some steps in this section need to only be performed once. Other steps must be
~4 performed every time Universal Authentication Manager is installed or upgraded.

Step 1: Grant the Service Account Local Administrator Privileges

The Universal Authentication Manager service account must be a Local Administrator on each
client system. This step only needs to be done once per client, and should be done immediately
after the client has been installed. These steps can be done before or after rebooting the system.
You can add the Universal Authentication Manager Service Account to the local Administrators
group on each workstation. Complete the following steps:

1. Click Start > Run > and type compmgmt.msc and click OK. The Computer Management
console opens.

2. Expand Systems Tools and then expand Local Users and Groups and click Groups.

3. Intheright pane, right-click on Administrators and select Add to Group....

4. Click Add. Enter the username of the Universal Authentication Manager service account that
you created, and click OK.

Step 2: Configure the Service

You must configure the Universal Authentication Manager authentication service to run under the
Universal Authentication Manager service account, and to automatically grant the account the Log
On As Service local privilege. This step must be performed after every Universal Authentication
Manager installation.

Complete the following steps:

1. Click Start > Run > and type services.msc and click OK. The Services console opens.

2. Double-click the ESSO-UAM Authentication Service. The Properties dialog will open.

3. On thelLogOn tab, select This account. Enter the name of the Universal Authentication Man-
ager service account into the This account field, then enter and confirm the password.

4. Click Apply. The first time this step is done, you will receive a message that the Log On As
Service right has been granted.

Step 3: Restart the Service

Restart the service to verify the new settings are working and the ESSO-UAM Authentication
Service can start. If the service cannot start, you can try to revert to the Local System, restart
the service, review and correct the settings, and try again.
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To restart the service, right-click the service and click Restart.

¥ Do not leave the service in a stopped state. If the service is left in a stopped state, users
® may not be able to log on.

Reverting Your Changes After Uninstalling Universal Authentication
Manager

To undo these steps and return to a clean system:

1. Uninstall Universal Authentication Manager or set the
ESSO-UAM Authentication Service back to Local System and restart.

2. Click Start > Run > and type compmgmt.msc and click OK. The Computer Management
console opens.

3. Expand Systems Tools and then expand Local Users and Groups and click Groups.

4. Intheright pane, right-click on Administrators and select Add to Group....

5. Highlight the service user name and click Remove.

6. Click Start > Run > and type secpol.msc and click OK.

The Local Security Policy console appears.

7. Double-click the Universal Authentication Manager service account.
The Properties dialog appears.

8. Expand Local Policies and expand User Rights Assignment.
9. Double-click the Log on as a Service policy.
10. Select the Universal Authentication Manager service account and click Remove.

First-Time Logon for Enterprise Mode Users

It is recommended that you require Enterprise Mode users to perform their first-time logon in
connected mode. If the workstation is not connected to the Active Directory Domain Controller,
users will be able to log on but not enroll, because Windows cannot resolve the username while
disconnected.

If users perform a first-time logon in disconnected mode, they might receive the following
message when attempting to access to the Client application: "You cannot enroll in Universal
Authentication Manager until you log on to Windows with the computer connected to the Windows
network.”
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Selecting the Desired GINA Library (Windows XP Only)

On Windows XP systems, the Universal Authentication Manager GINA automatically chains with
the Logon Manager/Password Reset GINA and with the Microsoft GINA.

During installation or when performing maintenance, the Universal Authentication Manager
installer resolves the GINA chain according to the following logic:

e Ifthe current GINA is MSGINA, Universal Authentication Manager will automatically chain to it.

e Ifthe current GINA is SSOGINA (used by Logon Manager and Password Reset), Universal
Authentication Manager configures SSOGINA to chain to UAMGINA, which then chains to
MSGINA.

e Iftheinstaller detects an unknown GINA, which was installed by a third-party product, it
displays the "Third Party GINA Detected" screen, and prompts the administrator to choose
between keeping the existing GINA configuration (default) or having Universal Authentication
Manager attempt to register and chain with the third party GINA.

";a Using the third-party GINA will limit the functionality of the Universal Authentication
A Manager GINA to varying degrees, depending on the specific GINA. Oracle recommends
replacing the third-party GINA with the Universal Authentication Manager GINA.

i Oracle Enterprise Single Sign-on Universal Authentication Manager - I...
Third Party GINA Detected

Select an option,

The installer detects that a third party product has modified the Windows native GINA, ESS0-UAM
supports chaining with third party GINAs but it is recommendead ko manually configure and test GINA
chaining. Refer to the ESS0-UAM product documentation For infarmation on how bo manually
configure ESSO-UAM to chain with other products that madify the Windows native GINA,

WARMNING: IF wou select option to Reqister ESSO-LAM GINA, the computer may encounter errors
that prevent ability ko lag on,

G} Keep Current GINA

@ Do not modify current GINA configuration,

() Register ESS0-UAM GINA
@ Register ESS0-UAM GINA and attempt to chain to current GIMA,

< Back ” Mesk = l [ Caniel

"

Itis possible that choosing to chain the Universal Authentication Manager GINA with an
unsupported GINA might resultin an unrecoverable error. If you choose to attempt
chaining to an unsupported GINA, be sure to verify that it will work by trying it in a test
environment beforehand.

Recovering from Use of an Incompatible GINA (Windows XP Only)

On Windows XP systems, if the Universal Authentication Manager installer detects an unsupported
GINA, it presents you with the following choices:

e Keepthe current GINA
e Register Universal Authentication Manager GINA
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If you opt to register the Universal Authentication Manager GINA, Universal Authentication
Manager attempts to register UAMGINA and chain it to the unsupported GINA. If the third-party
GINA is incompatible with UAMGINA, upon restart you might be unable to log on. In order to regain
control of your workstation, perform the following steps to modify the registry manually:

1. Restart workstation, boot in Safe Mode and log on as a local administrator.

F-¥ Do notrestart in Safe Mode with Networking or Safe Mode with Command Line. Refer to
“4 Microsoft documentation for more information about restarting your workstation in the
different Safe Modes.

2. Click Start > Run > and type regedit.exe and click OK to launch the Registry Editor.

3. Select the GINA configuration that you want to use from the following list. If you plan to unin-
stall Universal Authentication Manager after recovery, deleting the origGinaName entry will
prevent an unintended modification of the GinaDLL registry entry.

e Torestore the standard Windows logon:

a. Navigate to HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows NT\Cu-
rrentVersion\Winlogon and delete the GinaDLL registry entry.

b. Restart.

e To configure for Universal Authentication Manager GINA only:

a. Navigate to HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows NT\Cu-
rrentVersion\Winlogon and ensure that the GinaDLL registry entry is set to “*Uam-
Gina.dIl.”

b. Navigate to HKEY LOCAL MACHINE\SOFTWARE\Passlogix\UAM\Gina and delete any
ChainToGinaName registry entry.

c. Restart.

e To restore any previously configured third-party GINA:

a. Navigate to HKEY LOCAL MACHINE\SOFTWARE\Passlogix\UAM\Gina and copy the value
of any OrigGinaName registry entry to HKEY LOCAL MACHINE\SOF-
TWARE\Microsoft\Windows NT\CurrentVersion\Winlogon\GinaDLL, or set GinaDLL
to the name of the third-party GINA dll.

b. Restart.
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Installing Anywhere

This section describes the steps necessary for installing Anywhere.
It covers the following topics:

e Prerequisites for Installing Anywhere
e Installing the Anywhere Console

After installing Anywhere, please read Deploying Oracle Enterprise Single Sign-On Suite Plus
Components for Offline Use via Anywhere.
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Prerequisites for Installing Anywhere

Before you install Anywhere, ensure the prerequisites listed in this section have been satisfied.

F-¥ Please refer to the latest release notes to find out about last-minute requirements or
“4 changes that might affect your installation.

Prerequisites for Installing the Anywhere Console

e Anywhere reads the configuration of the other Oracle products from which you will create the
Anywhere deployment package. Prior to installing Anywhere, install the products that you
intend to deploy. Follow the installation and setup instructions for these products from their
respective installation and setup guides. The deployment package must include Logon Manager
and might include Oracle Enterprise Single Sign-On Provisioning Gateway (Provisioning
Gateway).

Install these products on a clean workstation. If you are deploying Provisioning Gateway, install
its Administrative Console on a different workstation.

E‘& The Visual C++ Runtime Library and .NET 2.0 Framework are prerequisites for running

— Anywhere. The installation package includes the Visual C++ Runtime Library, however
you must make the .NET 2.0 Framework available to users. See the Oracle Enterprise
Single Sign-0On Suite Plus Release Notes for a complete list of software and hardware
requirements.

e Configure the Agents as you want the end users to work with them. End users do not have the
option to alter the installation. If you want different users to install different packages, create a
separate deployment package for each installation.

e There are two types of XML files associated with Anywhere:

o The Anywhere configuration XML. Configures the application itself. This file includes
assemblies' dependencies and component files, required permissions, and the location
where Anywhere places updates as you create them.

o The deployment configuration XML. Configures the Anywhere deployments that you
create. This file includes the target location of the application XML, the version of the appli-
cation that the Agents will run, and the location (Web page or network file share) where
Anywhere checks for updates.
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Prerequisites for Unattended (“Silent”) Installations

In order to successfully install Logon Manager, Provisioning Gateway Client, and Password Reset
Client in unattended ("silent") mode, the Windows Management Instrumentation (WMI) service
must be running before the installer is executed.

To check whether the WMI service is running, and start it if necessary, do the following on each
target machine:

1.
2.
3.

5.

Open the System Management Console.
Open the Services snap-in.

Navigate to the Windows Management Instrumentation service and check its status and
startup mode.

Depending on the status, do one of the following:

e Ifthe statusis Started, the WMI service is running; proceed to the next
section.

e Ifthe statusis blank, check the service's startup type and start it as follows:
o Ifthe startup type is Disabled, do the following:
1. Double-click the service.

2. Inthedialog box that appears, change the startup type to Manual or Automatic,
as required by your environment.

Click Apply.
4. Click Start to start the service. The status changes to Started.
o Ifthe startup type is not Disabled, do the following:
1. Double-click the service.
2. Inthedialog box that appears, Click Start to start the service.
3. The status changes to Started.
4. Click OK.

Click OK to close the service properties dialog box.
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Installing the Anywhere Console

Read the sections Prerequisites for Installing Anywhere Console and Creating the Deployment
Package before proceeding with the Anywhere Console installation.

To install the Anywhere Console:

1. Launch the ESSO-Anywhere Console.msi installer file.

i Oracle Enterprise Single Sign-on Anywhere Console - InstallShield ... |z|

Welcome to the InstallShield Wizard for
Oracle Enterprise Single Sign-on On Demand
Console

The InstallShield(R) Wizard will install Oracle Enterprise Single
| Sign-on On Demand Console on your computer. To continue,
dlick Mext.

WARNING: This program is protected by copyright law and
international treaties.

2. Select Complete setup. Anywhere does not require any setup customization. Select the Cus-
tom option only to specify a directory other than the default. Click Next >.

i Oracle Enterprise Single Sign-on Anywhere Console - Instalishield ...  [X]
Setup Type
Choose the setup type that best suits your needs.

Please select 3 setup type.

All program features will be installed. (Requires the most disk
space.)

Choose which program features you want installed and where they
will be installed. Recommended for advanced users,

< Back ][ Mext = ] [ Cancel

3. Click Install at the prompt.
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i& Oracle Enterprise Single Sign-on Anywhere Console - InstallShield ... |z|

Installing Oracle Enterprise Single Sign-on On Demand Conseole
The program features you selected are being installed.

Please wait while the InstallShield Wizard installs Oracle Enterprise Single
Sign-on On Demand Console, This may take several minutes,

Status:
Copying new files

[-----------

3

InstallShield Wizard Completed

- The InstallShicld Wizard has successfully installed Oracle
Enterprise Single Sign-on On Demand Console, Click Finish to
exit the wizard.

See the Oracle Enterprise Single Sign-On Suite Plus Administrator's Guide for instructions on
creating your deployment package.
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Troubleshooting Oracle Enterprise Single Sign-On Suite
Plus Installations

This section provides descriptions of most commonly encountered Oracle Enterprise Single Sign-
On Suite Plus installation issues and their solutions.

Windows Installer Error 1720

If an error 1720 occurs during the installation of any of the Oracle Enterprise Single Sign-On Suite
Plus components software installation, then the currently logged-on user does not have sufficient
rights to install software on that machine. You must log on to the machine as a user with
Administrator rights or contact your organization's IT support personnel.

Troubleshooting Provisioning Gateway Installations

The following are the most common issues that can be encountered during the installation of
Provisioning Gateway, along with their solutions.

Provisioning Gateway Does Not Support File Synchronization

Provisioning Gateway will not function correctly if it is deployed with the file synchronizer.

The Agent is configured to store its user data as a flat file on a network drive, FTP server, NFS
share, or local disk drive. Provisioning Gateway will not function in this scenario because it requires
a directory in order to distinguish and provision individual user accounts.

Multiple Locators Require an Entlist at Each Locator Site

If two users are stored in different containers, a matching application configuration list (entlist)
must exist in each locator site in order for provisioning to work down to the client. The matching
entlists must exist under both containers that store the user credentials.

Using Active Directory or ADAM/AD-LDS and IIS Web Services on
Different Servers

If IIS and Active Directory (or the ADAM/AD-LDS instance) are on different computers, then you
must provide the IIS Web services with a user account that is in the same domain as (or a trusted
domain of) Active Directory or ADAM/AD-LDS, and that is provided with read/write access to the
directory.

Internet Security Settings (Windows 2003 Users)

The default settings for Windows 2003 Internet Security are more stringent than those for
Windows XP. If Internet Explorer Enhanced Security Configuration is enabled (on by default in
Windows 2003), you must add the Provisioning Gateway Web Console URL to the workstation's
Trusted Sites Internet Zone or the Local Intranet Zone in order to use Provisioning Gateway
without issues.

Internet Security Settings (Windows Domain and Citrix MetaFrame®
Users)

In order for Windows domain users and Citrix MetaFrame users to access Provisioning Gateway,
you must add the Provisioning Gateway Web service to the workstation's Local Intranet zone.
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Deploying Provisioning Gateway With Multiple Oracle Internet
Directory (OID) Servers

When Provisioning Gateway is deployed with multiple Oracle Internet Directory (OID) servers load-
balanced in an active-active (all servers active) topology, Provisioning Gateway cannot resolve the
client-server session state due to multiple servers being involved in the session. This will cause
Provisioning Gateway to behave erratically. To avoid this issue, do one of the following:

e For simple failover support, load-balance your deployment using an active-standby topology. In
this configuration, only one OID server is handling connections from Provisioning Gateway
clients at any given moment. Backup servers, synchronized with the active server via rep-
lication, are ready to take over if the active server fails. You must configure your network to
automatically re-route the connections from the failed server to one of the backup servers
when a failure occurs.

e (Recommended) Use the Oracle Real Application Cluster (RAC) technology to create an OID
server cluster. A cluster will appear as a single server to Provisioning Gateway clients, while pro-
viding the performance and high availability of a fully load-balanced deployment. In case of
server failure, operation continues uninterrupted, and servers can be replaced on the fly.
Servers can also be added at any time, providing quick and easy scalability.

— Page 152 of 174 —



Oracle Enterprise Single Sign-On Suite Plus Installation and Setup Guide

Troubleshooting Password Reset Installations

Server Error in V' /vGOSelfServiceReset/ManagementClient”
Application

When you install .NET 2.0 on a computer running a newly installed operating system, the Network
Service account must be granted read/write access or you will encounter a server error when you
access the Password Reset 7.0 Management Console.

To avoid the server error, grant the Network Service account read/write access to the following
folder:

C:\Windows\Microsoft.NET\Framework\v2.0.50727\Temporary ASP.NET Files

This is not a Password Reset-specific issue. All ASP.NET applications will receive this error if the
configuration is not set correctly.

Group Security Policy: Password History Setting Should Be Increased

Password Reset uses the password history setting of the Windows XP Group Security Policy. You
should allow for one additional prior password in addition to the Enforce password history setting.
For example, if the setting is 3 (ensuring that a user’s last three prior passwords cannot be
reused), Password Reset uses one of these, so the actual setting is 2. Oracle recommends a higher
setting for Enforce password history for optimal security.

Internet Security Settings (Windows 2003 users)

The default settings for Windows 2003 Internet Security settings are more stringent than those
for Windows XP. You must add the Password Reset Web service to the workstation's Trusted Sites
Internet zone or the Local Intranet zone in order to use Password Reset as a Windows 2003 client.
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Uninstalling Oracle Enterprise Single Sign-On Suite Plus
Components

To uninstall one or more Oracle Enterprise Single Sign-On Suite Plus components, do the
following:

1. From the Start menu, open the Control Panel.
2. Depending on your operating system:

e Open Add/Remove Programs.

e Open Programs and Features.

3. Inthelist of installed software, select the desired component and click Remove or Uninstall.

Confirm any messages that you might receive asking if you are sure you want to remove the
program.

5. Follow any additional prompts to complete the uninstallation process.
Repeat steps 3 through 5 for each additional component you want to uninstall.
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Appendices

This section contains additional information that you might find useful when installing or

configuring Oracle Enterprise Single Sign-On Suite Pluscomponents. It contains the following
topics:

e Appendix A: Deploying Oracle Enterprise Single Sign-On Suite Plus Components for Offline Use
via Oracle Enterprise Single Sign-On Anywhere

e Appendix B: Packaging Oracle Enterprise Single Sign-On Suite Plus for Mass Deployment

e Appendix C: Oracle Enterprise Single Sign-On Suite Plus Configuration Reference
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Deploying Oracle Enterprise Single Sign-On Suite Plus
Products for Offline Use via Anywhere

Anywhere reads the configuration of the other Oracle products from which you will create the
Anywhere deployment package.

To create a product configuration file that Anywhere will read:

1. Carefully review the information in Prerequisites for Installing Anywhere.

2. Install the Oracle Enterprise Single Sign-On Administrative Console. For more information on
configuring the Oracle Enterprise Single Sign-On Administrative Console, see the Oracle Enter-
prise Single Sign-On Administrative Console help.

3. Install the Logon Manager Agent.

4. Install the additional Oracle components as required. For more information, see the individual
Agent installation and setup sections.

5. Configure the Logon Manager Agent and Provisioning Gateway Agent, if applicable, as you
want. See the Oracle Enterprise Single Sign-On Suite Plus Administrator's Guide and the Agent
installation and setup sections for more information.

6. When you have completed your configuration, select Global Agent Settings > Live >
Write to Live HKLM.

7. When you create the Anywhere deployment, you will have the option to use the Live HKLM set-
tings, or an exported registry file. If you plan to use a registry file, select the set of Global Agent
Settings you have configured, right-click, and Export to a .REG file. The following graphic
depicts a sample configuration.

£ Oracle Enterprise Single Sign-on Logon Manager Administrative Console
Eile Edit Insert Repository Tools Help
DEeld BE Help Search: [ Go ]
= =] vGO S50 2 B mteminal
Applications {1 CM=Configuration.D C=rxdamain D C=com
=| Session Manager [~ CM=5chema,CM =Configuration, D C=rsdomain, 0 C=com
Provisioning Manager (T DC=DomainDnsZones,D C=rxdomain DC=com
|=* Shared Accounts {_1 DC=ForestDnsZones D C=rxdomain DC=com
ﬁ"‘ Passwond Generation Policies E1{_1 DC=rxdomain.DC=com
(®) Passphrase Questions [ CN=Computars
Credential Sharing Groups [Z] CN=ForeignS ecurityPrincipals
=43 Global Agent Settings 1 CM=Program Data
=@y Lve ] CN=Bystem
E] End-User Experience ] CH=Users
E] Event Logging {1 0U=Domain Corntrollers
E[] Primary Logon Methods =) "J DOU=vG0Config
El Sscurity [_] OU=People
E] Session Manager 4T CN=vgoentlist
= E) Synchronization 1 OU=vgolLocator
=@ AD
[E] Required
£ Advanced
& ADAM
@ File Sync
LDAP
[Z3 Roaming
e
Ready

— Page 156 of 174 —


http://download.oracle.com/docs/cd/E21040_01/index.htm
http://download.oracle.com/docs/cd/E21040_01/index.htm
http://download.oracle.com/docs/cd/E21040_01/index.htm
http://download.oracle.com/docs/cd/E21040_01/index.htm
http://download.oracle.com/docs/cd/E21040_01/index.htm
http://download.oracle.com/docs/cd/E21040_01/index.htm
http://download.oracle.com/docs/cd/E21040_01/index.htm
http://download.oracle.com/docs/cd/E21040_01/index.htm
http://download.oracle.com/docs/cd/E21040_01/index.htm
http://download.oracle.com/docs/cd/E21040_01/index.htm
http://download.oracle.com/docs/cd/E21040_01/index.htm
http://download.oracle.com/docs/cd/E21040_01/index.htm
http://download.oracle.com/docs/cd/E21040_01/index.htm
http://download.oracle.com/docs/cd/E21040_01/index.htm
http://download.oracle.com/docs/cd/E21040_01/index.htm
http://download.oracle.com/docs/cd/E21040_01/index.htm
http://download.oracle.com/docs/cd/E21040_01/index.htm
http://download.oracle.com/docs/cd/E21040_01/index.htm
http://download.oracle.com/docs/cd/E21040_01/index.htm

Oracle Enterprise Single Sign-On Suite Plus Installation and Setup Guide

E& Oracle recommends that you thoroughly test the registry settings before you export

" them for inclusion in the package.

If you want to sign your package using a digital certificate, follow the instructions for
generating an X.509 certificate in the following MSDN article:
http://msdn2.microsoft.com/en-us/library/ms819929.aspx
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Packaging Oracle Enterprise Single Sign-On Suite Plus
for Mass Deployment

**Verify whether this applies to other components or just LM**

The most convenient way to mass-deploy Oracle Enterprise Single Sign-On Suite Plus is to create a
customized MSI package and distribute it to end-user machines using a deployment tool of your
choice. An end-user machine that has been configured and tested for production acts as a
configuration “master” from which the target Agent configuration will be derived for inclusion in
the package. Below is a high-level overview of the required steps. The steps are described in detail
later in this guide.

1. Obtain the following:

a. The latest installer for the Oracle Enterprise Single Sign-On Suite Plus component(s) you
want to deploy.

b. The latest versions of the following documents:

e Installing Oracle Enterprise Single Sign-On Suite Plus(this document)

e Logon Manager Best Practices: Deploying Logon Manager with [your target
repository]

e Configuring the Logon Manager Agent (this is being folded into the
admin guide; update when confirmed)

2. If performing an unattended ("silent”) installation, complete the steps in Pre-Requisites for
Unattended (“Silent”) Installations.

3. Install the Logon Manager Agent and the Oracle Enterprise Single Sign-On Administrative Con-
sole on the “master” machine.

4. Configure Logon Manager settings using the Console. Make sure you have thoroughly read and
understood the Logon Manager Best Practices guides listed above before you begin.

5. Generate the custom MSI package using the Oracle Enterprise Single Sign-On Administrative
Console:

a. Select the Logon Manager components that you want installed on the end-user machines.
(For example, if your environment calls for a single primary logon method, you may want to
exclude all but the desired authenticator.)

b. Select the customized set of global Logon Manager settings you have configured in step 4.

c. Generate the final MSI package. This package will contain the components selected in step
6a and configuration settings from step 4.

d. Test the package by deploying it on a pilot group of machines. Identify and correct any
issues that may arise. Document the solutions as necessary.

e. Once the pilot deployment is successful, deploy the MSI package enterprise-wide using
a third-party tool of your choice.
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Creating a Customized Agent Installation Package

1. Place the base Logon Manager Agent MSI package in a working directory on the “master”
machine.

Start the Oracle Enterprise Single Sign-On Administrative Console.
3. Create and configure the desired set of Global Agent settings:

a. Inthetreein the left-hand pane, right-click the Global Agent Settings node and select
Import --> From Live HKLM.

b. When the “Live” settings set appears in the tree, right-click it, select Rename from the con-
text menu, give the set a descriptive name, and hit Enter.

c. Configure Logon Manager as desired. For detailed information on each setting, see the
Oracle Enterprise Single Sign-On Suite Plus Administrator's Guide.
4. Create the customized MSI package for deployment to end-user machines:
a. From the Tools menu, select Generate Customized MSI.
b. Inthe™“Logon Manager MSI Generator” wizard that appears, do the following:

i. Inthe“Base MSI Selection” screen, click Browse and navigate to the Logon Manager
Agent base MSI package, then click Next.

& 1o
Stages Base MsI Selection @
Base MSI Selection Fath:

IC:‘.,ESO—LM 11.1.2.0.0 (bass).msi Browse... I

Feature Selection

MNew MSI Generation

< Previous Next >

ii. Inthe“Feature Selection” screen, select the Logon Manager components that you want
to include in the package. Expand each category node to find the desired component(s),
then select the check box next to each desired component. When you have finished,
click Next.
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73 ES50-LM MsI Generator B -0l x|
Stages Feature Selection @
[ application Support =]

Base MSI Selection
E ¥ authenticators

[T windows Logan
B ¥ windows Logon v2
¥ GIna
[T Network Provider
LDAR
LDAR v2
Entrust
Proximity Card
Smart Card
Smart Card {Read-Only)
RSA SecurlD

Feature Selection

New MSI Generation

=
I e e

Authentication Manager

o}
Kl
W

wnchronizers

Microsoft Active Directory —
Microsoft ADAM

LDAR

Database

Roaming Profile -

I i .

< Previous Next =

iii. Inthe“New MSI Generation” screen, do the following:

1. Select the set of global Agent settings you have created in step 3 from the “Global
Agent Settings” drop-down list.

2. Click Browse and provide the target path and file name for the customized MSI pack-
age.
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3. Click Generate.

Stages

Base MSI Selection
Feature Selection

Mew MSI Generation

75 ESS0-LM MSI Generator B 10 x|
=N — o
Global Agent Settings:
[ Customized MSI Settings =]
Qutput MSL:
Browse

|C:\BSO—LM 11.1.2.0.0 {customized).msi

Generate |

< Previous

Mext =

5. Close the “Logon Manager MSI Generator” wizard.
6. Save the package settings to an XML file for future reference:

a. From the File menu, select Save.
b. When prompted, enter a descriptive file name and click Save.
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Testing the Customized Package in a Pilot Deployment

Once you have generated your custom MSI package, test it by installing it on one or more pilot
machines. Always install the package on a clean machine - that is, one that does not contain any

Logon Manager-related files or registry entries. If you are using the same machine to test multiple
packages, you must sanitize it before installing a new package so that old settings and files do not
remain; if the installer detects existing data, it will perform an upgrade instead of a normal
installation, resulting in false problems and false positives during testing.

To sanitize your pilot machine:
1. Delete the following directories and their contents:
e The Logon Manager application directory:
o On 32-bit systems: \Program Files\Passlogix
©o On 64-bit systems: \Program Files (x86)\Passlogix
e The Logon Manager user data directory:
o On Windows XP: \Documents and Settings\<user>\Application Data\Passlogix
o On Windows 7: \Users\<user>\AppData\Roaming\Passlogix
2. Delete the following registry keys and their children:
e On 32-bit systems:
o HKEY_CURRENT_USER\Software\Passlogix
o HKEY_LOCAL_MACHINE\Software\Passlogix
e On 64-bit systems:
o HKEY_CURRENT_USER\Software\Passlogix
o HKEY_LOCAL_MACHINE\Software\Wow6432Node\Passlogix

When testing the package, look for any deployment and configuration problems; Oracle highly
recommends that you set up a dedicated test environment so that you can perform a full range of
staging tests, including the chosen global Agent settings, administrative overrides,
synchronization with your central repository, and response to applications. The last item will
require that you create a set of pilot templates and test them against a selected set of applications.
This will let you spot and correct any application response issues that would have otherwise arisen
(and been much more costly to resolve) in production.

When the package has been fully tested and verified, use a deployment tool (such as Microsoft
Systems Management Server) to deploy Logon Manager enterprise-wide.
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Oracle Enterprise Single Sign-On Suite Plus
Configuration Reference

This section contains supplemental information you may find useful when installing Oracle
Enterprise Single Sign-On Suite Plus. It covers the following topics:

e Password Reset Client-Side Registry Settings

e Password Reset Server-Side Registry Settings

e Modifying the DCOM Permissions of the Password Reset Reporting Service
e Installing and Configuring an ADAM/AD-LDS Instance for Password Reset

Password Reset Client-Side Registry Settings

Under HKLM\Software\Passlogix\SSPR

Data Data [URLRoot] :
Key Value Name Type http://[host]/vgoselfservicereset

WindowslInterface | EnrollURL string URL of the Enrollment service default page:

(REG_ [URLroot]/enrollmentclient/enrolluser.aspx
SZ)

ResetURL string URL of the reset service default page:
(REG_ [URLroot]/resetclient/default.aspx
SZ)

StatusURL string URL of the checkstatus page (notifies reset client
(REG_ that reset service is available:
SZ) [URLroot]/resetclient/checkstatus.aspx

CheckEnrollURL string URL of Enrollment check service (checks if user
(REG_ is enrolled in service):
SZ) [URLroot]/resetclient/checkenroliment.aspx

AutomaticEnroll dword Set to a non-zero value to offer enroliment option
(REG_ to enroll user at next logon. Set to 0 (default) not
DWORD) | to offer enrollment upon logon.

ForceEnrollment dword Set to a non-zero value to require unenrolled
(REG_ user to enroll at next logon. Set to 0 (default) not
DWORD) | to require enrollment upon logon.

CheckForce string URL of force enrollment check service (checks

Enrollment (REG_ the number of times user can defer Enroliment):
SZ) [URLroot]/resetclient/checkforceenrollment.aspx
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Data Data [URLRoot] :
Key Value Name Type http://[host]/vgoselfservicereset

WindowHeight dword Adjusts the Password Reset browser window
(REG_ height.
DWORD)

WindowWidth dword Adjusts the Password Reset browser window
(REG_ | width.
DWORD)

Bitmap string Add this key to the registry to replace the
(REG_ standard GINA bitmap with a custom bitmap.
SZ) Specify the full path to the custom bitmap file.

See the Oracle online documentation center for
full instructions (Windows XP and earlier).

WindowsInterface\ | LinkText string Enter desired text to instruct the user to click to
xx (where xx is the (REG_ reset password (Windows 7 only).
two-letter SZ)
language code*)
WindowTitle string Enter desired text for the Enroliment and Reset
(REG_ Interface window titles.
SZ)
Windows WindowTitlel... string Set to the window titles that should display the
Interface\ WindowTitleX (REG_ Password Reset banner on Windows XP.
xx\GinaWindows SZ)

*Language Codes for WindowsInterface\xx

¢ Chinese: zh e Finnish: fi o Italian: it e Portuguese: pt ® Spanish: es
e Czech: cs e French: fr e Japanese: ja e Romanian: ro e Swedish: sv
e Danish: da e German: de e Korean: ko e Russian: ru e Thai: th

e Dutch: nl e Greek: el e Norwegian: no e Slovak: sk e Turkish: tr
e English: en e Hungarian: hu e Polish: pl
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Password Reset Server-Side Registry Settings

» Under HKLM \Software\Passlogix\SSPR

Data
Key Value Name Type

SSPRService Reset_ dword Set to 1 to display the reset prompt. Set
ShowIntroduction REG_ to O (default) to suppress the reset
DWORD | prompt.
SSPRService Reset dword Set to 1 to activate customizable reset
CustomizedErrorMsg REG_ error messages. Set to 0 (default) to use

DWORD | the built-in reset error messages.

SSPRService SessionTimeoutMessage | dword Set to 1 to activate a message notifying
REG_ the user that the session will timeout
DWORD | within a specified period of time. Set to 0
(default) if you do not want this message
to display.

» Under HKLM \Software\Passlogix\SSPR\Storage\Extensions\

ADAM Root string (REG_SZ) ADAM/AD-LDS partition root

Classname string (REG_SZ) Adam

» Under HKLM\Software\Passlogix\SSPR\Storage\Extensions\ADAM\

string (REG_ server:port (of the ADAM/AD-LDS instance)
SZ)

Servers | Serverl

» Under HKLM\Software\Passlogix\SSPR\Storage\Extensions\

Root string (REG_SZ) AD root

Classname string (REG_SZ) AD

» Under HKLM\ Software\Passlogix\SSPR\Storage\Extensions\AD\

| Servers | Serverl | string (REG_SZ) | server:port |
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Modifying the DCOM Permissions of the Password Reset
Reporting Service

Password Reset sends reporting events to the SQL Reporting database through the SSO Reporting
Service, which runs locally on the Web server. The local SSO Reporting Service sends those events
to the SQL Reporting database at regular intervals.

¥ The default interval for transmitting events to the SQL Reporting database is 30
“ minutes. You can change this setting from the Reporting page of the Password Reset
Management Console.

You can configure the Web server in one of two ways to enable reporting:
o Make the Password Reset Reset domain account a member of the local Administrators group.

or

¢ (Recommended) Modify the DCOM permissions of the SSO Reporting Service to allow the Pass-
word Reset Reset account to launch and activate the SSO Reporting Service.

To modify the DCOM permissions:

1. Click Start > Run. At the command prompt, type dcomenfg and press Enter.to launch the
Component Services management tool.

(%) Component Services

i File Action Vew Window Help

e Al o | NERERENN 7 |oel Fal

(L Console Root Mame |
3 Component Services | CoM+ Applications
= [ Computers ~ DCOM Config

= 1Al My Computer
| CoM+ Applications
| DCOM Config
" | Running Processes
_| Distributed Transaction Coordinator
@ Event Viewer (Local)
o4 Services (Local)

= Running Processes
" Distributed Transaction Coordinator

2. Navigate to the DCOM Config node: Console Root > Component Services > Computers
> My Computer > DCOM Config.
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(¥} Component Services

. File Action View Window Help

. = BT 1 ame
ol A a1, SEIRERN 7 | [oe] al |-
ShellWindows ;I
SLLUA
SLUI
SSORepartingService Class
SSPRChangePasswordSve

Ssr DCOM Back-end classes
System Configuration Utility

F F FE FEFEFEFE
WEREH SN s s

3. Locate the "SSOReportingService Class” node, right-click, and select Properties.

4. From the “SSOReportingService Class Properties" window, select the Security tab.

el

General | Locaton  Secuty | Endponts | identey | |

ok | Caed | e |

5. Inthe"“Launch and Activation Permissions” section, click Customize, then click Edit.

6. Inthe"Group or user names:" section, click Add.
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2%
Secsy |

Group or user names;

B2, Admirisirators (W IN-2KLAISEMALON Administratars)

B2 INTERACTIVE

[Pemissians for SYSTEM

Allaw

Local Laurch 1|

Remate Launch |
=
|

Local Adtiwation
Remate Activation

Leam shout sccess control and pemissiors

oK | Cocel |

7. Enter the name of the Password Reset reset domain account and click OK.

Select Users, Computers, or Groups ﬂﬁl
Salact this object type:
ILm,ﬁ'nLua. or Buiit4n sacurfty pincipals Object Types...
From this lacation:
Enter the cbjaet names ta selec (zemplasl
Bdvanced.. ok | canca |
A

8. Verify that the Password Reset reset account has “Local Launch” and “Local Activation”
permissions.

— Page 168 of 174 —



Oracle Enterprise Single Sign-On Suite Plus Installation and Setup Guide

Launch and Activation Permission i 21

Sen.rltl_.r]

(Group or user names:

82 SYSTEM
82, Administrators (WIN-2KUAJBEMXLDNAdministrators)
52, INTERACTIVE

l sspmeset (sspmeset@afman bocal)

Add... | Hemove |

Pemissions for sspmeset Allowe Demy
Local Launch =] O
Remote Launch O O
Local Activation ] O
Remote Activation O O

Leam shout access contral and pemizsions

OK I Cancel

9. Click OK twice to finish.

Installing and Configuring an ADAM/AD-LDS Instance for
Password Reset

1. Runthe ADAM/AD-LDS installer. Select A unique instance and click Next.
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= Active Directory Application Mode Setup Wizard x|

Setup Options
An ADAM instance iz created each time ADAM iz inztalled.

“'ou can create a unigue instance, or you can install a replica of an existing instance.

Select the type of ingtance you want to install

oF
Thig option automatically creates a new instance of ADAM that uses the default
configuration and schema partitions. The new instance will not be able to replicate
with existing instahces.

" A replica of an existing instance

Thiz option creates a new instance of ADAM that uses the configuration and
zchema partitions replicated from another instance of ADAM. Y'ou can also select
the application partitions to replicate.

< Back I Mext » I Cancel Help

2. Provide your Instance name and click Next.

ctive Directory Application Mode Setup Wizard il

Instance Mame
The inztance name iz uzed to differentiate this instance of ADARM fram other A0AM
instances on this computer.

Type a name for thiz instance. The name should reflect the use for which this instance
of A0AM iz intended.

Inztance name:

|55PFH1

Example; Addreszbook]

The ADAM zervice name is created when the instance name iz combined with the
product name. It will be displayed in the list of Windows services.

ADAM zervice name:
ADAk_S5PR-1

< Back I Mext » I Cancel Help |

3. Specify port numbers of 10000 and 10001 (ten thousand range, for easy recall) and click
Next.
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== Active Directory Application Mode Setup Wizard il

Ports
Computers will connect to this instance of ADAM using specific ports on all of the
IP addreszses associated with this computer.

The ports displayed below are the first available for this computer. To change these
portz, type the new port numbers in the text bokes below.

If wou plan to inztall Active Directory an thiz computer, do not use 389 for the LDAP port
or 636 for the S5L port becauze Active Directory uzes theze port numbers. Instead, uze
available port nurbers from the follawing range: 1025-65535,

LDAP port number;
|1 0000

S5L port number:
|1 onm

< Back I Mext » I Cancel | Help

4. Specify the root DN (for example, bc=SSPR, DC=Passlogix, DC=COM) and click Next.

= Active Directory Application Mode Setup Wizard |

Application Directory Partition
An application directory partition stores application-specific data,

Do you want bo create an application directory partition for thiz instance of ADAM ?

" Mo, do not create an application dirsctary partition
Select thiz option if the application that you plan to install creates an application directom

upon installation, or if pow plan to create one later.
¥ “Yes, create an application directary partition

Select thiz option if the application that you plan to install does not create an application
directary partition upan installation. & valid partition name iz any distinguizhed name that does
not already exizt in thiz ingtance. Example diztnguizhed name;

CH=Partition] D C=""oodgrove, D C=COM

Partition name:
DC=S5PR.DC=Paszlagix, DC=COM

< Back I Mext » I Cancel Help |

5. Specify an easy-to-find base location (for example, $RootDrive$\ADAM\Instance) and click
Next.
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ctive Directory Application Mode Setup Wizard il

File Locations

YY'ou can zpecify a location for each twpe of file associated with thiz instance of
ADAM.

Specify the locations to store files associated with ADAM.

Data files:
IF:‘\.&DAM\SSPH-‘I hdata Browsze. .

IF:k&DAM'\SSPH-‘I \recoverny Browse...

Data recovery files:

< Back I Mext » I Cancel Help

6. Specify the run privileges and click Next.

= Active Directory Application Mode Setup Wizard il

Service Account Selection

ADAM performs operations uzing the permizsions associated with the account you
zelect.

Set up ADAM to perform operations uzing the permissions associated with the following account.

£ Metwork service account

ADAM haz the permizgionz of the default Windows zervice account.

¢ This account;

ADdM has the permizsions of the selected account. Ensure that the account vow select is set
Lp barun as a service.

User name: (€ Qarsdministiator =] | Browss. |

Pazzword: Iio--ooo--o.

< Back I Mext » I Cancel Help

7. Specify the Administrative Permissions and click Next.
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.,';': Active Directory Application Mode Setup Wizard

ADAM Administrators
Y'ou can zpecify the uzer or group that will have administrative privileges for thiz
instance of A0AM.

Azzign the following user or aroup of users administrative permissions for A0ARM.

& Cumently logged on uzer: D&k drministator

The uzer that iz installing ADAM will have administrative permizzions for this instahce
of ADARM.

= This account

The zelected uzer or group will have adminiztrative permizzions for thiz inztance of
ADAM. Wou can chooze any uzer ar group from thiz computer, this computer's
domain, or any domain that iz tuzted by this computer's domain.

AEaunt name;

Browsze... |

< Back I Mext » I Cancel | Help

8. Select Do not import LDIF files for this instance of ADAM and click Next.

.,';': Active Directory Application Mode Setup Wizard

Importing LDIF Files
YY'ou can impart data from Lightweight Directary Interchange Farmat [LDIF] files into
your ADAM application directory partition,

To configure the ADAk service in a specific way, import one or more of the LDIF filez lizted
belo.

& Do not import LDIF files for this instance of A0AM:
" Import the selected LDIF files for this instance of A0AM
Luailable files; Selected LOIF fles:

M5 -A7Man LDF
bS5 -Inet0rgPerson LOF

b5 -zer LODF
S -UzerProsy LOF fadd - |
<- Bemove |

< Back I Mext » I Cancel Help

9. Click Next as requested to proceed.
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= Active Directory Application Mode Setup Wizard x|

Ready to Install
The ADAKM Setup Wizard iz ready to install ADAR with the following configuration.

Before continuing, reviews and confirm your selections.

Selections:

Install a unique instance of ADAR. -

Ihstance name: S5PR-1

Computers will connect to thiz instance of ADAM uzing the following ports:
LOAP port; 10007
S50 port; 10002

A0AK replication will uze Megatiate authentication.

Stare ADAM program files in the following location: LI

To change pour selections, click Back. To install ADAM, click MNest.

< Back I Mext » I Cancel Help

Click Finish.

ve Directory Application Mode Setup Wizard il

Completing the Active Directory
Application Mode Setup Wizard

Y'ou have succeszsfully completed the Active Directory
Application Mode Setup wizard.

<Back |7 Finish ™

Cancel Help
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